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AS YOU TRAVEL along the lunar stretch that connects
Pune to Mumbai—euphemistically called a
highway—you come across the first toll booth at a
place called Vashi. In August, the people who levy toll
on this road, decided to introduce smart cards to
make things easier.

Until July, vehicle owners would stick an ugly, flu-
orescent sticker on their car’s windscreen. It was
their monthly toll pass.

So when smart cards were introduced in August,
there was some jubilation. The toll contractors
installed spanking new PCs, printers, and a smart
card system, thereby ending the Ugly Sticker regime.

Or so the commuters thought.
Earlier, the man who handed out the sticker

noted your vehicle registration number in a log book,
returned the change, and then wrote the registration
number on the sticker. This routine took not more
than 45 to 60 seconds.

You’d think the smart card would make it easier.
But here is what happens: The same man now notes
the vehicle registration number in his log book, and
later onto the computer, extracts a smart card from
his filing cabinet, puts a sticker on it, and writes the
vehicle registration number on the sticker. He then
goes back to the PC, and prints out a receipt. Once
this is done, he returns the change and hands you
the smart card. Time taken: five minutes. Result:
Delayed service, long queues, and more than 
5,000 agonised commuters.

One hundred marks for transparency, zero 
for efficiency.

After spending lakhs on thousands of smart
cards (priced at Rs 70 each, a cost passed on to com-
muters), Pentium 4 PCs, four dot matrix printers,
and a smart card authenticator, Mumbai’s outbound
commuters are still stuck with a sticker (every
month one more sticker will be stuck to the previous
one), and now they even have to remember to carry
the smart card every day, which, for all practical pur-
poses, is a dog tag, because the authorities have not
installed a card reader at the toll booth.

The Vashi toll booth is a perfect example of how
technology is used where none is required—or even if
needed, how bureaucrats tend to over-engineer solu-
tions instead of using a little common sense. The ugly

sticker, however undesirable, was a reasonably com-
fortable solution, especially in resource-poor India.

Admittedly, smart cards need to proliferate in the
economy, but can only do so if the infrastructure is in
place. One that will allow not only easy passage at
Vashi (or any other toll booth in India), but also serve
as a card for cashless transactions at multiple
points—supermarkets, petrol pumps, ration offices, or
when dealing with government departments. It can
make the transactions cleaner, and prevent corrup-
tion to a certain degree. 

Only then would smart cards have truly touched
our lives.

We shall wait for that day.

Smart Cards, Dumb Bureaucrats

Editorial

“Smart cards can
proliferate only if
the infrastructure

is in place”

Sachin Kalbag Executive Editor

sachin_kalbag@jasubhai.com
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You get to choose what goes on Digit
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Size: 538 MB

Microsoft .NET 1.1 SDK
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Online

Web Special
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net connection sharing
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proxy and caching server

Digit
Patrons
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be loyal!

Find out

more on
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thinkdigit.
com

Last Month’s Question:

Do you like the new Digit? 

Digit Reader Poll

Yes No Don’t
Care

Could have
done better

This Month’s Question

What technology category
do you spend the most on?

Cellphones and accessories
Consumer electronics

PCs, Laptops, and related
accessories
Spend? What Spend? My
Papa’s The Richest!

Log onto www.thinkdigit.com
and vote

General
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From Linkin’ Park
to Doom III, 
it’s all here

Hardware
Discussion
The hangout
haven for geeks

QnA
Thousands of answers to every 
question you have

Bazaar
Have money, will
buy!

Software
Discussion
Some very 
opinionated 
people here

There’s something for everyone on the Digit Forum
Forum
Want to 
brainstorm? 
Start a 
discussion? 
Share an idea?
Log on to 
www.thinkdig
it.com/forum
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Subscribe
No more snail-mail! No need to visit post
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www.thinkdigit.com/subscribe and use
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PORN BLOGGERS’ EXCUSE

That’s Not
My Porn

On August 3, Wired
News reported that

porn blogs were
manipulating Google’s
Page Rankings. The report
said a firm called
CyberQuest was
responsible for the
marketing. It had set up a
“few dozen” cross-linked
and porn-themed blogs on
Google-owned Blogspot.
The blogs linked to three
of CyberQuest’s porn sites.
Many experienced bloggers
feel that the purpose

behind it all was to
artificially raise the Page
Rankings of the porn sites. 

“It’s the latest sleazy
porn marketing scheme,”
said John
d’Addario, editor
of Gawker Media’s
porn-themed
gossip blog,
Fleshbot. “It’s
another example
of porn folk being
sort of ahead of
the curve when it
comes to
technology and
marketing.” 

The whole ploy brings
back memories of early
porn-marketing techniques
in which porn operators
used meta-tagging to

outwit search engines.
Later, on August 5,

CyberQuest vehemently
denied the accusations,
blaming the episode on

“an affiliate”.
CyberQuest

owner Fade
Saab told Wired
News that until
that day, he had
been unaware
of what was
going on.

Headlines
such as “Porn
blogs

manipulate Google” have
been doing the rounds
lately. It is surprising to see
a flat denial—”it was done
by an affiliate” is as lame
an excuse as they come.

Virus In Your Handheld
Amrita Rao
The Ishq Vishq Girl

She has since been seen in
Main Hoon Na, this year’s

biggest domestic grosser; in
the Vivek Oberoi starrer
Masti; and will feature in
Deewar later this year. 
What does technology
mean to you? 
Innovation. It also means

interacting with my
fans and  keeping

in touch with
them real-time.
What gadgets
do you own?
A Sony PDA, a

Samsung DVD
player and a

Nokia cellphone.
Which Web sites are

you regular on?
I visit a few Bollywood
entertainment sites like
bollywoodworld.com and
planetbollywood.com, etc.
Do you store your holiday
memories on a CD, say a
video you shot with your
family abroad?
Yes. I prefer storing on a CD
because they will stay with
me for a long time, and in
good quality. Besides I can
store more.
Do you think technology is
only for geeks?
Everyone interacts with
technology every day. You
can even book rail and
cinema tickets online. This
just shows how even the
smallest, simplest thing in
life is made easier due to
technology.
Are you updated on the
latest technology trends?
I do like to keep myself
updated on MP3 players,
digital cameras, and the
latest computer peripherals.

Aparna Krishnakumar

YOU ARE GONNA GET ZAPPED SOON

No More CeBIT America 
The CeBIT America show, slated for June 28 to June
30, 2005, has been called off. It could not raise
enough revenue to justify a third year. CeBIT America
would now concentrate on the enterprise segment
and organise a show along the lines of Comdex. 

A Billion PCs By 2010 
Research agencies IDC and Gartner say the number of
PCs the world over will touch one billion by 2010. But,
manufacturers must adapt the PC to local usage,
battle government sanctions, and also create
awareness in emerging markets.

illustration Atul D
eshm

ukh

The wait is over, but for
the wrong reasons. A

Trojan Horse program
called
Backdoor.Brador.A, or
WinCE.Brador.a, has
arrived. It infects
palmtops running the
Pocket PC OS. The
program arrives
buried in an ordinary
program, and once the
former is installed, it is
activated. It then uses the
Internet connection from
the infected device to send
a message to the entity that
planted it. That entity then
gets to retrieve or delete
data from the compromised
device. If the palmtop is
connected to a desktop
computer, the desktop
would be under the
attacker’s control as well.

However, Symantec
rated the threat as level 1,
the lowest on its five-point
scale. The popular security

firm stresses that the
program’s efficacy is
limited merely to devices
using an ARM processor and
the Pocket PC OS.

Antivirus firm
Kaspersky Labs said the
Trojan was probably written
by a Russian coder.

“We were certain that a
viable malicious program
for PDAs would appear soon
after the first proof-of-
concept viruses emerged for
mobile phones and
Windows Mobile,” said
Eugene Kaspersky, head of
Anti-Virus Research at
Kaspersky Labs.

In this issue (page 44),
we have discussed the
upcoming threats to
smartphones—and this
report is just the beginning,
as Dr Kaspersky fears. 

“It’s another
example of
porn folk being
sort of ahead of
the curve when
it comes to
technology and
marketing.”

Illustrations M
ahesh B

enkar

Enter
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MANY MORE SUPERCOMPS

More power
To NASA

National Aeronotics and
Space Administration

(NASA) is all set to get a
massive supercomputing
boost soon with Project
Columbia. This project is
part of the plan to get its
shuttle missions
back in action
after the tragic
crash of the
Columbia in 2003
that killed seven
astronauts,
including India-
born Kalpana
Chawla. It is
touted to bolster
NASA’s
computing power ten-fold.

The new supercomputer

will be one of the world’s
biggest Linux-based

supercomputers,
and will help
NASA with flight
missions, analyses
of weather
paterns, climate
research, and
aerospace
engineering. The
system will have
500 terabytes of
storage, and will

use the power of 10,240
Intel Itanium 2 processors! 

Interestingly, the
supercomputer will be used
to model the human
impact on climatic changes
and global warming.

“The more computer
power you have, you can do
two things: you can
simulate more events, have
that many more ‘what if
scenarios’ to foresee other
circumstances,” Richard
Dracott from Intel’s
Enterprise Platforms Group
told BBC News Online.

Climate and weather
patterns critical for shuttle
missions can be simulated,
merged and stored
graphically. They can also
be modelled over a period
of weeks or even months,
instead of over just a 
few days.

VIRUS CREATOR’S TRIAL

Script Kiddie
Pleads
Guilty

Jeffrey Lee Parson, the
unleasher of the 

Blaster-B variant of the
Blaster worm last August,
pled guilty on August 11.
Parson is a 19-year-old
living in Minnesota.

Parson is not the
author of the original
Blaster worm, which
infected one million
computers last summer,
according to a report in
the Seattle times. What
Parson did was create a
variant of the worm, called
Blaster-B, by modifying the
original Blaster. He
unleashed the worm onto
the Net in early August of
2003. Blaster-B would
launch a distributed DoS
attack against one of
Microsoft’s Windows
Update Web sites from
infected computers.

So how was Parson
caught? Blaster and its
variants are worms that
spread by exploiting a well-
known vulnerability in
Windows. Blaster-B is
functionally equivalent to
the original Blaster, but
creates a file called
‘teekids.exe’ in the
Windows system folder.
The original Blaster
created a file called
‘msblast.exe.’ Parson’s
online nickname, or
handle, was ‘teekid’ or
‘t33kid.’ This, and other

One Silly Question What is a USB port?

Siddhartha Ganguly , Nagpur

Nisha Dhorba, Mumbai
Chintan Shah, Mumbai

Windows
XP SP 2
Bundles
security revisions and a new
update. Important features:
Windows Security Centre,
auto-triggering Windows
Firewall and browsing
enhancements for IE.

Windows
XP SP 2

Some programs just ‘stop
working’. By default, SP2
enables Windows Firewall.
Over 200 programs have
compatibility problems.
Even MS Office isn’t
spared.

What is it? Is it so
mething in a

computer?Dunno, sounds like some typical

gizmo.
It’s Universal something something.
Oops, I forgot.

Universal Serial Bus. It connectsany computer to 127 devices.
If you let me do a Googlesearch, I can tell you.

Tilak Pokharel, Kathmandu

Security Watch

MyDoom

AAllssoo  KKnnoowwnn  aass
W32/Mydoom.o@MM,
W32/MyDoom-O,
WORM_MYDOOM.M,
Win32.Mydoom.O 

Infection Method This
worm uses its own SMTP
engine to send e-mails. It
searches the victim’s
computer as well as
Altavista, Google, Lycos
and Yahoo for e-mail IDs.
For example, if it finds
‘something@rediff.com’ on
your PC, it uses a search
engine to procure e-mail
IDs ending with rediff.com.
The mail’s subject, text and
attachment vary and the
sender is spoofed.
It also drops the Trojan
Backdoor.Zincite.A, which
allows unauthorised
remote access to the
infected computer.

Damages Degrades system
performance, and may clog
mail servers as well as
networks. Hackers can
download and execute files
on the affected system. 

Removal Instructions:
Download the removal tool
from http://security
response.symantec.com/avc
enter/FxMydoom.exe, close
all programs, disconnect the
PC from the network,
disable system restore, and
run the tool. You may need
to enable Active Desktop
after this.  

The system
will have 500
TB of storage,
and will use
the power of
10,240
Itanium 2
processors 

Avijit Majumdar, Kolkata

brought to you by
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Academic and Career Guidance

www.educationinfoindia.com
This is one Web site you just have to
hit. Right from  aptitude tests to
model test papers to loan
information, this  Web site has it all.
Educationinfoindia.com also has
counsellors providing career advice
via chat sessions between 11 am to 1
pm IST.

www.Youngbuzz.com 
Neatly classified data helps you
make your career choice. Its Careers
section lists every detail about
computer engineering, photography,
biochemistry, microbiology, etc.
Those interested in pursuing careers
abroad may hop to its Study Abroad
section that answers such queries.

www.indiaEducation.info
Career counselling, self evaluation,
career options, advice for students
just clearing their 12th std. exams
and a whole bundle of useful
sections are found in one major box
on the homepage. Information
about distance education,
vocational education and
correspondence courses are smartly
packed under the Other Avenues
section. 

educationinfoindia

Youngbuzz

indiaEducation

Three Incredibly Useful Sites
clues, gave Parson away. He
was arrested on August 29,
last year.

Parson, in court,
admitted “intentionally
causing damage to a
protected computer”
before a federal judge in
Seattle, as part of a plea
bargaining arrangement.
He faces between 18 and 37
months in jail, instead of a
maximum of ten years. He
may also be ordered to pay
a fine, which could run
into millions of dollars,
according to Assistant US
Attorney Annette Hayes.

Why the reduced
sentence? Parson’s Blaster-
B hit nothing like a
million computers—just
about 48,000. In his plea
agreement, Parson
admitted using Blaster-B to
commandeer 50
computers, which he then
used to launch a broader
attack on the 48,000
computers, a Reuters said.

Parson is what is known
in hacker circles as a script
kiddie. According to
Webopedia.com, a script
kiddie is “a person,
normally someone who is
not technologically
sophisticated, who

randomly seeks out a
specific weakness over the
Internet in order to gain
root access to a system
without really
understanding what it is
s/he is exploiting because
the weakness was
discovered by someone
else.”

TURN THAT COMP OFF!

Off Or On?

You have probably often
wondered whether it is

better to leave your
computer on all the time,
or to shut it down once
you are done. If you leave
your PC on all the time,
how much energy are you
actually wasting?

Researchers at the
University of Waterloo in
Canada tried to answer this
big question with some
interesting tests. They
found that PCs with
Pentium 4 processors
running at 1.7 gigahertz
drew 110 watts while
booting up, and 60 watts
when they were on and
idle. A 17-inch CRT monitor
added an additional 

James Vernon Allridge, sentenced to
death for shooting a Texas store clerk,
has been running a Web site that
sells art and greeting cards online.
His star customer: Actress Susan
Sarandon. He claims he wants to give
something constructive back to society.

UNITED STATES

SWEDEN

A Round-up of Technology News from Across the GlobeThe Digital World

Pastor Helge Fossmo has been jailed for life
for faking SMS messages from God to get his
nanny-lover to murder his wife and try to kill
the husband of his second mistress. He was
having an affair with the nanny and the
neighbour’s wife.

CHINA

Yahoo! has given China something
that it has never given anybody else—a 
1 GB free email inbox. While other
Asian countries are not so lucky, this
move is seen as competition to
Google’s Gmail in the world’s largest
emerging market.

JAPAN

Microsoft has launched Japan’s first
blogging service. With this, Microsoft
aims to attract more than one million
users in the first year. Google better
watch out: the competition just got
hotter.

UNITED KINGDOM

Britain has the worst recycling records
in Europe. How do we know? Maxitech,
a UK-based NGO, has claimed that up to
two million working Pentium PCs are
dumped in landfill sites in the UK every
year. They obviously haven’t heard of

kabadiwallas.

AUSTRALIA 

Legal experts here have decided that copying music to
the Apple iPod is illegal. The reason: Australia does
not have a copyright law for fair copying of music,
leaving the 1 lakh-odd iPod buyers as potential
convicts. History has come full circle, for sure!
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75 Watts. Newer, flat-screen
LCD monitors use about
half as much power.

These numbers say that
the PC isn’t really an
energy waster. But add up
all the hours of standby
time, and now multiply
that by the number of PCs
in the world. Doesn’t it
total up to quite a bit?

Dell spokesman Lionel
Menchaca said, “There used
to be a bigger difference in
terms of wear and tear
when you power up your
PC, but it’s not an issue
anymore.”

It is best to go green
and turn your computer off
if you are not going to be
using it for a long time.

ROAM BETWEEN WI-FI AND 3G

Mobile, WiFi
Hybrid
Phones Soon

Cell phone vendors are
planning the release of

WiFi phones ahead of
schedule. But, it is feared to
unleash new threats and
opportunities to wireless

carriers as well as traditional
phone service providers. 

A hybrid phone gives
you the luxury to connect
using a local wireless
Internet access point, and
seamlessly switch over to a
mobile network. Motorola,
in cooperation with Proxim
and Avaya, has developed
such a hybrid phone. The
result is greater flexibility
in mobile
communications—as well as
potential slash in costs.

The phones will
combine the three
technologies—WiFi wireless
networks, VoIP and wireless
broadband.

Early versions of WiFi
phones failed miserably
because of the drain on the
batteries, which had to
support two chipsets, and
also because users were
forced to manually switch
between networks.
Motorola solves the
automatic transfer
problem. Carriers are
promising fabulous
scenarios by December this
year. A user could start a
call on an office WiFi
network, switch to a cell
phone network as he
travels outside the office

building, then conclude
the call on a home wireless
network—all without any
interruption.

MICRO NOW MACRO

Toshiba Gets
To 60 GB 

Toshiba has recently
added 30 GB and 60 GB

models to its 1.8-inch hard
drive line-up, both offering

the highest areal density of
any hard drive of that
format.

The two models feature
one and two 30 GB platters,
respectively. Both offer an
areal density of 93.5 GB per
platter. Both have 2 MB of
buffer memory and offer a
15 ms average seek time. The
drives can each cope with
knocks and bumps of up to
500 Gs for 1ms while
running, or 1,500 Gs for 1
ms when the drive heads are
parked. Toshiba said that the

Pulse

Digit Caption
Flexible working hours,
they said. First class
travel, arrangements,
they said...

Every month, Digit will carry a
funny caption for a photo. Come
up with something funnier, and
beat them at their own game!

Photograph Jiten Gandhi

Send your captions to
beatthat@thinkdigit.com
and win an Optical
Mouse from Logitech

Electronic Goodies
FFaabbmmaallll..ccoomm’’ss Discount Store has a
remarkable collection of electronic
goods. Save Rs 6,150 on the Che-Ez
Boxx Digicam, originally priced at Rs
9,995. Or grab a Rs 4,999 portable
MP3-VCD player at half the price.
Maybe you could even use the 79 per
cent discount on the cool Mouse
Phone to buy it for a meagre Rs 425.
Walkmans, digital diaries, wireless
intercom sets—you name it, you got it.
All at bumper discounts.

http://www.fabmall.com

Cheap Cell Phones
SSiiffyy..ccoomm has some really affordable
deals this time around for cell
phone freaks. You get to choose
from Nokia, Samsung, Motorola,
Siemens, and Sony Ericsson. Go get
that Rs 18,499 Nokia 5100 for just
Rs 11,499. It’s Rs 3,600 off on the
sleek Nokia 6800, originally priced
at Rs 12,599. The Rs 16,290 Siemens
S55, up for grabs for just Rs 11,790,
is just one of many other great deals
in here.

http://sify.com/shopping/ 

A Selection Of Best Offers From Popular E-commerce Sites

Last Month’s Winner!
Sylvester D’Souza (Goa)
Side effect of a Microsoft OS
on a PDA—BSOD (Bald Screen
Of Death)
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two drives will ship in the
fourth quarter of 2004. This
puts a timeframe on the 60
GB iPod that has been
anticipated ever since a
Toshiba staffer admitted that
the company had a 60 GB
model in the works, and
that Apple was a 
big-time customer.

Pricing, however, is yet
to be disclosed.

OPT-IN REQUIRED

FCC Bans Cell
Phone Spam

The US Federal
Communications

Commission has finally
decided to crack the whip.
The FCC recently voted to
outlaw all unauthorised

text messages to mobiles
and pagers without
permission from the owner.
However, it
remains to be
seen whether the
law is going to
actually work.

The US
Congress sought
strict rules for cell
phone spam from
the FCC last year,
while passing the
Controlling the Assault of
Non-Solicited Pornography
and Marketing (CAN-SPAM)
Act of 2003 last year. CAN-
SPAM allows spammers to
send unsolicited
commercial e-mail to e-mail
accounts until the recipient
opts out of receiving e-mail
from that sender. But it
hasn’t been too successful
in tackling this nuisance.

The FCC’s action this
time requires an opt-in.
Commercial entities

sending text
messages to mobile
phones and pagers
must get
customers’
permission before
sending them.

Opt-out or opt-
in, there is little
doubt that
spammers will

dodge the new law, and
come up with newer ways
to spam us. If our fears are
right, cell phone and
smartphone attacks will
shoot up in the years to
come.

GOING UPMARKET

Indian PC
Market 
Shoots Up

According to Gartner, the
Indian PC market grew

34.6 per cent, with more
than 7.6 lakh units being
shipped in the second
quarter of 2004.

Vinod Nair, Analyst-
Computing systems,
Gartner India, said,
“Healthy economic
conditions coupled with
increase in run-rate
business resulted in a good
second quarter this year.
The election quarter and
expectation of further
reduction in prices due to
the financial budget
caused a marginal halt in
desktop purchases during
the last two weeks in
June... but the upward
trend continued.”

Desktop sales grew 32
per cent; notebooks grew
123 per cent, constituting
five per cent of the total
shipments this quarter.

HP was the market
leader with a 14.9 per cent
share. HCL follows at 11.9
per cent. The growth has
come at the expense of
assembled PCs. 

This indicates four
trends. First, the increased
market share of branded
players means there is little

to choose between branded
and assembled machines.
Also, branded players now
offer customisation in their
PC solutions, and this is
something the Indian
market sorely needs.

Third, and perhaps most
important, companies such
as HP and HCL are moving
on to services and value-
addition. 

Finally, with most users
having desktop PCs for quite
a few years, they are steadily
moving towards laptops or
high-end machines.

Trust Busters

In order to write the ‘Old Way,
Tech Way’ article (Page 77), we

had to file income tax returns
online (Tech Way). Everyone sug-
gested FileMyReturns.com, so
we logged on.

They had three plans on offer:
The Rs 99 plan, where you do all
your calculations online, download
the filled forms, and submit them
yourself. The second plan costs Rs
200, and the only difference is
that they send a representative to
pick up the forms from your house
and submit them. The third plan
costs Rs 250, and only needs you
to contact them—their representa-
tive comes to you and fills and
submits everything. 

We applied for all three plans,
filled out the contact information,
and then waited... and waited...
Three days later we e-mailed their
helpdesk, nothing... As of going to
print, over 10 days after contact-
ing them, and over 15 days after
registering on the site, there’s still
no reply.

Opt-out or 
opt-in, there
is little doubt
that
spammers
will dodge
the new law

GENDER 

BENDERS

Aditya, an engineering student, is brimming with
confidence, itching to lay his hands on the PDA. No sooner
did he grab the gadget that it briskly turns on. He smartly
runs the stylus on the screen. In no time, he is looking up
the drop-down menu of utilities. Eureka!—“There’s the
Sketcher,” he gasps, beaming. Little time is lost in scurrying
back to the main menu again and switching the PDA off.
Boy, that was really fast!

Aditya Govindarajan vs. Jayshree Haran
Find The Sketcher Tool On The
Zire 71 PDA 

20 sec.

1 min
40 sec.

There’s a slight worried look on Jayshree’s face when she
takes hold of the PDA. The engineering student takes a few
moments before launching the hunt. Oops, a few unsure
moves. More follow. After groping for the utilities for a while
more, she finally tracks it down. Ah! So, here’s the elusive
sketcher. But that’s just the job half done. She’s gotta escape.
She rummages all over the screen with the stylus, looking for
the main menu, overlooking it several times, till she finally
manages to make it.
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WWAN CHIPS

Intel For 3G,
WiFi Chip

Just as the news comes
that companies like

Motorola will ship WiFi
mobile phones, Intel is
gearing up to release a
wireless chip that is capable

of talking to both WiFi and
3G phone networks. Intel
said it will ship a joint
802.11a/g product soon,
though it is not clear where
this chip is to find use. The
chip has been dubbed
‘WWAN,’ for ‘Wireless Wide
Area Network’, and Intel
might pitch it towards
handset makers.

An Intel spokesman said
that the picture may
become clearer in two

months, hinting at an
upcoming announcement
surrounding, in general, the
ability to roam seamlessly
between WiFi hotspots and
mobile phone networks. The
announcement is likely to
be made at the Intel
Developer Forum, which
opens on September 7.

Products that are
already available, which
could make use of the new
chip, include mobile data
cards for notebooks, which
incorporate 3G or
GSM/GPRS radios along with
WiFi capabilities. Software
comes into the picture,
too—several firms are
working on software that
will allow the user to move
seamlessly from one type of
network to another. 

Intel is working on that
part, too.

What is an OLED?
An Organic Light Emitting Diode
is an organic molecule (carbon,
as opposed to silicon-based)
that emits light when teased
with electricity. This simple
concept requires one to find the
right molecule to get the right
colour, and you are all set for
dazzling displays. Displays made
with OLEDs save both on
thickness and power.

Who invented OLEDs?
Kodak researcher Ching Tang, a
Hong Kong-born chemist
working in Rochester, New York,
noticed a blue glow emanating
from one of the organic solar
cells he was working on.

How did he develop OLEDs?

Tang investigated the above
phenomenon and published a
paper on the results in 1987,
concluding that organic materials
were efficient converters of
electricity, were great to show
moving images and needed a low
voltage to glow.

Why do we need OLED
displays?
OLEDs are thin. They can be
sprayed or printed on to very
thin substrates; they neither
need high-voltages to be driven
nor additional power to
backlight them. They also have
a higher contrast and look
equally bright from all angles.

Where can I find OLED
displays?
Right now, as screens on small
devices. Typically, an external
screen of a cell phone is likely
to be OLED-based, if at all.  

When can I find OLED displays
everywhere?
2005 is going to be the magical
year for OLEDs. Expect them to
proliferate from small devices
such as cameras, cell phones to
laptops and monitors, etc.

Organic Light
Emitting Diode

Technology is trying hard
to be sexy. From Intel’s

Centrino to the Apple iPod,
small, chic, a study in white,
technology now attempts to
connect with its audience.
BenQ calls it engagement
versus intrusion—generate
emotional value around a
product to engage the buyer.

At Taipei, where Digit
visited BenQ’s home ground,
its products may be little
known. But it is investing a
great deal in building its
brand. From LCDs to
keyboards. AUO is the third
largest manufacturer of LCD
displays and BenQ has a
meaty 14 per cent stake in
the company. This gives
them an edge in an area
which is both capital and
technology intensive. Indeed,

LCD TVs, monitors and large-
screen smartphones such as
the P30 and the P50 are
harbingers of the OLED
products that will soon
follow (see “W5H”
alongside).

Jerry Wang, Executive
Vice-President and Chief
Marketing Officer, isn’t too
keen though about Tablet
PCs. “Embracing a new
product category is too
dangerous,” he told Digit. 

Slim 17-inch LCD
monitors, widescreen
Joybooks, Flash-based Joybee
MP3 players, digital cameras
with touch sensitive LCD
and friendly UI, projectors,
LCD TVs, scanners,
keyboards, funky optical
media—what’s common to
all this? Fashion and
lifestyle, not technology. The
colours, the organic shapes,
all speak the same mantra.
There’s only one focus all
along—people. It explains
why BenQ has more software
engineers than for
hardware. The interface is a
more important issue than
most others.

Ease of use is paramount.
The iPod, the Treo 600, the

TiVO stand out for user-
friendliness. Peter Chen, Vice
President and General
Manger, Digital Media, said
that Windows Longhorn was
“getting even more
complicated.” 

Chen informed that
every home in Taiwan has
an Ethernet connection, and
that the digital home is not
all that far-fetched. He said:
“We are not talking about
connecting fridges and
microwaves. We are talking
about connecting storage
devices, something more
real.” Many IT companies are
going for convergence today.
But Chen’s words will keep
ringing for long—“Who can
make it first and easier to
use is the consideration. 
We hope to be the first.”
First and sexy, don’t forget
the sexy. 

(Senior Writer Ahmed
Shaikh visited Benq’s

headquarters on invitation.
This report is meant only for
information. Digit does not

endorse Benq’s products 
listed in the story) 

Here Comes The Chic
TECH FOCUS ON PEOPLE, BENQ TELLS DIGIT
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Fuelling the pursuit of technology knowledgeWhat Threats
Lie Ahead

Demystifying
The DVD40

Passion
Digital

Meera Vankipuram

hen we heard that
Salman Khan battles
six Akshay Kumars in

David Dhawan’s Mujhse Shaadi
Karogi for the hand of Priyanka
Chopra, we thought of many
doubles with bad wigs and
mismatching body sizes. How-
ever, we were in for a pleasant
surprise when we saw the
movie—there actually were six

Akshay Kumars! Special effects (SFX) in Bolly-
wood movies are hitting new heights.

Directors are now looking for that something
extra to make their movies a tad more special—
just a good soundtrack doesn’t cut it anymore in
India. It’s not just Bollywood either: whether it’s
TV serials, sports programmes, music videos, or
animation films, we expect so much more in
terms of visual appeal. If the Wachowski brothers
can do it for The Matrix Trilogy, why can’t we?
Dhawan’s flick has nowhere close to the amazing
SFX that thrilled us in the Matrix, but it’s a start!
Other movies such as Rudraksh—where the SFX is
more comic relief than awe-inspiring—could have
used some professional SFX help.

Indian cinema and production houses are
beginning to adopt advanced SFX techniques
such as Motion Capture and Motion Control—a
combination of which made Neo appear super-
human in the Matrix. 

John Gaeta, visual effects supervisor of The
Matrix Trilogy, used a technique called ‘Bullet
Time’—inspired by the popular Japanese anima-
tion style ‘animé’.  He also coined the term ‘Vir-
tual Cinematography’—the process of
translating the Bullet Time technique on to the
big screen. Virtual Cinematography helped

depict action-packed, surreal scenes in slow-
motion, as seen by a camera moving at regular
speed. The result was super-human feats,
accomplished at a level of realism never seen
before. Motion Capture (MoCap) helped
create these virtual super-humans.

Inside MoCap
MoCap is a process that uses subjects in spe-
cial suits that contain several ‘data points’.
Data (an action sequence or movement) is
transmitted to the computers using wired
or wireless technology, and cameras. Tex-
tures can be added to create realistic ani-
mated imagery. 

The subject, whose motion is cap-

Main Story

Playing God
Games 
Manan Plays38 44

SEPTEMBER 2004 DIGIT

The Indian entertainment industry looks good these
days, and it’s all thanks to some very special
effects...

W

Im
aging Parag Joshi
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tured, usually wears a body suit with reflective
markers taped or glued to specific points all over
his or her body. Several cameras film the subject as
he or she performs specific motions—for example,
the multiple Mr Smiths in The Matrix Revolutions
were created by mapping actor Hugo Weaving’s
face and then transposing it on to the CG replicas. 

The cameras report the exact position of each
reflective marker, hundreds of times a second, to
a computer. A magnetic system can also be used in
place of the optical system—a sensor detects a
nearby magnetic field and transmits data on its
3D position to the computer. Camera motions are
also fed into the computer. MoCap software then
processes this data to determine the exact move-
ment of the subject. The animation data exported
by the computer, can be manipulated using soft-
ware such as Maya or 3D Studio Max.

MoCap in India
The word ‘animation’, a decade ago, would invoke
thoughts of cartoon characters—remember Bugs
Bunny? Today, realism is key, and movies use ani-
mation techniques such as MoCap to achieve this
realism in tales of fantasy. MoCap is also used in
computer games and television shows. 

In India, very few animation studios have
invested in MoCap systems, mainly due to the
absurdly high costs of the equipment. Pentamedia
(Chennai) and FX Factory (Mumbai) are two studios
that have spent the big bucks on this equipment. 

Chennai-based Pentamedia have one of the
largest Motion Capture facilities in the world. The
company has produced full-length animation
films (including Sinbad—Beyond The Veil Of Mists; Pan-
davas—The Five Warriors; Alibaba and Son of Aladdin),
and also specialises in SFX for Tamil (Shankar’s
Jeans) and other regional language films.

Pentamedia’s setup includes high-speed
Falcon cameras, capable of running between
speeds of 60 to 240 frames per second (fps). The
cameras read data from special scotch-brite type
markers that are fitted onto a subject’s body. The
cameras can capture data from anywhere within
the 20 x 20 ft capture area, and software such as
3D Studio Max, Maya and Soft Image can use this
data to create the required animation.

Riyaz Babu, who manages the 80’x 40’x 80’
Mo Cap facility at Pentamedia says, “Our Optical
Mo Cap system enables data capture from mul-
tiple characters, animals, stunt and sports
sequences as well.”

FX Factory’s 50-member team of animators,
art directors, storyboard artists, sculptors and
visual effects supervisors is led by special-effects
expert Ramesh Meer. They use full-body motion
capture systems—Gypsy 2.5 and Gypsy 3.0, man-
ufactured by Saicom Studio Systems. Gypsy is a
cost-effective MoCap system, and has a large
wireless capture range—up to half a mile (800 m)
outdoors and up to 200 yards (180 m) indoors.
This system does not require cameras, and
records motion directly from the body. It is also
portable, and works with any PC.

Fantasyland
The character ‘Gollum’, in Peter Jackson’s trilogy
The Lord of the Rings (LOTR), was filmed using
MoCap. Oscar-winning director of photography

Andrew Lesnie and his team first captured actor
Andy Serkis’ performance on the set. Animators
then used his movements and facial expres-
sions, captured with MoCap cameras, and
applied them to the animated Gollum. Motion
capture photography, CG imagery and digital
sound mixing combined to produce what you
saw in LOTR. 

MoCap starred in George Lucas’ Star Wars -
Episode II Attack of the Clones, especially in the
form of Jar Jar Binks—a completely CG character,
played in costume by Ahmed Best. Jar Jar, inci-
dentally, was the first CG character in Holly-
wood filmdom ever to interact realistically with
live actors.

MoCap has been used to create mind-
blowing SFX in films like Titanic (1997), Gladiator
(2000) and, of course, The Matrix series. Even full-
length animation films such as Columbia Pic-
tures’ Final Fantasy: The Spirit Within are believed
to have used MoCap data.

Hotshot director John Woo is currently
exploring the possibility of translating Nin-
tendo’s best-selling video game franchise
‘Metroid’ onto the big screen—large portions of
which will involve MoCap. Robert Zemeckis’ The
Polar Express (due for release in 2005) plans to use
MoCap to create an animated character ‘played’
by Tom Hanks.

MoCap is also used to create games such as
Electronic Arts’ FIFA and Cricket series, games
based on the LOTR trilogy, and James Bond 007:
Everything or Nothing, in which actor Pierce
Brosnan’s expressions were digitally mapped.
James Bond: 007 Nightfire, a cinematic simulation
of the original Bond game used MoCap for half
the project—the rest was animated by hand. 

Bangalore-based Dhruva Interactive, a game
developer, was the first Indian company to be
signed on by a major global publisher to develop
an international title—Mission: Impossible PC, in
1999. Says CEO Rajesh Rao, “We used MoCap stu-

MoCap equipment helps animators study movement precisely

Origins

MoCap probably
takes its origin from
rotoscoping, a
process that involves
creating a series of
drawings by
projecting individual
frames of an actor's
filmed performance
onto sheets of paper.
These drawings are
then filmed to create
an animated
sequence, which can
be as lifelike as
possible, in
appearance and
movement. Disney
Studios used this
method to create the
human characters in
Snow White—the
animation was traced
out over film footage
of live actors playing
out the scenes.
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dios in the UK and US to develop this game,
because the required pantomimes were not avail-
able in India. Besides, MoCap equipment is very
expensive. We would rather hire studios for a few
days, as even the voice recording for interna-
tional games has to be done abroad.”

Howzzat!
Sri Lankan spinner Muttiah Muralitharan’s con-
troversial ‘doosra’—the leg spin delivery bowled
with an off-spin action—was subjected to a series
of tests at the University of Western Australia’s
human movement department, using twelve
high-speed MoCap cameras shooting at a speed
of 250 fps. 

A team of bio mechanists studied this doosra
under controlled conditions. Reflective markers

were placed on Muralitharan’s body,
which were then captured by the

cameras and computers. The
actual analysis was computer-
generated.

In 2003, the International
Cricket Council (ICC) adopted
an analytical software tool

called e-Cricket Pro, produced by
Bangalore-based Phoenix
Global Solutions India (PGSI)
Private Limited to train
umpires for international

games. This software was also used by the Indian
cricket team for game training and analysis. 

Many Indian players, including former Test
cricketer Javagal Srinath and the inimitable
Sachin Tendulkar—who studies his game on a
laptop (one is provided to each member of the
cricket team)—are believed to have benefited from
motion analysis software. Motion analysis also aids
injury prevention, and opportunities to study the
effects of orthopaedic or athletic devices.  

Apart from the Phoenix software, the Indian
cricket team also uses a video-based motion
analysis system called Silicon Coach, developed
by Joe Morrison, a bio-mechanist from New
Zealand. The system helps analyse players’ tech-
niques through four basic processes—error detec-
tion, analysing why the problem occurs,
planning a solution to the problem, and finally,
communicating with the player to implement

the suggestions.
This software is marketed in India by S

Ramakrishnan, a former First Division player,
IBM certified computer professional and head
of Meru Sports Technology Services, Chennai,
which offers video-based motion analysis for the
Indian cricket team. “Over time, small changes
creep into a player’s techniques without his or
her knowledge. Video analysis helps you to iden-
tify these problems at an early stage, and pos-
sibly correct them,” he says. 

Silicon Coach is currently being used by the
BCCI, National Cricket Academy, MRF Pace Foun-
dation, Tamil Nadu Cricket Association,
Mumbai Cricket Association, Bengal Cricket
Association, TNTA and the Golf Federation. “We
have also worked with world class coaches such
as Dennis Lille, Bobby Simpson, Bom Woolmer,
Peter Philport, Graham Gooch, Bruce Reid, John
Wright and bio-mechanists from India and
abroad, including Bruce Elliot and Mark Portus
of the ICC,” adds Ramakrishnan. 

The ‘Time Warp’ feature in Silicon Coach
provides instant feedback to players. A bowler
can check and correct his action immediately
after a delivery. “Though Silicon Coach is ideal

for self-analysis, the
presence of a coach
will definitely help the
player,” Ramakrishnan
says. 

TA Shekhar of the
MRF Pace Foundation,
one of the first institu-
tions that invested in
the software, says,
“Almost all the boys
who have trained at the
Pace foundation have
used Silicon Coach to
analyse their style and
performance. Bowlers
like Irfan Pathan,
Zaheer Khan and all

the others too.”
Indian coach John Wright is also believed to

be doing extensive research on opposition teams
studying data compiled by computer analysts
such as Ramakrishnan.

The Motion Control Maya
Another emerging technology called Motion
Control also helps achieve an effect similar to
MoCap. Motion Control systems use computers
to control camera movements. Replication
(many clones of the same actor), for example, is
made possible thanks to Motion Control. An
actor is filmed in one position using motion
controlled cameras, and then again in a dif-
ferent position. This creates a series of shots
where the background is identical, as are the
movements the camera makes. These shots are
then collated on a computer to yield multiple
copies of the same actor in the same scene.

A year ago, Mumbai-based Prime Focus Ltd
went where few Bollywood enterprises would
fear to tread: studio heads Naresh and Namit
Malhotra  decided to invest in Motion Control
equipment that cost them nearly Rs 3 crore. 

Hardware Requirements

Motion capture involves map-
ping ‘data points’ (usually at

the joints) of the subject. The
process involves the use of electro-
magnetic fields and magnetic sen-
sors, or by using special markers
that reflect the infra-red light that
comes from illuminators, which is
then captured by MoCap cameras. 

The captured data is then
analysed using specialised soft-
ware (such as Kaydara MOCAP, for
example), which renders the per-
former's movements on 3D charac-
ters in real-time. The data can
then be edited and manipulated

using animation tools, or advanced
mapping technologies by applying
motion data to characters.

MoCap equipment is very expen-
sive—the digital cameras, lights, and
the software required
are extremely
high-end, and
very few stu-
dios invest in
the equipment.
The risk of
obsolescence,
too, runs high
with any such
technology.

Motion control cameras can achieve super-human shots

The Vicon VCam
MoCap camera

“Like MoCap
software, Flair
(used by Motion
Control
equipment) is
compatible with
most animation
software such as
Maya and 3D
Studio Max,”
Sandeep Sethi
Manager- Motion Control,
Prime Focus Ltd

Testing Murali’s
‘doosra’
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According to Rajnish Sah, Manager Opera-
tions, “The rig is the only one of its kind in the
country.” It has added zing to several ad-films,
Hindi feature films, television serials, documen-
taries and music videos.  You can see the Motion
Control effect in the Titan Raga watch advertise-
ment with multiple Gul Panags, and also in the
Palmolive Aroma talcum powder, and the LML
Freedom bike commercials. “The French com-
pany that had commissioned the Palmolive adver-
tisement were so impressed by the Indian version
that they flew the model down to India, and the
international version was also shot here,” says
Sah. (Find the actual clips on the Digit DVD.)

Prime Focus is also responsible for the Mujse
Shaadi Karoge scene. Motion Control was used
there to replicate the six Akshay Kumars. (See the
movie clip on the Digit DVD.)

Prime Focus has a seven-member team, led by
Manager Sandeep Sethi, to run the Motion Con-
trol rig. The equipment is powered by ‘Flair’—a
software that helps the operator build complex
moves and coordinate all the axes of the Motion
Control system. “Like MoCap software, Flair is
compatible with most animation software such
as Maya and 3D Studio Max,” says Sethi.

The Motion Control equipment can track,
rotate, lift, pan, tilt, roll, zoom, etc., when
shooting a scene. Its geometry allows it to per-
form these moves from ground level to a max-
imum of 4.1 metres (13.5 feet) with minimal
image jerkiness. The rig can repeat a complex
series of such moves with the flick of a button—

something no human cameraman could ever
achieve. It is also used to replicate crowds, make
objects appear and disappear (the Hindi movie
Gayab was filmed using Motion Control), and
juggle background imagery. 

Motion Control has been employed in the
making of films such as Harry Potter and the Pris-
oner of Azkaban, Alexander, The Matrix (Reloaded
and Revolutions), James Bond: Die Another Day, Stuart
Little 2, Terminator 3, and Black Hawk Down.

Techniques like Motion Capture and Motion
Control represent the acme of synergy between
technology and human creativity. MoCap makes
it possible to create fluid, life-like character ani-
mation, in a faster, easier and more realistic
manner than traditional animation. Motion Con-
trol helps capture near-impossible camera angles
to add a dash of the unreal to cinematic action. 

Whereas MoCap technology in its current
avatar can record only the movement of a few
key points on the actor’s body (where the reflec-
tive markers are placed), in the not-so-distant
future, MoCap sessions might be able to capture
the complete frame of a person, from several
angles. Every inch of the actor’s body can be
mapped, thus providing animators MoCap data
with higher resolution of detail. 

However, all the advanced equipment in the
world will not create a Matrix, or a LoTR—that
requires the ability to put such equipment to
good use, and of course, some out-of-the-box
thinking—Wachowski ishtyle! 

meera_vankipuram@thinkdigit.com

1/2 Pg H AD

Gollum was brought to
life thanks to MoCap and
Andy Serkis
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Solution

Price Rs 3,648

Before you proceed, remember that overclocking
your video card nullifies its warranty. 
To overclock your video card, use  EnTech

Taiwan's Powerstrip (http://www.entechtaiwan.
com/ftp/pstrip.exe) and test whether the speed is
safe using Artifact Tester (http://www.3dcht4u.de/
3dc/kfd53t5fes8z/artifact-tester.zip).

First, ensure that no programs are running in the
background. Start PowerStrip, click on its system tray
icon and go to Performance profiles > Configure.
The ‘Performance profiles’ dialogue has two sliders:
one on the left to adjust the clock speed of the GPU
and the other to adjust that of the video memory.

Move the sliders up to overclock. Avoid taking
long strides; increase the clock speed by 4 MHz at a
time and click OK or Apply. Initially, increase both
the video chip and memory clock speed in this man-
ner. You can overclock most video cards to achieve

speeds that are
around 10 per
cent above
their default
specifications.

A video
card over-
clocked above
its safety limits
shows arti-
facts—random

dots and lines on the monitor. Unpack the artifact-
tester.zip file to a folder and run ArtifactTester5.exe
from that folder.

Use PowerStrip to overclock your video card by 4
MHz. Now, click on 'Begin Test' in Artifact Tester. The
bottom right of the window indicates if any artifacts
were detected, when the test completes. For a start,
select 'Average' under ‘DirectX Testing Strength.’ You
may also want to use software testing methods to be
completely sure that artifacts are not produced.
Increase the clock speed if it does not detect arti-

facts. If it detects some, then lower the clock speed
by 1 or 2 MHz and test again. Note the final stable
clock speeds. This is the 'absolute maximum clock
speed' (AMCS) that your video card can safely reach.

If your system freezes, return to the previous
clock speed value and take that value as the AMCS.

You may also launch the Artifact Monitor by
clicking on 'Launch Artifact Monitor', located at the
upper left of the monitoring application. Keep this
window open as you go about detecting artifacts
while overclocking the video card.

To be on the safe side, lower clock speeds by
around 4 MHz below the AMCS since the video card
tends to get heated when playing 3D games and may
produce artifacts during game play or worse, get
fried. Overclock the video card above the AMCS only
if you have a PC cabinet with proper ventilation and
use a cooling solution for your video card such as a
better heat sink/ fan combination. 

Additionally, ATi card owners can use the ATi
Tool (http://atitool.ocfaq.com/), whereas nVidia
card owners can employ Riva Tuner
(http://www.guru3d.com/rivatuner) and NV
Hardpage (http://www.guru3d.com/nvhardpage).
Use these only if you are adept at overclocking.

This
Month’s

Challenge

Insert an item in
the menu that
opens as you

right-click on a
Web page in

Internet Explorer

Rules and Regulations
Readers are requested to

send in their answers by the
15th of the month of
publication.

Employees of Jasubhai
Digital Media and their
relatives are not permitted to
participate in this contest.

Readers are encouraged to
send their replies by e-mail.
Jasubhai Digital Media will not
entertain any unsolicited
communication.

Jasubhai Digital Media is
not responsible for any
damage to your system that
may be caused while you are
solving the problem.

Every month, Digit will pose a question
that will set you thinking. Digit
challenges the geek in you to take a

crack at the problem. If you indeed crack it,
send in your answers to Digit with your full
name, address and contact details to
takeacrack@thinkdigit.com. Digit’s Test
Centre will select the correct answers. In
case of multiple correct entries, the winner
will be decided by a draw of lots.

Win!

Last Month’s Challenge Was:
Can you overclock your graphics card safely without causing a crash?
The winner of the Microsoft keyboard and mouse is Jayesh C. Limaye.
Congratulations, Jayesh!  His solution is published below...

Overclock Your
Graphics Card—
Without A Crash!

Artifact Tester diagnoses whether the performance boost
leads to artifacts

Powerstrip lets you load and select
performance profiles

Sponsored by



Digital Passion l 30 days with...

SuSE Professional 9.1
Ahmed Shaikh

Circa 1994. I was weaned on Slackware,
moved on to Red Hat, and flirted briefly
with Mandrake. Along the way, I had a

GNU/Linux epiphany: call me when you have
better font-support, when the X server does not
hang my system or when an application stops
the rude memory-dump-to-my-desktop-and-exit
game. The call came in 2004. 

ahmed_shaikh@thinkdigit.com
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Day 1
5 CDs of SuSE Professional 9.1 dare me. I boot into a pretty blue and whiteinstallation screen—a long way fromSlackware’s textual installation. Excellent layout here, good use ofhyperlinks, well-presented relevantinformation—everything was logicallyplaced.

I made changes, mostly because Icould… showed off my 133t skills to ayounger brother. Reiser FS, five partitionsand a 512 MB swap, all set.

Day 2
Things change all the more…Boots into X by default. I don't like thegraphical bootup, seems most unLinux-like. 

SuSE took me to KDE: decent fonts allaround, which, given its history, surprisedme. I have heard a lot of negatives aboutthe KDE menu—its busy layout mostly—didn’t bother me. KDE wasn’t aware of mymonitor though, which is ridiculous sinceits installation detected it fine. Oh well, the hunt for the KDE versionof the Control Panel begins…

Day 3
Well hidden, in plain sight. Themonitor setup is a ninja waiting inthe shadows; you won’t see it until it’sbreathing down your neck. Right-clicking on the desktop just lets youchange wallpapers. The defaultdesktop needs serious makeup; time tofind out just how flexible KDE is interms of looks.

Day 4
Very flexible. I love it...Settled for a pseudo-BeOS look, althougham certain there is a better one out there.I must communicate with the world… But dude, where’s my network? Some

trials and errors later, I have Internetaccess. 

Day 5
Opera on KDE, feels like home already. Oh,I almost forgot: KDE supports system-widemouse gestures _grins_

Day 12
Grrr, plugins! Where are my plugins? 
Day 17
Multimedia on Linux? Hmm, worth a try, at least I will get alaugh or two out of it. Foobar 2000 gotthe closest to my Quintessential (QCD)Player experience on Windows. I likeFoobar, but QCD (not for Linux, alas) isstill the best around in terms of ease-of-use. I am looking at you, Winamp.

Day 25
Let’s try getting some work done withKDE! Kidding, just kidding, lower yourflamethrowers. OpenOffice.org actuallyboots slower on KDE than on Windows.KOffice is OK, but it does not offer that MSOffice feel. Since I am migrating, OOo itwill be. It works. Yes, it can behave a lotbetter as per cross-compatibility with anMS Office document…

Day 28
I did try Gnome—the one with theridiculously small fonts—for a while. Ihave neither the time nor the patience todo the font tango with Tux. Gnome, I loveyou mate, but you will have to wait. Bythe way, where is my Ximian desktop?Nautilus rocks, spatial-browsing and all.

Day 30
30 days just aren’t enough. SuSE surprisesme equally with its brilliance andstupidity. I am intrigued enough to givethis relationship more time.



T
he Athens Olympics was one of the world’s biggest sporting events.

The L Athens Display is one of the world’s biggest computer displays

ever. At 92 inches and resolution support up to 6,400 x 1,200 pixels,

you get to work on them only with professional quad-head display adapters.

Why would you want this? One, it will make you the talk of the town, not

just the neighbourhood. Two—and more importantly—you can work on

multiple applications at the same time without taking an appointment with

the ophthalmologist, thanks to its double anti-glare hardcoat. It can

interface with any platform—PC, Mac, HP, SGI and Sun.

Its feet are detachable, making the display wall-mountable. The L-Athens

display can be used for creative, medical, military, engineering modelling,

high-end audio-video editing, and TV broadcast applications.

At 48 kg, it is not lightweight by any standards. You need a heavy wallet,

too. In American money, it costs $20,000. In Indian money, that is around Rs

10 lakh, not counting the taxes, duties, and shipping costs. 

Whoever said size doesn’t matter?

L Athens Display

The picture of the L Athens
was so big we couldn’t fit it
on the page with the right
dimensions! So, we put a
17-inch LCD monitor to let
you know what 92 inches of
monitor madness really
looks like

Digital Passion | Geek Dreams
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Ahmed Shaikh

here are geniuses amongst us. Young,
unassuming characters, destined to
change the way you think, work and live.

Abhinav Dhall, 19 years old: The World to a
religious homemaker, brother to a fellow
student, and son to Tarsem lal Dhall, an
Executive Engineer under the Pushpa Gujral
Science City project and a role-model to Abhinav.
His favourite movies are Armageddon and Kal Ho
Na Ho. He also enjoys the Backstreet Boys.

Vibhore Jain, 20 years old: Best friend to his
sister, Sonu to his mom and his father, an insur-
ance advisor with TATA AIG. He loves classics—
Ben-Hur is his favourite movie, Mark Twain one
of his favourite authors, with Robert Frost’s

seminal beauty Stopping
by Woods on a Snowy
Evening his inspiration.

Both Abhinav and
Vibhore are second-year
students at the D A V
Institute of Engineering
& Technology (DAVIET),
Jalandhar. Under the
auspices of Sandeep

Kath, a 24-year-old computer science BTech, and
faculty member, the dynamic duo has created a
supercomputer for all of us. Codename: Prerna.

How it All Began
DAVIET dabbles with fibre-optics and electronic
simulations. Research needs that require
computational power upwards of the gigaflop
range. Affordable faster machines were needed.
What better way than to maximise the potential
of the desktop computers that filled two labs
within the DAVIET campus? Enter clusters!

A cluster is a collective of PCs or “nodes”
with task-masters, which divide tasks between
the nodes—the more nodes there are, the faster
the cluster. Prerna hired openMosix as the over-
seer, which sits atop a Linux kernel, openMosix
and distributes work amongst the lab PCs. 

Each node handles smaller tasks, has greater
access to a cluster-wide memory, and finishes a
job faster as a single unit. Thus was Prerna born.

“The idea struck us when I read an article on
Beowulf in Digit,” recalls Abhinav. “We began by
analysing the technologies available for paral-
lelising computational tasks. We started with
PVM on Windows and then tested MPI on
Fedora—the most demanding part was that for

T

Abhinav Dhall, 19
Second year student

Vibhore Jain, 20
Second year student

Sandeep Kath, 24
Faculty Member

When three
young and
unassuming
geniuses from
Jalandhar get
together, this is
what they come
up with—
a Linux-based
supercomputer!
Meet...

A

OpenMosix gets the work done
Nodes A, B and C are part of a system-wide OpenMosix cluster. Node
B needs more computation power to complete a task, while Node C
needs more memory to store data brought in by workers. Both send
out requests, which Node A acknowledges by transmitting power to
Node B and allocating memory to Node C

B

C

Team Prerna

Digital Passion l First Hand
Info graphic Solom
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Looking Ahead
While travelling at faster-than-bullet speeds along
the roads laid by Moore’s Law, the semiconductor
industry has hit the proverbial wall. Diminishing
returns and migrating electrons have made
shrinking processors an uneconomical strategy. It
seems the future lies in multi-core processors. 

Clusters and distributed computers already
exist. By parallelising a task, a cluster offers
supercomputer speeds at a fraction of the cost.

“The speed and portability [of Prerna] inter-
ested us,” Vibhore tells us, adding, “We imagine
clusters being used instead of expensive servers…
end-users will use these services to fuel ultra-
modern gadgets such as wearable computers. At
present, clusters will find more penetration in
institutes and universities in India.”

Presently, Prerna is used for “number crunch-
ing problems, and rendering using Blender and
POV-Ray.” Vibhore discusses plans to outsource its
power, “We can provide computational services to
agencies, which have massive calculation require-
ments. We can also help  companies migrate from
Windows to Linux, and set up clusters.”  

Abhinav chips in with a view to tomorrow,
“We intend to shift it to the R & D facility of our
college. Prerna will be used for MATLAB and
fibre-optics simulations and for SETI@Home!”

The success of Linux with Prerna is also the
inspiration for a cheap hardware routing solu-
tion. When their college router got “useless ARP
packets”, they thought of creating a router of
their own. Abhinav says, “The main node of the
cluster can also act as a router. For this, Vibhore
and I are looking for a good firewall. The next
phase will be to make router from very cheap
hardware. Our estimate is Rs 7,500. We are study-

ing FREESCO to gain knowl-
edge. The cheap box concept
is based on embedded Linux.”

A likely application for a
distributed or a cluster-based
computing system, such as
the Grid initiative, is to
harness the power afforded,
to drive low-powered devices
such as PDAs. Think of a

handheld computer running Doom 3 by drawing
power from a cluster of thousands of PCs.

A far-fetched concept? “Clusters can bring
supercomputing power to small laboratories,”
Abhinav tells us, adding, “There are endless
benefits… (A cluster) can be mixed with a
SIMPUTER, where the latter will draw all the
power from a cluster, reducing the price of the
SIMPUTER to within reach of the common man.” 

Apologies to Frost: clusters sound promising
and perhaps even deep. But Team Prerna has
promises to keep, and miles to go before they
sleep, and miles to go before they sleep. 

ahmed_shaikh@jasubhai.com

both these libraries, the applications we
intended to run were not available, ” he added.

MPI? PVM? Reads like a job for the TLA (Three
Letter Acronym) police. Abhinav explained, “PVM
and MPI are parallel libraries. PVM (Parallel
Virtual machine) and MPI (Message Passing
Interface), are sets of libraries using which paral-
lel programs are developed. MPI is widely used.
Our problem is that the programs which we
have, such as the fibre-optics simulation, are
Windows-based. So, we need to run them using
VMware or WineX. But these are not optimised
for PVM and MPI. Here, customised software
development is required. A MATLAB MPI toolkit
is available, but then the cluster would have
been very specific. We wanted a general cluster
which could compute a whole lot of stuff from
simulation to games.”

Why did Team Prerna
decide to forego the
Scalability Hero of Linux
Clustering, Beowulf, for a
newcomer? The reasons
ranged from flexibility to
cost. Vibhore says, “With
openMosix, we can run
almost all Linux apps,
except Java threads. It gave us sound perform-
ance. As far as scalability is concerned, yes, we
can only add 50 nodes using openMosix.
Beowulf can run in thousands, and scores over
openMosix when a job is complex… but
openMosix is free and easier to implement.”

openMosix is a delicate balance between the
range of applications possible and the speed at
which a job is completed. Take a complex job,
such as a nuclear fission simulation, which
require “tons of complicated calculations”. If this
task is optimised for MPI/PVM, the performance
will be great, but sticking to these libraries takes
away the flexibility afforded. 

With the release of
Ragnarok Online,

Massively Multiplayer Online

(MMO) games have been
heralded to Indian shores.
Currently enjoying a beta
phase, Ragnarok will soon
come to a cyber-café near

you. Meanwhile, find it with
the August issue of Digit.
Globally, online games are
expected to grow to a $1.1
billion market by 2008

MMOs

Each node of
Prerna is
powered by an
Intel Pentium 4
processor at 1.8
GHz, on an 845
chipset-based
motherboard,
with 256 MB DDR
RAM, a 40 GB,
7,200 rpm hard
disk, over a 100
Mbps network.
Currently Prerna
has 23 such
nodes and is
expected to hit
50 soon

Write in

Assembled some-
thing just as geeky? 
Tell us about it. 
Write to firsthand@
thinkdigit.com

Girlfriends? [Smiles] Not at 
present, I think VB has one but
does not disclose... but who is 

Prerna [Laughs]?
Team Prerna, on passions of 

the female persuasion

This apples to oranges comparison indicates the effectiveness of a cluster-based system. A 23-
node Prerna is five times as fast as the dual-processor Xserve. The Xserve sells for about $4,000
(about Rs 1,88,000). Prerna, with 23 nodes costing Rs 10,000 per node, comes for Rs 2,30,000

2233--nnooddee  PPrreerrnnaa

DDuuaall--GG55  AAppppllee  XXsseerrvvee 99..00  GGiiggaaffllooppss

66..00  GGiiggaaffllooppss

4488  GGiiggaaffllooppss

DDuuaall--AAMMDD  OOpptteerroonn  sseerrvveerr
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Digital Passion l Gadget Creed

A
s you enter Manan Bhanushali’s
modest apartment in Garodia
Nagar, located in north-central
Mumbai, everything seems pret-
ty ordinary—from the twin-
apartment with teak furniture,
to the old world look of the inte-

riors and the conservative Marwari family talk-
ing in hushed tones. Step inside Manan’s room,
however, and the illusion fades away.

Placed neatly on shelves on a sidewall are a
Sony PlayStation 2, a Microsoft Xbox and the
Nintendo Game Cube—the three most powerful
consoles that any gamer worth his salt would die
for. If that’s not enough, Manan introduces you
to two more gadgets—the Game Boy Advance SP,
and a Nokia N-Gage QD, a newer, slicker version
of the N-Gage. “The QD lets you play arcade and
console games, and also online multiplayer
games using Bluetooth,” he says. 

But these are just the starters. He opens a cup-
board, and steps away so you can peep into his
gargantuan collection—1,700 game titles costing
around Rs 3 lakh, including Xbox, PS2, Game
Cube and N-Gage games. Most purchased from
abroad, courtesy obliging friends and relatives.

He is also a familiar face amongst game dealers
in Mumbai. “Unfortunately, they charge me way
more than the actual store price,”  he says.

His collection covers all the game genres there
are, “except flight simulators!” Gamers will drool
at adventure titles such as Broken Sword, role play-
ing games (RPGs) such as the Final Fantasy series,
strategy games such as the Hero series, action
games such as Quake III, Unreal Tournament 2004,
Doom 3, Max Payne and BloodRayne.

“Piracy is inevitable, especially in India. If offi-
cial versions are not released simultaneously in
India, pirated copies hit the grey market in a day
or two. Gamers do not like to wait,” he says with
a wry smile. “International companies are realis-
ing the need to enter and cater to the Indian mar-
ket. The Nokia N-Gage for example, has a decent
price-point (street price: Rs 9,000) for the Indian
market,” he adds. 

Manan is 23, and has a Diploma in Computer
Technology. In his final year, he was offered a job
with Milestone Interactive Software, India’s lead-
ing distributor and developer of PC and console
games, as a technical support executive. He soon
became a product specialist, which let him write
game reviews, maintain their Web site and test
games. Manan’s plans include developing games
for mobile phones. “I’m reading up on J2ME now.
I want to pursue a career in gaming; I think I was
born to play games! I intend to start a company of
my own, to develop and market games,” he says. 

Manan started gaming at the age of four—
from Space Invaders on an Atari, to EXE files that
masqueraded as games on his old 386 such as id
Software’s Wolfenstein 3D. Manan today owns an
AMD Athlon 2000+ XP, with 512 MB DDR RAM, a
40 GB 7,200 rpm hard disk and an ASUS GeForce
FX 5600 Ultra graphics card. 

He has also travelled to Chennai, Bangalore,
Kolkata, and Delhi to provide tech support to the
gaming community. He even trained the staff at
McDonald’s to use the PS2. 

As Manan begins a session of Resident Evil, the
room quakes with the powerful sound effects
and the near-real graphics. “Pay attention to the
details,” he says, as he points to the way the
leaves of a plant sway with the wind, on screen.
“I'd give Resident Evil and Metroid Prime 10-on-10 for
detailed graphics.” 

Given a choice, Manan would prefer to ‘Enter
the Matrix’. Reality can wait a while!  

meera_vankipuram@thinkdigit.com

With 1,700 gaming titles across all platforms, 23-year-old Manan Bhanushali is a first among
equals. This is a glimpse of the man who has spent Rs 3 lakh on buying original games

The Game’s On

I want to pursue a career in
gaming. I think I was born 

to play games.

GameCube
Metroid (Rs 3,000)
Super Mario Sunshine
(Rs 2,500)

Game Boy Advance 
Spiderman Mysterious
Menance (Rs 1,900) 
Golden Sun (Rs 1,200)  

Play Station 2 
Final Fantasy X
(Rs 2,999) 

XBox 
Ninja Garden (Rs 3,000)
Halo (Rs 3, 500)

PC games  
Black and White
(Rs 1,999) 
Metal Gear Solid
(Rs 1,500)
Unreal tournament
2004 – Special DVD 
edition (Rs 2,000) 
Baldur’s Gate, complete
pack (Rs 4,000)

Manan’s Picks

Gameboy: Manan Bhanushali can go on, and on, and on... 

Photograph M
exy Xavier

Meera Vankipuram
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Badri Narayan

Back in 1995, we first heard the name
DOOM. The game actually had ‘VGA’ graph-
ics—the word VGA inspired awe, and was

spoken in a hushed tone back then. Most PCs
were too ‘underpowered’ to play this game, so a
few of us dashed over to a friend’s place—he had
just bought a ‘fast’ 486-SX, running at all of 40
MHz. As he fired up the game, our jaws dropped
in amazement. 

More colours than you could count, finely
detailed graphics, a bob effect that simulated
walking, superb weapon models, the list was
endless. Then there was the environment
itself—the mountains of Mars could only be
described as achingly beautiful. 

In short, it was a revolution—a whole bunch
of never-seen-before features packed into a sin-
gle game. It was the sole reason for thousands
of people to upgrade our systems.

Gaming has come a long way since then, but
no other title has managed to evoke the same
reactions as DOOM. 

With its latest game, id has finally dumped
the old-school run-and-gun gameplay that it
fathered, in favour of a more personal interac-
tion with your deepest fears. A classic survival-
horror shooter, it tells the tale of how all hell
breaks loose (literally!) within minutes of you
arriving at a Martian military base. 

The game feels like living in a movie—steam
pipes hiss, metal creaks, and monsters lunge
out at exactly preordained points. FPS evolution
has taken two distinct paths: the classic shooter
with waves of monsters coming at you from
everywhere, and the game with “cinematic
quality” graphics and surround sound.

Another significant change is the better AI—
zombies with guns will use available cover to
pop out and take pot-shots at you. They are
still not up to the level of Half-Life’s marines,
though. For one, they are predictable, and
they have not given up their kamikaze rush. 

But where would a horror game be with-
out its dark corners and flickering lights?
DOOM 3’s graphics aren’t eye-popping, for the
simple reason that there are very few machines

around that can actually run the
game at ultra-high resolutions.

Yes, when id lists the minimum
requirements for the game,
it’s lying through its teeth.

Nonetheless, you can get
an idea of what to expect
when you see effects such
as shadows being cast 
in real-time. Expect to 

see some remarkable

39

results a few years from now, when other
developers bring out their games based on the
DOOM 3 engine, and the hardware to actually
run them has become more common. Is DOOM
3 worth the upgrade, like DOOM was back in
1995? We don’t think so! It’s good, but not
that good.

The game will genuinely scare you at
times. It’s a classic entertainer. It’s a trendset-
ter. But it’s certainly not revolutionary. Far Cry
brought with it the great outdoors, DOOM 3
brings in amazing lighting and graphical
effects, and Half-Life 2 is expected to provide
realistic physics and tough AI. The tools for
making the next wave in gaming are all here.
Now it remains to be seen how they will be
put to use. 

badri_narayan@thinkdigit.com

DOOMed
To Succeed
Be afraid, be
very, very
afraid
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Bhaskar Banik

ver since it was launched commercially
in 1997, the US market alone has sold
more than 85 lakh DVD players, and 1.2

crore DVDs. The Indian market is no different.
The DVD player market is one of the fastest grow-
ing in India today.

With good reason, too. A recent survey by
IDC, the world’s premier IT research agency,
predicted that only five per cent of all PCs
shipped by end-2005 will have CD-ROMs. The rest
will have DVD-ROMs, or DVD combo drives or
DVD and DVD writer combinations. DVD-Writers
that let you back up data and copy movie DVDs
are also gaining popularity amongst both DVD-
movie enthusiasts, as well as, the average
computer user. 

Why DVD?
A typical SoHo-content creation business needs
to back up images, audio, video and documents
of projects—something that might run into
several gigabytes. A CD, therefore, becomes
unviable. You would require more of them, and
also more space to store—let alone cataloguing
them carefully.

The options are a bigger hard disk, a DVD-
writer, or a tape drive. Investing in a new hard
drive is not a portable solution. DAT, or Digital
Audio Tape drives offer you 120 GB and above, but
costs are a deterrent.

This is where the DVD-writer steps in.
Commonly available DVD media, which offer 4.5
GB of disk space, cost around Rs 160, while a
DVD-writer would cost Rs 7,000 and upwards. 

The DVD, therefore, with six times the stor-
age space of a CD, offers itself as an affordable
alternative. Yes, it does take time to write a
DVD, but it is far better than juggling around
seven CDs. 

Does this mean that it is good-bye 
to CD-burning? Definitely not, since all 
new-generation DVD-Writers burn CDs as 
well. However, before you get yourself a DVD-
Writer, there are some factors that you need 
to consider.

The Format Wars
Buying the right DVD-Writer
would need some research. Here
are some DVD media formats
available: DVD-R and DVD-RW 
Pioneer developed and released

the DVD-R and DVD-RW formats in
1997. However, Pioneer was the only

manufacturer at that time with such a
product, and it did face compatibility issues. 

The DVD-R format is split into DVD-R (A)
‘Authoring’ and DVD-R (G) ‘General’ formats.
They differ in terms of the laser used to write on
them. The DVD-R (G) writes with a cheaper 650-
nm (nanometre) laser, whereas DVD-R (A),
intended for professional development, uses a
635-nm laser. The problem is that these formats
are not compatible with each other. 

DVD-R (A) drives cannot record on DVD-R (G)
disks, and vice-versa. Their capacities also vary.
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It is one of India’s fastest growing tech segments. For
many, however, the DVD is still a conundrum of

formats. Here’s demystifying the 4.5 GB storage 
behemoth—the DVD

Space:
The Final
Frontier

Space:
The Final
Frontier



DVD-R (A) disks offer 3.95 GB of space, while
DVD-R (G) disks provide 4.7 GB.

DVD-RAM
It’s a fast-disappearing DVD format, ushered in
just after the DVD-R made its appearance.  These
disks are still preferred by those who munch
video for a living. The reason was that it was the
only format that allowed direct data manipula-
tion on the disk in real-time, without having to
rewrite the whole disk. Initially, these disks
came with a storage capacity of 2.8 GB, which
later increased to 4.7 GB. 

The DVD+R and DVD+RW formats
The DVD+R and DVD+RW alliance was formed
by Dell, Hewlett-Packard Company, MCC/Verba-
tim, Philips Electronics, Ricoh Company Ltd,
Sony Corporation, Thomson Multimedia and
Yamaha Corporation. These companies formed
their own consortium and came up with these
two formats.

They are relatively new. Worldwide, they
were made available only in late 2001. The
DVD+R made its appearance only in mid-2002.

Advantages and Disadvantages
Unlike other formats, DVD-RAM media are disks
housed in cartridges, which DVD-ROM drives
cannot read. A later version allowed the disk to
be removed from the cartridge, but DVD-ROM
drives still failed to read them. 

DVD-Rs and DVD-RWs are incompatible with
DVD+R and DVD+RW media. You cannot write to
either of these disks using interchangeable
writer drives. Hence, drive manufacturers came
up with dual-format DVD drives that can actu-
ally write to all of them.

DVD-R media are written at a lower speed
than that used for DVD+R media. Both have a
theoretical limit of 16X, and a few DVD-writer
drives write at 12X. The DVD-R format is yet to
do so. The higher the media speed, the faster
your job gets done, provided the drive writes at
that speed. Another aspect is the finalisation

property. Say, you want to write a video-DVD
comprising different clips. In the case of a
DVD-RW, you need to finalise the DVD. It
means, simply mark the lead-in and lead-out
before you play it on a standalone DVD player.
A DVD+RW though can play on a DVD player
without finalisation. This feature is known as
the DVD+RW VR (Video Recording). Hence, you
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DVD Regions

2

3

4

5

6

7

8

USA, Canada

Europe, including France, 
Greece, Turkey, Egypt, Arabia,
Japan and South Africa

Korea, Thailand, Vietnam, Borneo 
and Indonesia

Australia and New Zealand,
Mexico, the Caribbean, 
and South America

India, Africa, Russia and former 
USSR countries

People’s Republic of China

Unused

Airlines/Cruise Ships

1

Canada

USA

Mexico

The Caribbean

Russia

Japan

India

South East Asia

Africa

Middle East

South Africa

Europe

China
Korea

Australia

New Zealand

South America
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can add episodes of your favourite TV serial to
a DVD+RW, and play it instantly on a DVD
player. However, DVD-RWs needs finalisation
before playing.

Another factor is the Mount Rainier support,
the de facto standard with all future releases of
Windows. It lets you write directly to a DVD+RW
sans any special software. Not so with the DVD-Rs
and DVD-RWs since this was not specified in
their format.

Compatibility
DVD-R, DVD-RW, DVD+R and DVD+RW media are
compatible with 85 per cent of the available
standalone DVD players. As for DVD-RAM disks,
they were not designed for, and are not compat-
ible with, any of the available DVD players. Only
specialised drives, such as, the Iomega Super-
Drive read them.

The Dual-layer Format
All available DVD media are limited to single-
layered, single-sided mode (DVD-5) and hold up
to 4.7 GB of data. Some manufacturers sell dual-

sided, single-layered media (DVD-10), but these
are a fast disappearing specie since the same
amount of data fits onto single-sided, dual-
layered DVD-9 disks. This also provides less clut-
ter since you are effectively stuffing two disks
worth of data on a single disk. 

Philips and Mitsubishi Kagaku Media devel-
oped the first DVD+R and DVD+RW dual-layered
media, meant for general users. Not to be left
behind, Pioneer released a dual-layer format of
the DVD-R. 

Worldwide, dual-layered media is scarce and
was not available in India at the time of going
to press. Also, as of now, only dual-layered
DVD+Rs and DVD+RWs are available. For the
purists who would rather opt for a dual-format,
dual-layered DVD-Writer, there still may be some
time to go before they actually get hold of one.

Two media layers are separated from each
other on one single side of the disk. While writ-
ing, the first layer is written with the same
speed as that used on a single-layered disk. As
the laser switches to the second layer, the speed
decreases and the data is written at a much
slower speed. 

For example, the DVD-Writer may slow
down from 4X to 2.4X. The point at which
this switch occurs is a known issue for the
current crops of DVD-ROM drives available in
the market. 

When we conducted DVD-ROM drive tests,
the older Creative 12X PC DVD drives did not
recognise the dual-layered disk sample, though
it did read single-layered disks. The new
Samsung SD-616F 16X DVD-ROM drive read the
dual-layered disk without any problems and so
did the Lite-On LDW-811S and 812S and the
LDW-401 DVD+RW drive. Hence, be warned
that compatibility can be an issue with older
DVD-ROM drives.

Buying Guide

Portability
External as well as internal DVD-writer drives
are available. If your job involves taking 
backups from PCs scattered across different
locations, an external drive would be ideal. All
you need to do is connect it to the PC, and
backups can be done instantly. While opting
for an external drive, make sure that it
supports both USB 2.0 and Firewire for high-
speed data transfers.
Speed
A 4X dual-format DVD-writer costs less than an
8X dual-format DVD-writer. The latest DVD-writ-
ers have speeds of around 12X. Writing 4.7 GB of
data at a speed of 4X takes about 15 minutes,

DVD+R: A Cross-section View
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1980
Philips and Sony agree upon
the standard for the Compact
Disk (CD).

1994 September 
Sony/Philips announce the
High-Density CD (HDCD)—the
grandfather of dual-layered
DVDs such as DVD-9 and
DVD-18. 

1995 December
The final DVD format is offi-
cially announced. Initially,
the word was not an
acronym. It later came to
mean Digital Video Disk and
Digital Versatile Disk. 

1996 November
The first DVD players are
released for sale in Japan. 

1997 March
DVD players are available to
US consumers.
Also in 1997, first General
DVD Forum Meeting held in
Tokyo, Japan.

1998
DVD launched in Europe.

2000 July
DVD audio players launched
in the USA.

2000 November
First DVD-audio disks in the
USA.

2001
DVD-video recorders
launched in Europe.

2002
DVDs officially make their
appearance in India.

Timeline

Polycarbonate
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Dye recording
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while the same written at 8X takes around nine
minutes—a difference of six minutes per DVD. If
you get a lot of backups done, you may want to
opt for a faster DVD-writer.

Format
Rewritable disks need to be formatted before
they are used. DVD-RW disks do not support
background formatting whereas DVD+RW
disks do.

Therefore, opt for a DVD+RW disk when
writing data on to a rewritable disk. Also,
choose a dual-format DVD-writer, as it lets
you write to any type of media, even if it 
costs more. 

On the other hand, if you also want to write
to DVD-RAMs, opt for a superdrive that lets you
write to media of any format. At present, only
Iomega manufactures superdrives.

Three Little DVDs Went to the Market
At Lamington Road, Mumbai’s hardware
heaven, Mitsubishi DVD+Rs were available for
Rs 210 each, while a Pioneer DVD-Rs cost Rs
180. On the other hand, Imation and Moser-
Baer offer both types of media for Rs 130 each,
while Sony prices it at Rs 150. 

Princo was the surprise. While a single
DVD-R retails for Rs 38, a spindle of 10 costs a
reasonable Rs 320. We did not find any dual-lay-
ered media.

Rewritable media were priced steeply:
Mitsubishi’s DVD+RWs retail at Rs 400 each and
those from TDK Rs 375. As for DVD-RWs, we
could just find some manufactured by Pioneer
retailing at Rs 375. 

Cheap variants of both formats are available
for anything between from Rs 31 to Rs 110. 

bhaskar_banik@thinkdigit.com

With DVD capturing everyone’s fancy (even ‘Digit’ now offers a free
DVD with its every issue), the amount of storage space it provides

may seem more than enough. Eventually, even this space will fall short.
Here’s an example. HDTV broadcasts are already available for prime-
time shows in the US and Japan. HDTV offers crystal clear picture
quality, but takes up more space as compared to the DVD format.
Hence, recording HDTV shows will need more space than a single DVD.
This is where the new formats step in.
Blu-Ray
Blu-Ray technology was founded by a consortium of Hitachi, LG,
Matsushita, Pioneer, Philips, Samsung, Sharp, Sony, and Thomson,
with Mitsubishi joining them in 2003. Dell and HP recently announced
their support for this standard. Sony’s PlayStation 3 console will
also support Blu-Ray disks. These disks offer a storage capacity of
27 GB per layer, and use a 405 nm blue laser to write data. Blu-Ray
recorders have already started shipping in Japan. And yes, they are
really expensive. 
HD-DVD
Developed by Toshiba and NEC, an HD-DVD disk is similar to the
current DVD, and stores 15 GB of data per layer per side. This
technology also uses the same 405 nm blue laser to write data. Its
biggest plus lies in its ability to use existing production lines for
manufacturing processes. Toshiba and NEC have already announced
plans to launch HD-DVD recorders next year. Microsoft too has
announced native support for HD-DVDs in Windows Longhorn, which is
slated for a 2006 release.

Future Formats

Choose a dual-
format DVD-
Writer. It may
cost you more,
but it lets you
write to any type
of media 1 COL AD
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Ram Mohan Rao

t is a truism that every device is
interconnected. They all recognise one
another, they all understand each other.

Unfortunately, they all put each other at risk.
Welcome to the future!

Soon, viruses on your PCs will be passé,
Spyware will be antiquated, and you will actu-
ally wish the ‘good old days’ were back. Of the
several tech threats that lurk around the cor-
ner, these are the ones that stand high on the
maximum disaster index.

Smartphones
Picture this: You are at your office, equipped
with a newly configured WLAN (Wireless Local
Area Network), and you receive an e-mail on
your smartphone. Business as usual, right? It
turns out the e-mail has a virus attachment.
The attachment has a virus payload that reads
and sends malicious e-mail and spam MMSes to
all the contacts in your address book. The same,
multi-faceted virus also propagates over any
wireless network you are connected to at that
moment. Your WLAN is now infected.

You don’t realise you have a virus, and
promptly sync your handheld with your PC as
soon as you reach home. Once on the PC, the
virus takes on a sinister role—part of the virus
attaches itself to all digital devices connected to
the PC, propagating via memory cards,
synchronisations and the like. One part directly

attacks the host computer. One part uses your
PC to spam; another launches a DoS attack. 

It’s strange that it hasn’t happened already.
The only well-documented viruses for wireless
devices thus far are proof-of-concept ones—and
now, as of August, we also have WinCE.Brador.a
for Pocket PCs (See box “I Have Seen The Future,
And I Am Scared”).

Smartphone users routinely download
ringtones and Java games. However, when it
comes to anti-virus software, firewalls or spam
filters for these devices, there aren’t many, as of
yet. This lack of software development should
change with the rising popularity of mobile
devices. Unfortunately, so will virus
development. Thus far, virus developers have
ignored such devices only because of the small
numbers they can affect. 

Tomorrow, however, there will be millions
of smart phone users, and each user will have
hundreds of contacts, with each contact just an
e-mail, SMS or MMS away. Attack one phone,
and you cause a domino effect that will sweep
across the globe in a few hours. We switch off
our computers, we barricade ourselves with
firewalls and anti-virus software, but we rarely
ever turn off our cell phones, or bother to think
twice when we receive an SMS or an MMS. So
how do we prevent this?

Take the Cabir virus, for example. It was sent
to security firms for analysis; it wasn’t released
“into the wild”. But as security firm F-Secure
noted, the next attack might not be so civilised.

In 2003, the New York Times reported that the

Chinks In The Wireless Armour

The Future
Tread Softly

into

The year is 2015. Technology has
taken over the world. It’s not the
Terminator story yet, but we are
almost there...

I

There is concern over
the use of Bluetooth-
enabled devices in
corporates: several
executives are paranoid
about the security
breaches in corporate
LANs that these devices
can perpetuate. There is
also concern about
‘Bluesnarfing’ and
‘Bluejacking’

Smartphones are increasingly 
seen as potential backdoor 
entries into a WLAN. A smart-
phone virus could easily spread
within minutes over a WLAN 

Anyone with the right equipment
can get into a WiMax network, just
by walking into range. There is no
limit on what a talented hacker
could do once he is indise the
network—steal data, start DoS
attacks, and more
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virus threat to cell phone networks was
“probably” five times larger than that to PCs,
because of how few people are focused on the
problem. The article quoted incidents in Japan,
when DoCoMo customers “were being sent
messages that froze their screens and
automatically dialled 110—the hotline to the
police in Japan.” If they could dial the police,
they could just dial other numbers as well, at
random, racking up a huge phone bill? 

As smartphones replace laptops, the
problem will intensify. Right now, infection
may mean just be the loss of your contacts and
a few notes; later, it could crash your PC.

Wireless Networks
The issue is that people are at risk without
knowing it. It’s a time bomb. In a wide-range
WiMax wireless network, where people typically
sit at a large distances from access points, they
may be at risk even when they are not connected
to the Internet—the network is there for anyone
to exploit. There’s a spectrum of threats: PANs—
typically Bluetooth-connected areas; WLANs;
and WANs—WiMax networks. Few people are
aware of the risks of insecure networks.

Smartphones, as also other Bluetooth-
enabled devices, could be used as a backdoor into
corporate networks: when an infected phone is
synchronised with a terminal, the entire office
network could get infected.

According to research agency Gartner, WLAN
attacks will be the biggest wireless-related
security issues through to 2008. The current
insecurity of WLANs is well known and well
documented—not too many administrators take
the trouble of securing them; several
independent researchers have gone to the 40th

floor, and easily accessed a WLAN on the 38th

floor, as benign experiments.
Wireless Internet Magazine warned in 2001 of

“economic information warfare, involving
sophisticated attacks against entire economies,
commerce and enterprises”; and “next-
generation computer viruses that will self-
mutate and are designed to destabilize, confuse
and destroy critical electronic infrastructure
essential to industry and government.”
These are plausible scenarios, and WLAN
security, or the lack of it, will hurt us. 

VoIP
Anything that’s smart can be subverted. You
are soon going to have smart VoIP—
something that will trickle down into every
device. This is a perfect recipe for disaster.

It is envisaged
that much of the role
the existing telephone
system plays will be
replaced by VoIP
networks. Imagine your
home phone line replaced
with a fixed VoIP line, operated
by your broadband provider. Data
and voice will be on the same
cable. Your PC will, naturally, be
connected to this cable. What happens if
your computer gets infected? It will suck up all
the bandwidth, and you can’t even place a call to
customer service! And if the attack happens at
the service provider’s end? You will  end up with
no phone, no Internet service, nothing.

The problem is that VoIP networks happen to
be especially easy to crack. It’s hard to secure a
simple protocol like http, so what are the
chances of securing the whole range of protocols
used in VoIP, and written by different groups?
That’s what VoIP is—three complex protocols,
each of them not a single protocol, but a
protocol family in its own right.

Consider Asterix, a PBX software for Linux.
PBX is short for Private Branch eXchange, and is
a small, private telephone exchange. With just a
configurable tool such as Asterix in a hacker’s
hands—not to mention various, other
underground tools—imagine the damage that
could be inflicted on a VoIP network.

VoIP, where you can send any return number
you want, takes phishing to a new level.
(Phishing is the sending of spam that makes you
believe you’re receiving it from a legitimate
source, and which asks you to disclose personal
financial details such as your bank account
number.) You could be phished by a person with
a PDA and a headset sitting outside your home.

Cable modems run real-time OSes; they can
be hacked and reprogrammed. Eventually, VoIP
phones will make use of a cable-modem type
device. With such a device sitting in your home,
it will definitely get exciting for hackers.

At some stage, you could imagine your ‘VoIP
line’ connected to your desktop, laptop, TV,
entertainment system, and more. Someone
could send you a pre-recorded message over the
channel, and cause your phone to crash. And
every device that’s connected to the channel is
suddenly under threat. 

Consider the convergence of devices in the
home that’s happening. You are soon going to
have a single device that acts as entertainment
centre, VCR, TV, PC, and more. This device is
connected to a broadband cable, and suddenly, is
open to hacking.

Convergence also means Bluetooth-enabled
refrigerators, washing machines, microwave
ovens. All connected via the cable, all vulnerable,

and all putting the others at risk. Soon, the
term ‘virus’ will take on a new meaning, not

limited to ‘computers’: any device with a
microchip and software will be at risk.

As we take small, hesitant steps into
the future, let us hope we can be smart
enough to prevent rather than cure. 

ram_mohan@thinkdigit.com

I Have Seen The Future, And I Am Scared

Although the threat was characterised as relatively low, anti-virus com-
panies said on August 2, 2004, that a Trojan program for Pocket PCs
has emerged. The program, known as Backdoor.Brador.A or

WinCE.Brador.a, lets an attacker gain full control of the infected handheld
device. Brador is the first ‘backdoor Trojan’ program that has emerged for
Pocket PCs, thus far. Such programs cannot self propagate, and have to be
sent as e-mail attachments. Symantec said Brador seems to be limited to
devices that use ARM processors and Pocket PC operating systems. 

Eugene Kaspersky, head of anti-virus research at Kaspersky Labs, said in
a statement, “We can be sure that the computer underground will snatch at
the chance to attack PDAs and mobile phones in the nearest future.”

We can be sure
that the computer
underground will
snatch at the
chance to attack
PDAs and mobile
phones in the
nearest future.
Eugene Kaspersky
Head of Anti-virus
Research
Kaspersky Labs
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rmed with easel and
paintbrush, canvas and
oil paint, a Web site, a

CD-ROM, an Apple G4, a 22-inch
LCD Cinema Display, and more
than a fair share of common
sense, Jaideep Mehrotra is
quietly conquering new worlds.

Mehrotra on the art scene is
just like the view from his
elegantly comfortable home on
the Mumbai seafront—calm,

serene, and almost noiseless.
Which is why, although he is one
of India’s most accomplished
painters and sculptors, his name
is hardly taken in the same
breath as his other media-
savvy colleagues. It is a
pity, really, because
Mehrotra’s work

is as important as any other
contemporary major artist.

He is also a pioneer—he was
the first artist in India to set up
his own Web site, and later, the
first to create and market a CD-
ROM of his work.

It is not an exercise in vanity;
in fact, it is a productivity tool
few can afford to miss.

It has been a long time since
Mehrotra set up his Web site, and
began marketing his CD-ROM.
Three years, in fact. And his tech-

nology training has taken the
same route as his art education—
everything he does is self-taught.
Whether it is creating art instal-
lations, wood art or even fabric
art, Mehrotra has never had any
formal training.

First Among Equals
It was not a Eureka moment that
brought about the idea of a CD to
showcase his art, and expand his
audience manifold. Mehrotra has
been drawn towards technology

for quite some time now—he was
VSNL’s 35th customer for an
Internet account at a time when
it cost in excess of Rs 10,000 for a
100-hour registration. Prior to
that, he was also part of the
LiveWire Bulletin Board Service
run by the Nanda brothers—
Suchit and Anish—India’s
pioneering digital entrepreneurs,
whose foray into BBS was viewed
with much scepticism in 1992.

It would take three days for
a message to reach the US,

and another three
for a reply if it was

posted. “It was
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Jaideep Mehrotra is India’s first artist
to use a CD-ROM and the Web
effectively to promote his work. Here’s
how he has harnessed technology to
take his art across the globe
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would make his work accessible
to a larger section of art connois-
seurs and peers, both Indian and
from across the world.

The CD itself is a digital jour-
ney into the artist’s life. Divided
into sections that detail his life,
his work is in the form of paint-
ings and lithographs. 

It even includes his poster
design for the Dev Benegal film
Split Wide Open. It then records
his views in the form of newspa-
per and television interviews. 

“It has my work from 1984
onwards. Each of the paintings
includes a description of the
work along with the attached
price, if it is still available for
sale. You can find my sculptures
and other art work too.”

Interestingly, Mehrotra
authored the CD on his own for
both Windows and Apple plat-
forms compatibility.

Veteran actor and one of the
early adopters of the Web in
India, Shammi Kapoor, launched
the CD in 2001, and Mehrotra has
since sold over 300 CDs, a unique
achievement for something that
is as niche as an art CD-ROM.
Mehrotra later sold through mid-
day.com (the Web site of a popular
evening newspaper in Mumbai) to
sell the CD, a move that resulted
in a lot of enquiries from the US
about his work.

Why CD-ROM?
Mehrotra feels that a CD-ROM is
important for any individual or
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faster than snail mail, though,”
says Mehrotra.

The Internet, therefore, was
a natural progression. He
created a self-titled Web site, for
which he learned to author
HTML pages. “It was great fun,”
he remembers.

It all began when, in the late
’80s, Mehrotra began experi-
menting with digital litho-
graphs, something he would
develop into a fine art, and a
constant revenue stream. He was
in New York then. 

Later, in the ’90s, he created
exquisite works of art using both
two-and-three-dimensional soft-
ware. Adobe Photoshop and
Fractal Design Painter were his
easels; his Wacom cordless pen
and a digitiser, his brushes. 

And A CD Takes Birth
The CD-ROM would seem a run-of-
the-mill idea, but when Mehrotra
pioneered it in 2001, it was noth-
ing less than revolutionary. 

Even today, no other Indian
artist has developed a CD-ROM.
Mehrotra is quite reticent about
it, though. 

“I have done a lot of diverse
work since 1967. I felt I should
preserve my work in a medium
different than a glossy catalogue.
The CD-ROM idea came primarily
with that objective in mind.”

Mehrotra also wanted it to be
interactive. A CD-ROM would be
the best medium, then, given his
needs. The medium, he hoped,

Online Art Will Be Big... Soon

Experts say technology will only enhance
the art experience. It is only a matter of

time before artists in India begin to
process, catalogue and archive their works
digitally. Art critic Jasmine Shah Varma
believes the Internet has opened a new
vista for Indian artists.

Dinesh Vazirani, co-founder of
Saffronart.com’s India chapter, says the Net
has helped promote art in a big way. “It has
provided an objective platform for artists to
display their works to a global audience.”

He adds that the Net is increasingly
being used by artists to experiment and
usher in new movements in terms of style.

Mehrotra is probably the first Indian
artist who experimented with digital media,
but others are following suit. Says Vazirani:
“Digital art is not a hot trend due to lack of
awareness, and due to the misconception
that digital art can be reproduced a million
times over. This has resulted in a cautious
approach towards this medium.”

Shah Varma, meanwhile, feels that
technology has some way to go before it we
can confidently say that the time for it has
arrived. 

“It is a relatively new field, and only two
other major contemporary artists—Akbar
Padamsee and Gulammohammed Shaikh—
have experimented with this medium,” she
says. “The awareness of digital art and use of
technology in art among art buyers is
practically non-existent, and art buyers are
more comfortable with traditional media like
oil and watercolour. 

“It is hard to say whether the market for
digital art will thrive in India in the current
scenario.”

But she is also certain that technology
is making inroads into the field of artistic
creation. “Many artists have been using
video and computers as media to make and
display art. Gradually, we will see greater
use of technology, but it is hard to predict
how soon and to what extent.”

The 
CD-ROM is
an impor-
tant step in
making
people
aware of
my work...
I am happy
that
several
artists are
now going
digital.

Jaideep
Mehrotra
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small company as an effective marketing tool. “A CD should
be created from the long term business point of view. Unlike
music or films, the success of a CD cannot be just determined
by sales alone; people buy the CD and may even take years to
buy my work; this is just a step towards making my work
known to people.”

The initial reaction to Mehrotra’s CD was that of fasci-
nation, since nothing of this sort existed in the art world
before. “But now I see a change,” he says, “Several
colleagues of mine are now going digital.” There is a sense
of accomplishment in his eyes when he says this, even 
if some of the purists have not accepted this form of build-
ing awareness.

Technology And Art: Do The Twain Meet?
Mehrotra defends digital art not with the irrational fanati-
cism of a blind supporter, but with the reasoned rationale of
a seasoned parliamentarian: “Digital art is equally creative.
There is a misconception that digital art is dependent only
on the computer’s capabilities. This is simply not true. Unless
you give the necessary commands to the machine, and incor-
porate your ideas, how in the world is the computer going to
create art? 

“Technology has ensured that art sites have mushroomed;
one is now able to look at pieces of work that were not acces-
sible earlier. It has brought art to the common man. Earlier,
making a film was considered a multi-layered process; today
one can shoot on a personal video camera, and edit pictures
at home on a personal computer.”

Even as art dealers and artists try to get comfortable
about the use of technology, Mehrotra has only shown the
way. He says the day is not far when the world’s first digital
painting with a digital signature of a prominent artist would
go on sale for half a million dollars. “This will make people
notice digital art,” he believes.

Meanwhile, at Crossword, a nationwide chain of book-
stores, Mehrotra’s CD sells as the sole representative of a CD-
ROM on art. For now, he can be happy that he still remains
the only Indian artist to have dabbled in this medium. It
won’t be long before he has followers. 

aparna_krishnakumar@thinkdigit.com
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Ram Mohan Rao

t’s been said all too often
now—the paperless office
is a dream, and it’s become

more of a dream since the advent
of the very things that  promised
it. The demand for printers and
printouts is only going up, with
offices getting increasingly
swamped in tonnes of paper. Add
to that stockpiles of newspaper
clippings, handwritten notes,
books, the works. Hapless employ-
ees are then left swimming in a sea
of paperwork. Metaphorically, at
least. What can be a remedy to the
paper mess? Is it really possible to
have clutter-free workplaces?

First things first, though. It is
not possible to have a totally
paperless office, and this is some-
thing we have to accept. Besides,
humans are more adept at
reading paper than digital docu-
ments. Having said that, the
advantages of less paper in the
office are several. Besides, seam-
less integration of paper and dig-
ital documents is indeed possible.

Here’s how you can benefit
with less paper:

in-built document organisation
software.

There are three fundamental oper-
ations you would need to do:

OCR (OCR stands for Optical
Character Recognition which
involves scanning your pages, and
storing them in text format instead
of as images) your documents

Organise and archive your data
once it’s done

I

Swamped by paper in
your office? Digitising
your documents could be
your way out of the
clutter

Paper vs Paperless

Imagine a thousand sheets of paper of different
kinds in your office. A rough calculation would

indicate that each page is 2 KB of text with
formatting. If, say, every page has a 100 KB image,
these would amount to 1,00,000 KB or 100 MB of
images. The text comes to approximately 2 MB. So,
100 MB of disk space would store the thousand
sheets. Extrapolate this, and you would get on a 10
GB hard disk (Price: Rs 2,000), 1 lakh sheets of paper. 

Normally, you would spend money on the car-
tridge ink, the real estate to store the documents,
printer maintenance, the cost of the paper, and so
on. 

Digital, therefore, is the way to go. It requires
only a small mindset change to go digital. Next time
you need something; don’t simply shoot off a printout.
Instead, get a PDF, or use e-mail.
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Towards the 
Paperless Office
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Freedom from clutter
Better, more effective organisa-

tion of information
Cost-effectiveness, because

going paperless means you cut
down on physical storage space

Better archival, and therefore,
easier retrieval

Easier communication when a
piece of information is required to
be sent

Greater efficiency in the office

The questions now would be:
Would it involve huge labour

cost to digitise manually?
How does one rely on hard

disks to keep information secure?
How does one organise com-

piled information?
Here’s the good news: there are

answers for these questions. 
Hard disk reliability is not

really an issue. With hard disk costs
coming down by the day, taking
multiple backups is a viable option.
You can use backup-scheduling
software like WinBackup and
Second Copy to further protect
your data. Also, manually digi-
tising documents isn’t as difficult
as it used to be, with automatic
document feeders, combined with



5590 a boon for office users. It is
ideal for those looking for better
control of management of docu-
ments for digitising, indexing,
storing and retrieval purposes. 

Says Manu Sharma, Country
Category Manager, Digital
Imaging Products, HP: “The HP
Scanjet 5590 will serve as an inte-
gral requirement for organisations
where document flow is high,
such as financial services, logistics
and large distribution companies
with dealer networks, etc.”

Xerox takes this concept of
paperless office a step further.
FlowPort, Xerox’s image routing
software, lets you move smoothly
between hard copy and digital
information. You can capture,
store, access and retrieve just
about any kind of document.

The idea is, when people actu-
ally have immediate access to the
documents they need, instead of
saying, “I’ll courier you a copy
when I find it,” they can say, “I
have it right here on my screen.” 

FlowPort turns hard copy doc-
uments, even complex ones, into
high-quality digital documents. It
then routes it to e-mail, document
repositories, or other applica-
tions, where it can be easily
accessed and shared.

It even does the reverse: It iden-
tifies and retrieves specific digital
documents and routes them for

faxing, e-mailing or
printing to a spe-
cific output device.
Ergo, work is now
easier and cheaper.

FlowPort’s user
interface is a 
piece of intelligent
paper—a Paper
Ware Cover Sheet
that puts docu-
ments exactly
where you want
them, with the
simplicity of a
checkbox and a
green button. You

can route documents anywhere
on your network by marking
checkboxes on the PaperWare
Cover Sheets. Essentially, you
need to put a Cover Sheet with the
document. Then scan it to Flow-
Port on a network scanner or a
traditional fax machine.

All you have to do now is
push the button. FlowPort inter-
prets the Cover Sheet and routes
the documents accordingly. For
example, a Cover Sheet contains
checkboxes for several cate-
gories. E-mail the document to a
specified team,  send the docu-
ment to a specified printer in a
particular department, or send
the document to a Xerox
DocuShare collection, in a speci-
fied category.

Once this is done, they are
instantly available—minus the
costs of a crowd of people man-
aging them, transportation delays
and delivery fees. FlowPort even
tells you, when your files arrive,
where you want them, with
printed or e-mailed confirmation
reports.

Once all that paper is off your
desk and out of your file cabinets,
you can use PaperWare Document
Tokens and Document Catalogues.
They give you FlowPort-specific

retrieval instructions to find and
print files from any FlowPort sup-
ported repository.

A Final Word
Think paperless. Documents
belong in the PC, not on paper!

More advanced solutions such
as Xerox’s DocuMate series are not
available in India yet, but should
be, soon.

Archiving and organising are a
smooth process if your documents
are digital. 

Seeking a completely paperless
office is unrealistic, but you can
definitely go quite a good way
towards clearing the clutter. 

And becoming greener. 
ram_mohan@thinkdigit.com

Record what’s on paper and
what’s digital. Create a system to
manage such records, so that you
can keep track of what is where,
and whether it’s digital or not.

The Tools that Digitise
There is no dearth of tools that
help build a paperless, or less
cluttered office. Consider stand-
alone OCR software, which you
can use in conjunction with 
the scanners your organisation
already has.

The best OCR software we
have tested is ABBYY FineReader.
It can digitise any type of docu-
ment, however complex. Charts
and pictures aren’t any problem
with the FineReader. Just scan,
OCR and archive—the OCR
process is as simple as this. 

When it comes to scanning,
however, you will need some-
thing that supports automatic
feeding of documents. Scanning
thousands of sheets manually is
both impractical and unfeasible. 

Contemporary scanners have
in-built OCR software helping
you to simply feed in a document
and get a PDF file as output.

Now, here’s where the smart
solutions come in. Consider, for
example, HP’s high-speed Scanjet
5590. The scanner comes with its
unique document-management
software and a 50-page duplex
automatic document feeder. The
machine makes it easy for the
users to manage multiple docu-
ments and paperwork.

At a price tag of Rs 26,990, the
product even features a Trans-
parent Materials Adapter (TMA)
that helps convert negatives and
slides to digital images. 

The scanner comes with in-
built document management
software. The additional capa-
bility of scanning books and 3D
objects makes the HP Scanjet
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Scanjets will
be integral to
infrastructure
in
organisations
where
document
flow is high.
Manu Sharma, 
Country Category
Manager, 
Digital Imaging
Products, 
HP

The Guide to Digitise 50 Documents 
Use a scanner, such as the HP Scanjet 5590.
Connect it to the PC.
Use the Automatic Document Feeder to feed in all 
the documents. You should get a speed of eight 
pages per minute, making for a total of six 
minutes for the scan process.
Set DPI (dots per inch) to 300 for optimal scanning.
Click on ‘Scan Now’.
When scanning is over, click on ‘Recognise’.
In ABBYY FineReader, click ‘Save’ and choose ‘PDF’.
You should get 50 PDF files.
Use the scanner’s document management software
to annotate and archive the PDF files.
Throw all your paper documents into the bin.

Document Organisation and Retrieval

OCR your documents, using either the in-built OCR software or a third-
party OCR software, using the Scanjet 5590.

NewSoft’s Presto! Page Manager saves the results as thumbnails. The
thumbnails will contain relevant information about each document.

Create appropriate directories, for example, ‘June’, or ‘Meetings’, and
save the thumbnails to the appropriate directories.

Later, when you need to retrieve a document, use as many or as few key-
words as you want. The software will automatically find all documents con-
taining the keywords or keyphrases

The FlowPort Cover Sheet shows a
sample of a digitised task list
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It is a Web site we are familiar
with, yet we hardly know how it
works. Baazee, arguably India’s

most accessed e-commerce site, has
hundreds of links that give you thou-
sands of options. And therein lies
the problem—how to create order
out of those options? A few pointers
would help:

Register
You need to register with Baazee to
conduct any transaction. The proce-
dure is simple, and similar to the one
followed by other Web sites.

Search
You can search products in two ways:
Either use the Search field from the

home page, or browse through the
various categories by clicking the
respective links.

Buy
There are five different ways items are
sold on Baazee:
QuickBuy: If you like a product that
is priced within your budget, click
on Buy Now. There is no auction
process in this category; hence
bidding is out of the question. The
buying process is the simplest here.
Auctions: Search for and select an
item. Each item is accompanied 
by a ‘Current Bid Status’, which indi-
cates the highest bid for that product
thus far. 

Often there is a ‘Reserve Price’ for
a product. A seller usually sets a
Reserve Price so that he doesn’t have
to sell at a ridiculously low price if no
one bids on his item. Otherwise, people
might be able to buy a car for Rs 10, or

something equally ridiculous. If the
final bid is below the Reserve Price, the
transaction is considered complete.
Though we have all heard stories about
people buying stuff at dirt cheap
prices, don’t hold your breath, at the
end of the day, the sellers are here to
make money, not lose it.
MaxBid: This new concept by Baazee
involves a little thinking, a bit of luck
and some ‘Baazee Points’, which can
get you that proverbial ‘steal of a deal’. 

Here’s how it works: Buying stuff
in the Quick Buys section earns you
Baazee points. Redeem these to enter
MaxBid. A MaxBid item is sold at a 90
per cent discount on its MRP. So, a Rs
20,000 video camera is sold on MaxBid
for Rs 2,000. Use a few hundred
Baazee Points to bid on such products,
and remember to bid as close to the
MaxBid as possible. All bids are

compared once the maximum bids
limit (as in, the number of bids) is
reached. Two or more biddings of the
same price are discarded, and the
winner is the highest unique bid.
Hence, you can get that video camera
for any price below Rs 2,000—if no
other bidder choses the same bid
amount, or a unique bid that’s higher. 
Secondhand Goods: The Secondhand
Goods store sells anything from
computer memory to laptops, or sofa
sets to houses—all at discounted
prices. However, before you take the
plunge, remember the phrase “Let the
buyer beware”. If you opt for second-
hand, it’s always at your own risk,
since there is no warranty for any of
the goods you buy.
The 99 Store: Another innovative
section for those with slim wallets.
Purchase anything in this store for
Rs 99 or less. T-shirts, VCDs, pendants,
wallets, and more—they are all here.

Pay
The most common form of payment 
is Cash on Delivery (COD), popular
among individuals who are wary of
revealing their credit card number on
the Web, or small businesses operat-
ing on Baazee. Bigger vendors accept
credit cards, demand drafts, cheques
and electronic bank transfers. 

Sell
Baazee is a great place to set up 
your own business online without
investing in expensive real estate.
There are three ways to sell your
goods: Auction, QuickBuy or Classi-
fieds. You can ‘Auction’ absolutely
anything except real estate and serv-
ices. QuickBuy is for anything except
real estate, services and automobiles,
and Classifieds are only for real estate
and services. Depending on what you
are selling, choose between Auction
and QuickBuy. 

Remember that QuickBuy is a
fixed-price sale—so people will either
like or dislike your offer. Auctions, on
the other hand, let people bid on the
item, and you may end up with more
than what you expected. However, you
should know that Indian buyers are
not likely to pay extra. 

After you choose the way you are
going to sell, you have to select a cate-
gory. Choose one that your 
goods fit into, and you will see a verifi-
cation page with relevant details. Click
on Verify Me, and Baazee’s customer
service promises to contact you within
24 hours. Once they complete their
verification process, you are informed
via e-mail, and are then allowed to put
up your item for sale.

Now that eBay.com has bought
Baazee, we can expect more innova-
tive buying and selling options from
the site. Until then, keep searching for
the proverbial ‘steal of a deal.’ 

robert_smith@thinkdigit.com

eBay buys
out Baazee
This past June,
eBay bought
Baazee.com Inc.
and its
subsidiary
Baazee.com
India Pvt Ltd,
for $50 million
(Rs 230 crore).
In turn,
Baazee.com will
use its
relationship
with eBay to
further develop
its business and
strengthen its
position in
India’s e-
commerce
market.

Most vendors accept Cash on Delivery (CoD), allaying Internet fraud fears

The Baazee Home Page shows the three steps to buy

Trading on this auction site is fun, and addictive

Baazee.com
Digital Tools l Sub-section



Retrieving Lost Password
For Content Advisor

Control the Web sites
that users surf using your

PC via Content Advisor in IE.
Specify a password. Forget the
password and you may not be
able to visit certain Web sites at
all. There is a work around
though. Go to Start > Run, and
type ‘regedit’ to bring up the
registry editor. Navigate to the
registry key HKEY_
L O C A L _ M AC H I N E \ S O F T -
WARE\Microsoft\Windows\
CurrentVersion\Policies\Rati
ngs. Delete the key entry in the
right pane and close the reg-
istry editor. Now, start Internet
Explorer, go to Tools > Internet
Options > Content > Content
Advisor and click ‘Disable
Ratings’. Do not enter any pass-
word when asked to do so and
click OK. That’s it! All Content
Advisor Settings eliminated.

Auto-disconnect 
This feature was enabled
by default in IE4; not so

in the latest version. Enabling
it lets you specify the period of
inactivity after which the
Internet connection is discon-
nected. You can also configure
it to prompt you to ascertain
that IE should go offline, when
you close all its instances—a
useful feature for dial-up users. 

Open Internet Explorer, go
to Tools > Internet Options ,
flip to the Connections tab,
click Settings and then click
Advanced. Select the check-
boxes that says ‘Disconnect If
Idle for [X] minutes’ and
‘Disconnect when connection
may no longer be needed’.

Click OK thrice to save
changes.

FTP With Internet Explorer 
Internet Explorer can
emulate an FTP client.

Simply type in addresses in the
following format: ftp://user-
n a m e : p a s s wo r d @ s e r ve r -
name.com. If you are behind a
firewall, or cannot access FTP
folders, try using the Passive
mode. To enable this, go to
Tools > Internet Options,
switch to the Advanced tab and

enable the ‘Use Passive FTP
(for firewall and DSL modem
compatibility)’ checkbox
under Browsing Settings.  

Scroll Through History 
If your mouse has the
scroll wheel, then simply

press the [Shift] button and
scroll up or down to go for-
ward or backward in the
browser history.  

Disable Images, Graphics
Disable all graphics and
images of a Web site to

load the page faster or to save

costs of ink while printing,
Here’s how you do this: make a
plain text file with the line
‘IMG { display: none !impor-
tant;}’ in it and save it as
imagesoff.css. Use Notepad to
do this. Now, in Tools >
Internet Options, press the
‘Accessibility’ button. Use the
‘user style sheet’ option to
specify the .css file you just cre-
ated. Once you press OK, all
your images will vanish, until
you go back to  the Internet
Options dialog and disable the

selected settings.

Zoom In/Out Quickly
To increase the font size
on a Web site using the

scroll wheel of the mouse,
scroll your mouse down, while
pressing the [Ctrl] button.
Scroll up to reduce the font
size.

Get Alerts On Updates
Many IE users hardly
know how to use the

Offline Viewing feature of
Internet Explorer. If you visit a
particular Web site regularly,

you can add it to your list of
favourites, and click on
‘Organize Favourites’. Now,
click on the ‘Make available
offline’ option and select
‘Properties’. You can even set
the rate at which IE checks
whether the page is updated. If
the page does get updated, IE
can alert you by displaying 
a small red icon in the
favourite list, or even by
sending you an e-mail.

Home Sweet Home
Another feature that’s
seldom used, is the

homepage. If you start
browsing your Internet every
time by a specific Web site—an
e-mail site or or your home-
page, for example—you can set
the URL of this Web sites as
your  browser’s homepage. This
will cause IE to start by visiting
that URL first. Set this by going
to Tools > Internet Options
and inserting the URL in the
‘Home page’ field.

Auto-flush Browser Cache
If you wish to clean up
your surfing trackswhen

you are done, but hate to
empty your IE cache manually,
then here is 1a better way out.
Go to Tools > Internet
Options and flip to the
Advanced panel. Scroll down
to Security and check ‘Empty
Temporary Internet Files
folder when browser is
closed’ and click OK, IE will
now automatically delete its
cache when you close the
browser window.

Keep History Trimmed
You can configure
Internet Explorer to
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Internet Explorer

Make a Web site available offline on
the ‘Organize Favourites’ window

Secrets That Keep You Ahead In The Race

You can set Internet Explorer to
disconnect the dialup connection
automatically when you don’t
need it



54 DIGIT SEPTEMBER 2004

Digital Tools l Tips & Tricks

automatically delete the his-
tory of visited Web sites. Go to
Tools > Internet Options. On
the first tab, under ‘History’,
set the number of days for
which the browser should
retain the history. If you enter
five, then all track of Web sites

older than five days gets
purged automatically.

Multiple Sessions
You can start surfing
with the same set of

Web sites by saving them as a
session. 

For example, if you like to
start out with a Web-based e-
mail site along with a couple
of news sites, open them and
click on File > Sessions > Save
session. Save the file with a
.win extension in the default
location. 

You can recall these saved
sessions even while browsing
some other sites; File >
Sessions > Insert Session will
take care of this. Next, press
[Alt] + [P] to bring the

Preferences dialog, head to
File > Preferences > Start and
Exit. Here, check ‘Show start-
up dialog’ to bring up the
startup dialog box every time
you open Opera.

This box allows you to
maintain multiple sessions
and eliminates the frustration
associated with a browser
crash—you can start browsing
at exactly the point where the
crash occurred, a very useful
feature. The default path for
the saved sessions is: 

Windows 2000/XP: C:\
Documentsand Settings\
<login name>\Application

Data\Opera\Opera7\pro-
file\sessions\opera.win

Windows 95/98: C:\
Windows\ApplicationData\O
p e r a \ O p e r a 7 \ s e s i o n s \
opera.win

Tabbed Browsing  
To use Opera’s tabbed
browsing feature, enable

the Page bar by going to View
> Toolbars > Page bar. Call a
new tab either by pressing
[Ctrl] + [N] or double-clicking
on an empty Page Bar area.
Right-clicking a link and
selecting ‘Open in back-
ground page’ opens a tab in
the background—a better fea-
ture, as it lets you browse the
parent page as the link opens
without disturbing you. Note
that the text of the tab
changes colour once it fin-
ishes loading a Web page.
Browse between tabs by using
[Ctrl] + [Tab]. You can also use
the mouse to do this: With the
mouse right-clicked, use the
scroll button to move up and
down the list of tabs. Use
[Ctrl]+[W] to close any active
tab. Close all open tabs using
[Ctrl] + [Shift] + [W]. To close all
tabs, but the one you are
browsing under, press [Ctrl] +
[Alt] + [W]. You can also change
the position of the tabs by
simply dragging and dropping
them wherever you deem
them to be fit. 

Clothes Make the Browser  
The default user inter-
face can be tweaked to

be leaner and much less of a
resource-hogger. Right-click
on the Main Bar, click on
‘Images only’, and then
uncheck ‘Large images’. Right-
click again and choose Left,
then disable the Personal
Toolbar by right-clicking on it
and selecting ‘Off’. Switch off
the Hotlist by pressing [F4]. To

make the interface cleaner
and more user-friendly, you
can perform the following
modifications: go to View >
Status Bar > Bottom, View >

Page Bar > Top, View >
Address Bar > Top, View
Navigation Bar > Auto. You
can drag-and-drop elements
to the toolbars. We will do so
for the Address Bar: right-

click and choose ‘Customize
toolbars’. You will find three
tabs here: Large, Small and
Fields. The last tab is where
you will find search options—
the Zoom and Status fields.
Let us add the Google search
field to the Address Bar. Just
click on it and drag it to the
bar. Note that it is a drop-
down field. An especially
useful search criterion is
‘Find’ in the page search,
which highlights keywords
within the Web page as you
type in the field. 

Add your keywords for easy,
customised searches

You can choose to start any saved
session or last auto-saved session
when you start Opera

Opera is the most customisable
browser around. You can easily
change buttons and the position
of all the toolbars

OperaYour Own Search Keywords
in Internet Explorer 
Opera and Firefox let you use
keywords to search from the
address bar. You can implement
this in Internet Explorer too via
a registry tweak. If that frightens
you, use the Tweak UI utility,
which can be downloaded from
Microsoft’s Web site. 

Visit the search engine site
you want to add a keyword for,
search for something, say a
phrase, and copy the URL. Next,
expand Internet Explorer in the
left pane of Tweak UI and then
click Search. In the right pane,
click Create and paste in the
URL. Now, replace the phrase
you searched for with %s, and
enter a keyword of your choice
in the Prefix box. For example, if
you want to add Google, your
search string will be something
like http://www.google.co.in/
search?q=%s and the keyword
may be g. Click OK twice to
change your settings. The next
time you want to google Digit,
just type in ‘g Digit’ in the
address bar. 

Bet You Didn’t Know
Illustrations: Farzana Cooper
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Magic Wand
Logging on to Web sites is
a much simpler task

thanks to the Wand feature-a
password and forms manager.
Log in to a site and let Opera
save your username and pass-
word. When you next come to
the same site, the login boxes
will be bordered golden. Press
[Ctrl] + [Enter] at the login

screen and Opera fills in the
requisite personal informa-
tion, and automatically log in.
All Wand passwords can be
cleared from ‘Delete private
data’ on the File menu. Your
usernames and passwords are
scrambled by the Wand before
they are saved to disk. However,
for added protection you may
set a master password in
Opera’s Security preferences.
Press [Alt] + [P] and go to the
Security section of the
Preferences dialog box. Click
on ‘Set password’ next to
‘Master password’ for added
security. You can also change it
when Opera asks you for the
password, and when it asks
whether the same should be
used for both the e-mail client
and the Wand.

Search Me
Opera supports several
search engines. You can

either type in a query into the
search field—[Shift] + [F8]—or
you can use the Address Bar to
do the same. Every engine is
associated with a single letter;
thus, Google gets a ‘g’,

Download. com gets a ‘w’, etc.
Press [Alt] + [P] and go to the
Search option for the list of
engines supported and the
associated letter. Here, you can
also change the number of
results displayed per page. To
use the Address Bar for a
Google search, press [F8] and
precede a query with a ‘g,’ for
example, ‘g X-Men movie Web
site’ [Enter], will search for the
‘X-Men…’ string in Google.

Forward/Rewind  
When viewing a page
with no user forward his-

tory, Opera will try to detect a
possible forward link that you
can access. The Forward icon
will change into a FastForward
icon when this is possible.

Certain Web sites, mostly
forums and search engines,
have a single link at the
bottom that takes you to the
next page of posts. Try it with
a search engine to go to the
Next page link, or when
reading a multi-page article. 

It can detect link-next ele-
ments, and will perform
checks to find one if not. Press
the spacebar to follow the link
to the next post, or page.
Rewind takes you back to a
site in the history. If you have
jumped from Google.com to
Thinkdigit.com, you can
rewind to Google by pressing
[Shift] + [Z]. Rewind takes you
back a Web site, so unless you
have followed more than one
link at Thinkdigit.com, you
can press [Shift] + [Z] to go
instantly back to Google.

Pressing [Z], on the other
hand, would take you just one
page back. Note that [Shift] +
[X] takes you forward in a sim-
ilar vein. 

Slideshow
In a Web site that has a
lot of images linked in a

continuous manner (for
example, a site that displays
family photos or screenshots
of games), you can use the
Slideshow feature of Opera to
enjoy the pictures better. The
FastForward button displays
photo files on the Web in a

slideshow. To see photos full-
screen on a black background,
press [F11] to invoke Opera’s
presentation tool, OperaShow.

Reload Time  
Opera can reload a Web
site after a user-specified

time. Right-click on a Web
page and go to Reload every >
Enable. Note that you can also
set a custom time, to reload at,
say, every two minutes and 30
seconds. 

The Custom dialog box
also lets you reload only if the
Web page has expired (as
determined by the site pro-
grammer). Great for those
cricket score Web sites!

By Proxy 
To set up a proxy server,
press [Alt] + [P] >

Network > Proxy Servers. Add
the address and port number
for the appropriate type of the
proxy server here, and just
make sure that the checkbox
is ticked. You can also disable
proxies for certain addresses,
such as within a LAN, and can
point Opera to an automatic
proxy configuration URL, in
case your ISP requires such a
setting. 

Note it Down
Opera lets you keep snip-
pets of text from Web

sites as notes. For example, a
particularly interesting piece of
news can be saved for posterity
as a note. To do this, select any
amount of text off a Web page,
right-click and click on ‘Copy to
note’ ([Ctrl] + [Shift] + [C]). Notes
can then be accessed by
pressing the [F4] key, to invoke
the Hotlist under the Notes sec-
tion. You can delete notes here

Mouse Gestures in Opera
Mouse gestures are a novel way
to navigate the Web using
Opera. For instance, you can
hold the right mouse button
and draw an ‘L’ on a Web page
to indicate that you want it
closed. Similarly, right-click and
hold the mouse over a link and
move it down and then up to
open the link in the background
window. Here are some gestures
supported by Opera. Click and
hold the right mouse button,
move the mouse in the
directions indicated below and
then release the button: 

Open new document: Move
down 

Reload: Move up and down 
Restore or maximise window:

Move up then right 
Minimise: Move down then

left 
Duplicate window: Move

down then up 
Close document: Move down

then right, or move right-left-
right 

Bet You Didn’t Know
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Securing Your Windows XP System with 
In-built Tools

Deepak Dhingra

Enable Firewall 
Before you connect to the
Internet or your LAN, enable

the built-in fire-
w a l l — w i t h o u t
this, your PC
may be infected
with Blaster or
Sasser within
minutes of con-
necting. To do
so:
1. Go to Start >
Control Panel >
Network and
I n t e r n e t
Connections >
N e t w o r k
Connections.

2. Right click on the connection
you want to protect and click
Properties.

3. Click on the Advanced tab
and then select ‘Protect my
computer and network by lim-
iting or preventing access to
this computer from the
Internet.’ Click OK.

Install Security Updates
Security updates protect your
computer from vulnerabilities
and malicious code. Whenever
threats are detected, Microsoft
promptly releases security
patches for their OSes.
Windows XP comes with an
automatic update feature that
downloads new patches auto-
matically. To activate it: 
1. Go to Start > Control
Panel > Performance &
Maintenance > System.

2. Click Automatic Updates,
and then select Keep my com-
puter up to date.

3. Select an appropriate setting.
You can specify a schedule as
to when the updates will be
downloaded and installed.

Since Automatic Update only
installs future updates, you will
also need to go to the Microsoft
Web site for updates and install
the latest available updates.
1. Go to http://windowsup-

date.microsoft.com
2. Click ‘Scan for Updates.’

Windows Update scans your
computer and displays a pre-
selected list of critical
updates.

3. Under ‘Pick updates to
install,’ click ‘Critical
Updates and Service Packs’.
A list of the updates that are
appropriate is generated.
Critical updates are selected
for download by default.

4. Click ‘Review and install
updates.’ 

5. Select the updates and then
click Install Now.

Create Users 
The User Accounts features in
Windows XP can also be used to
protect your computer from
unauthorised access. To avoid
misuse, you can create limited
user accounts. If your PC is
‘hacked’ while you are logged in
as a ‘limited’ user, the hacker
can only inflict limited damage.
To set up a user account:
1. Go to Start > Control Panel >
User Accounts. 

2. Under Pick a task, click
Create a new account. 
3. On the ‘Name the new
account’ window, type a name
for the new account. Click Next. 
4. On the ‘Pick an account type’
page, click the type of account,
and click Create Account. 

You need to assign a pass-
word to your administrator
account so that only you can
access it:
1. Go to Start > Control Panel >
User Accounts.
2. Under ‘Pick an account to
change,’ select and click on the
name of your account. 
3. On the ‘What do you want to
change about your account’
page, click ‘Create a password.’
4. In the ‘Type a new password’
box, enter a password, and
follow the steps that come up. 
5. Click ‘Create Password.’

deepak_dhingra@thinkdigit.com,

Internet Connection Firewall

The settings for Automatic Updates

Just set up a new installation of Windows XP Professional? Here is what you
need to do to secure the PC using in-built tools in Windows XP

Install an
antivirus software,
such as the free AVG
or Avast anti-virus
solutions to protect
your computer from
viruses. Let the soft-
ware get automatic
updates to its virus
definitions to make
sure that you are
immune to the
latest threats.

Do not open
unidentified e-mail
attachments.

Do not share
passwords and
credit card numbers
with anyone over
the Internet.

Also Remember



and create new ones as well.
You can also send a note via e-
mail by right-clicking on it.

Hotlist 
The Hotlist panel is tog-
gled by the [F4] key. It is

a repository of useful stuff—
Bookmarks, Mail, Contacts,
History and Transfers can be
accessed from here. It also
provides a quick listing of all
the windows open (Windows),
information on the Web page
that you are browsing (Info),
and a listing of all the links
off a Web page (Links). 

If that were not enough,
you can customise this panel
by adding games, news pages,
dictionaries, etc. To make a
Web page show up in the
Hotlist, bookmark the page by
pressing [Ctrl] + [T] and select
to show it as a panel. You can
find more panels, specifically

designed for the slim, vertical
layout that the Hotlist offers,
at http://my.opera.com/cus-
tomize/ panel/.

Bookmarks
To file a bookmark, press
[Ctrl] + [T]. You can show

the page under the Hotlist or
on the Personal Bar here. You
can also give a bookmark a
nickname. For example, by
giving Thinkdigit.com the
nickname ‘Home,’ you can
enter ‘Home’ in the Address
bar, and Opera will take you to
the Web site. Make sure you do
not assign a common URL such
as ‘Microsoft.’ A bookmarked
site gets precedence over a URL,
so typing in ‘Microsoft’ will
take you to Thinkdigit.com in
this case. Manage your book-
marks by pressing [Ctrl] + [Alt] +
[B]. Note that deleted ones are
stored in a Trash folder. You can

import bookmarks from IE,
Netscape, Mozilla, etc, over
here. You can also export your
current bookmarks for backup
or other purposes. 

Mail
It is possible to import e-
mails to Opera’s M2 e-

mail client, from earlier ver-
sions of Opera as well as from
Outlook Express, Eudora,
Netscape Mail (only version 6
and 7), or any mailbox stored
in the generic mbox format,
including older versions of
Netscape. Select File > Import
> Mail to import your e-mail.
You can import different
accounts, folders, settings and
contacts. 

When importing from
Opera 6, the folder structure
will be copied to ‘My folder,’
and the imported e-mails will
be saved to the Received folder.

Quick reply is useful for chat-
like conversations. You can
type a short text that will be
appended to the top of the
original quoted message. 

When you are viewing an
e-mail, type your message in
the text box, and click on the
‘Quick reply’ button. This will
send the reply to all the recipi-
ents of the original e-mail. Set
up filters for My folders and
Spam by right-clicking on a
folder and then Properties.
Click on Add filter: Boolean
operators are supported—you
can match your filters by cri-
teria such as Sender, To header,
or Entire mail. The condition
can be set to ‘Contains’,
‘Doesn’t contain’, or ‘Matches
regular expression’. 

When you are finished
with each filter, set the filters
to ‘And’ if your messages must
satisfy all the filter terms, or
‘Or’ if they only need to match
one of them.

Backing Up
Use MozBackup (http://
backup.jasnapaka.com)

to back up your profile. This
freeware utility works with
Mozilla, Mozilla Firefox,
Mozilla Thunderbird and
Netscape. It allows you to
backup e-mails, favourites,
contacts, etc. Just run
MozBackup and choose what
you want to backup. 

Bookmark Backups: the
name of this extension

Readers’ Tips

Firefox
Navigation Made Easy

Firefox lets you navigate browser his-
tory with ease using the scroll wheel.
Press [SShhiifftt] and roll the wheel back-
wards to visit the previous Web page,

or forward to go back to the next Web page.
Sreevirus

Opera Tricks

Some Commands For The Web Page
Here are some smart Opera tricks up my sleeve.
Double-click on a blank page to go to the predefined
homepage. Middle-click on a link to open it in a
background window. If the heavy Java system slows
the browser down, press [F12] and uncheck ‘Enable
Java’. Press the Spacebar twice to ‘FastForward’ to
the next page. Opera intelligently ‘looks’ at a page
and detects ‘Next’ hyperlinks. Use [Ctrl]+[Alt]+[V]
to validate Web pages. Press [G] to toggle between
preventing image to load or permitting them to load
afresh, or from the cache. And by the way, Opera
lets you reopen windows closed in the current ses-

sion by going to Window > Closed. Press
[Ctrl]+[Alt]+[Z] to reopen the Web page that was
closed last.

great_manish

News Feeds
About Opera and RSS 

RSS feeds publish news to Opera, hence
you can get to know the latest without
actually browsing any news sites. Go to
MMaaiill  >>  NNeewwss  FFeeeeddss. A dialogue showing

a few news sites such as BBC, etc., comes up.
Check the ones already mentioned or add a Web
site of your choice, and Opera fetches news from
that site at the specified time interval. 

No need to press the refresh thing at all. News
downloaded is elegantly indicated by a small
popup to the bottom left of the browser. News
sites such as Yahoo! ((hhttttpp::////ssttoorryy..nneewwss..yyaahhoooo
..ccoomm//nneewwss??ttmmppll==ss&&uu==//rrssss__iinnddeexx__tteecchh//ssttaattiicc))
and Reuters ((hhttttpp::////rreeuutteerrss..ccoomm//nneewwssrrssss..jjhhttmmll))
that provide free RSS feeds can be good places to
start with.

Deep

Firefox

Use Bookmark Backup to backup
Bookmarks and other settings in
Firefox
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explains its function. Firefox
uses it to copy the bookmarks
file to a desired location as you
close the browser. If the orig-
inal file gets corrupt or lost,
you can restore the latest
backup by copying into your
profile folder. Simply go to
Tools > Extensions, and click
Options to choose what you
want to back up. Apart from
bookmarks, you can specify
other files to back up too. Be
warned though: use this exten-
sion along with the regular
profile backup. Download
Bookmark Backups from
http://www.pikey.me.uk/mozil
la/?extension=bb.

Profile Games 
All personal settings
such asfavourites list,

history, cookies, e-mail set-
tings, etc, constitute  one pro-
file. 

Firefox uses profiles to
manage multiple users. As a
rule, you have to delete the
installation directory when-
ever you install a newer ver-
sion of Firefox, but you can

safely retain the profiles
folder and restore it. 

Knowing the location of
the profile can be useful
when you install a newer ver-
sion or reinstall the existing
version, when you are
migrating to another com-
puter, or just backing up set-
tings. This folder is located at
C:\Documents and Settings\
< W i n d o w s l o g i n / u s e r
name>\Application Data\
Mozilla\FireFox\Profiles\<Pr
ofile name> in Windows XP
/2000 and at C:\Windows\
ApplicationData\Mozilla\Fire
fox\Profiles\<Profile name>.

Extensions
Akin to plugins, exten-
sions are software that

work with Firefox to give you
the desired functionality.
Download more than 200 such
extensions at http://
extensionroom.mozdev.org/m
ain.php/Firefox.

Tabbed Browsing  
Tabs let you open many
Web pages simultane-

ously. It reduces clutter at the
Task bar and brings other
added benefits, such as ses-
sions, with it. Most popular
browsers such as Opera,
Netscape, Mozilla, and, obvi-
ously Firefox support tabbed
browsing. 

You can also use extensions
to enhance tab functionality.
Some of them are:

Flowing Tabs: Wraps tabs
onto multiple rows

Session Saver: Remembers
open tabs and reopens them
the next time you use the
browser

Tab Killer: Disables tabbed
browsing

Tab Scroller: Lets you switch
between tabs using the scroll
wheel

Tab X: Adds a Close button
to every tab

Undoclosetab: Allows you to
reopen tabs closed recently 
Tab browser Extensions or
‘TBE’ (http://white.sakura.
ne.jp/~piro/xul/_tabexten-
sions.html.en) is a heavy duty
extension that lets you reopen
up to 50 closed tabs, drag-and-
drop and thus rearrange tabs
and use the mouse to navigate.
It also bestows a Close button
and a progress bar on each tab,
and also bundles along the
auto-reload feature.

Customising 
Configuration

Here’s how you configure
Firefox real quick. Simply

type ‘about:config’ in its
address bar and press [Enter] to
bring up a list of customisable
features. Changing a value for
a feature is as simple as double-
clicking it and entering the
appropriate value. Change
these values only if you are
sure of what you intend doing. 

For example, to alter image
animation, find the line that
says image.animation_mode
and change it to once, none or
normal.  ‘Once’ causes anima-
tions to play once, none stops
all animation and normal indi-
cates default animation. 

Easy Search
Search using your
favourite search engine

via the search bar in Firefox.
Press [Ctrl]+[K], type the search
phrase and press [Enter] to
search using Google—the
default search engine. To add
more search engines, click the
arrow at the search bar and
choose ‘Add engines’. This
brings you to a Web site
offering search engine plugins.

An easier way to search is
by using keywords. For
example, type ‘google search-
phrase’ in the address bar to
search in Google. Other key-
words are: ‘goto’ to use

Google’s ‘I’m Feeling Lucky’
search, ‘dict’ to search dic-
tionary.com, etc. You can
come up with your own key-
words too: Add the page (that
you intend creating a keyword
for) to bookmarks, point to
this entry, right-click and
choose Properties. Replace the
phrase you searched for on the
Web page with ‘%s’, type in a
value in the keyword field and
then click OK.

Load Firefox Faster
In Windows XP, right-
click the icon you choose

to start Firefox and choose
Properties. In the target box,
add ‘/Prefetch:1’ to the end of
the line so that it reads:
‘C:\Program Files\Mozilla
F i r e f o x \ F i r e f o x . e x e ”
/Prefetch:1’. This gets Firefox to
load faster.

Form Manager
To better fill out forms on Web
sites, the Form Manger can
remember your personal infor-
mation. Go to Edit >
Preferences > Privacy &
Security > Forms and click on
the ‘Save data from…’
checkbox. Furthermore, you
can also pre-fill personal details
by clicking on the ‘Manage
Stored Form Data’ button.

Importing IE Cookies into
Firefox
Open Internet Explorer, go to
File > Import / Export and
choose ‘Export Cookies’. Specify
a location and click OK. Now,
open this file and put a dot
before every line. For example,
‘yahoo.com TRUE/FALSE
1271725143’ becomes
‘.yahoo.com TRUE/FALSE
1271725143’. Now, move this file
into Firefox’s profiles folder.

Bet You Didn’t Know

Use MozBackup to backup
important settings automatically

Use Bookmark Backup to backup
Bookmarks and other settings of
Firefox

Mozilla



Billing Time with BillingTracker

BillingTracker Pro is  is the
ideal time-management tool
for freelancers, whose

earnings depend on the time
spent on a project.

Setting it Up
The latest version of
BillingTracker Pro is on the
September Digit DVD/CD.

Freelancers work
for several clients at
the same time. Also,
there are several
projects to be
tackled for each
client. This is when
B i l l i n g T r a c k e r
comes in handy. 

To enter client
details, go to
Manage > Manage

Clients. Click the ‘Add new client’
button at the bottom of the
program window. Entering Client
details and then Project details,
are the initial steps to start using
BillingTracker. You can add as
many clients you want by clicking
the ‘Add new client’ button. 

Next, go to Manage > Manage
Projects and choose the name of
the client from the dropdown list.
Then click ‘Add a new project’ to
enter project details for the client
name that you selected.

Use the Timer function to keep
constant track of the time spent
on various projects: Go to Manage
> Timer. Here, you get to keep
track of two projects
simultaneously. Choose the first
client and project and click the
button ‘Set A’. Then select the
second client and project and
click ‘Set A’. Now, you can simply
use the Start button to start the

timer, the Pause button to pause it
and the ‘double arrow’ button to
switch between the projects.

Managing Expenses
All you have to is go to Manage >
Manage Expenses, and you get to
view all the expenses incurred.  To
record a new expense, just click
on ‘Add a new expense’ button,
and enter the values.

Managing Work
Whenever you complete a
particular task, you can enter it to
keep track of the time taken. Go to
Manage > Manage Work to view the
list of all the work done.

It’s Billing Time
Here comes the most crucial part
of the software—creating invoices
and billing your clients. To
manage all your invoices, go to
Manage > Manage Invoice, and you

will get to see a list of all invoices
that you have created. You can
search for any particular invoice.

Got Payment?
BillingTracker Pro is designed to
manage all your transactions with
clients. To record payments
received, go to Manage > Manage
Payments, and click ‘Add a new
payment’. It will show you a list of
all outstanding invoices.

Freelancers—manage your
clients, invoices, expenses,
work, and more

Entering Client
details and then
Project details are
the initial steps to
start using
BillingTracker

Keep track of the time spent on projects
using this tool

Question: In Opera,
is there a way to
arrange my
downloads
automatically by
folders?
Answer: Yes, you can do so.
Among the many features
that Opera comes loaded
with is one that
automatically organises all
your downloads (transfers)
as separate folders, based
on the type of files
downloaded.

To have Opera
accomplish this feat, go to
TToooollss  >>  PPrreeffeerreenncceess  and
select the ‘‘FFiillee  ttyyppeess’’
section of the Preferences
dialog box. 

Here, locate the file
type that you intend
sending to a specific folder.
For example, to send your
downloaded MP3 songs to
your ‘‘cc::\\mmuussiicc’’ folder,
search for the MIME type
called ‘‘AAuuddiioo//mmppeegg’’  with
file extensions of MP3, MP2,
and MPGA. 

You can use the Search
box on the top to type in the
extension you need (for
this, you have to uncheck
‘‘HHiiddee  ffiillee  ttyyppeess  ooppeenneedd  wwiitthh
OOppeerraa’’  ). Once located, click
EEddiitt and in the dialog box
that opens. 

Click on ‘‘SSaavvee  ttoo  ddiisskk’’
and ‘‘DDoo  nnoott  aasskk  ffoorr  ffoollddeerr,,
bbuutt  ssaavvee  ddiirreeccttllyy  ttoo’’ and
then enter the target
folder—eg, ‘‘cc::\\mmuussiicc’’——in the
text box that you see there.
Click OOKK and you are done!

Repeat the same steps
for extensions of all the
other files that you want to
store in different folders.

Tip Of The Month
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Contact information, billing
details and shipping particu-
lars can all be separate sets of
data, granting greater flexi-
bility. After you configure it,
you can save a relevant form’s
data from Edit > Save Form
Info and the saved data can be
loaded by clicking on Edit > Fill
in Form. You can select which
fields to auto-fill here.

Popup Windows
Annoying popups can be
turned off from Edit >

Preferences > Privacy &
Security > Popup Windows.
You can also define Web sites as
exceptions for both allowing
and suppressing pop-up win-

dows. Also, Mozilla displays a
confirmation dialog box, and
displays an icon in the status
bar upon popup blocking.

Managing Passwords 
Password Manager stores
your login information

for password-protected Web
sites, mail and news servers.
Turn on this option from Edit >
Preferences > Privacy &
Security > Passwords. You can
also encrypt this stored data.
Stored data such as passwords
can have a master password
acting as a safety mechanism.
This way, Mozilla can confirm
your identity before auto-filling
login information and such.
You can tell the browser to ask
you the master password either
the first time it is needed, or
every time. It can also be tagged
to a time limit—useful if your
PC is used by multiple users.

Bookmark Keywords
To set keywords (custom
shortcuts to bookmarks):

go to Bookmarks > Manage
Bookmarks (or press [Ctrl] +
[B]) and select the bookmark
you want to set a keyword for.
Click Properties or press [Ctrl] +

[I] and enter a keyword for that
bookmark. You will be able to
go there by entering this key-
word in the address bar.

Rescue Me
If your old profile has
been corrupted, this is

how you can rescue it:
1. Note the name of the

folder with the old profile.
2. Start the Profile

Manager and create a new
profile. Exit Mozilla (and
also Quick Launch).

3. Go to the profile
folders. Copy all files from
the old profile folder to the
new profile folder, allowing
existing files in the new pro-
file’s folder to be replaced.

4. If you want to copy
your form data and pass-
words: save your form data
and passwords in your new pro-
file. Find the two numbered
files with the .w and .s exten-
sions in your new profile’s
folder. Make copies of the files
with the same extensions in
your old profile folder, rename
them (with numbers matching
those of the files in the new
profile folder. Copy them to the
new profile. Replace the files.

5. Restart the Profile
Manager and start with the

new profile. The contents of
your old profile should now
have been successfully restored
to the new profile.
Add-Ons: Visit http://www.
mozdev.org/projects/active.ht
ml for more add-ons.

MozBlog: Blog with Mozilla
while you surf—http://
mozblog.mozdev.org/Mouse
Gesture Support: Navigate the
Web using click-and-drag
mouse gestures http://
optimoz.mozdev/gestures/
Piemenus. A radical way 
to access the Mozilla UI,
Piemenus reduces mouses
movements and is easy to adapt
to—http://www.gamemakers.de
/mozillaradalcontext/.  

Changing the Words
‘Mozilla Firefox’ in the
Window Title
Navigate to the installation
folder. Typically, it’s
C:\Program Files\Mozilla
Firefox. Once there, copy a
folder called chrome to some
other location, so that you can
restore it later if something
goes wrong. Extract en-US.jar
(present in this folder), unzip
it, and go to locale\en-
US\global folder. Open the file
brand.dtd using Notepad.
Locate these lines:
<!ENTITY brandShortName
“Firefox”>
<!ENTITY brandFullName

“Mozilla Firefox”>
<!ENTITY version “0.8”>
<!ENTITY vendorShortName

“Mozilla Firefox”>
and change them to:
<!ENTITY brandShortName
“My Browser”>
<!ENTITY brandFullName “My

Browser”>
<!ENTITY version “1.0”>
<!ENTITY vendorShortName

“My Browser”>
Now zip the folder and start
Firefox to see the results. If you
plan to use the inbuilt zip
feature of Windows XP, rename
the extension of en-US.jar file
to .zip, unzip it, make the
changes, zip it and change its
extension back to .jar. In case
anything goes wrong, replace
this folder with its backup.

Bet You Didn’t Know

You can block pop-ups and create a list of exceptions—sites whose pop-
ups are not blocked

Speed Browsing in Mozilla
Go to Edit > Preferences >
Advanced > HTTP Networking
and check ‘Enable Pipelining’.
Mozilla defaults this to ‘off’ as
certain servers and proxies have
problems with pipelining, but
when ‘on’, the browser fetches
everything on the page in a
single connection, rather than
making one connection for
each item, thus boosting
browsing performance. 

Bet You Didn’t Know
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Digital Tools l Visual Explanation

Using NAT
A NAT (Network Address

Translation) server works
like a robot. It shows

no understanding,
and doesn’t care

what it is you want.
All it knows is that one

Internet Protocol (your
computer’s) wants to
connect to another (the IP of
the server you want to
connect to). A NAT server is
a solution for all non-HTTP
traffic, as all other protocols
have no need for caching. 

Varied Requirements
In a typical office, connectivity
requirements differ from user to user.
We can break up these requirements
into HTTP requests and ‘other’
protocols, but every computer wants
data, and it wants it now 

Squid
Proxy servers, such as Squid, can

take care of HTTP requests. Squid,
for example, is intelligent. It reads

what you want, then checks its
cache for the requested item. In

the example, Google.com is
present in the cache, whereas

ThinkDigit.com isn’t

How Shared
Internet Works
In a typical office environment, an Internet
connection is shared over a network across several
users. The two basic sharing systems are NAT
(Network Address Translation) and 
Proxy (Squid in our example). 
Here’s how they work...

I want Google.com

I want
ThinkDigit.com

I want MSN Messenger
to connect

I want streaming audio

I want to connect
to IRC
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The End Justifies The Means
Both Squid and NAT have their

place in an office where an
Internet connection needs to be
shared. Used in conjunction, the

two can power your sharing
requirements, and make for a

satisfying user experience

Internet Requests 
When Squid recieves data
from the Internet, objects

are cached for later
retrieval. Of course, all this

depends on the size rules
you set in Squid, such as

maximum object size. In the
example, the request for

ThinkDigit.com is saved in
the cache, and a reply is

sent to the user requesting it

Cached Hits
When an object is available in the cache,
Squid doesn’t connect to the Internet, and
instead, sends a reply instantaneously.
Not only does this improve surfing speeds
on the average, it also translates to
bandwidth savings. In the example, a
reply for Google.com is sent immediately,
while Squid sends a request to the
Internet for ThinkDigit.com
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end up paying more than needed.
This also increases the chances of
RF interference with nearby APs.

In its simplest form, you can
conduct a site survey with just a
Wi-Fi enabled laptop and appro-
priate software. A comprehensive
site survey can be conducted with
devices such as spectrum or hand-
led hardware analyser from, say,
AirMagnet, especially designed for
this purpose. However, these are
expensive and you might want to
take the laptop route.

The site survey process consists
of first checking whether any
device is causing interference in
the region that you need covered.
You might find signals from neigh-
bouring areas. If you do find inter-
ference, locate that is causing it
and reposition the equipment.

The next step involves placing
each AP at different locations, one
at a time, and marking out the
boundaries where the signal is
available. The entire process is
based on trial and error. Once you
prepare a boundary map by plac-
ing an AP at multiple locations,
analyse it to ensure a proper over-
lap of signals, and make sure that
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W
i-Fi, or Wireless

Fidelity, means
freedom—free -
dom to connect to
the Internet from

just about anywhere in your home
or small office. We are all familiar
with the cell-based technique of
mobile communication. It is the
basis of Wi-Fi technology too. As
long as you are in a region covered
by Wi-Fi—also called a hotspot—
you can access the Internet.

While on one hand, Wi-Fi gets
rid of problems, such as wire
hassles, that exist with wired
networking, it does bring about a

setback in the data through-
put provided by the various Wi-Fi
standards, vis-à-vis wired network-
ing. Here, we check which prod-
ucts in this domain are the best.
How large is the bandwidth gap
between wired and wireless? How
much extra do you pay? We
explore several such questions and
attempt to provide answers.

SETTING UP A NEW OFFICE
Site Survey
A major hurdle you encounter
while setting up a Wi-Fi hotspot is
determining the exact location for
Access Points (APs), and the
number of APs you need to provide
a constant and reliable connection.
Install too many devices and you

Say good-bye to
endless cables
and entangled
wires, and say
hello to a whole
new workplace

Break
Free
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change channels, while Linksys’ WPC11 does not allow you to save
the configuration to the disk.
Price
Linksys’ WPC11 provides the best price for an AP at Rs 4,000, while
Dax’s DX-910AB0 and Net4India’s N4I-WB2200APR products
turned out to be too expensive.

Thus, even though the top two performers were Net4India’s
N4I-WB2200APR & Dax’s DX-910AB0, pricing made the Linksys
WPC11 and the Compex WP11B+ the winners.

Connections Of An AP
The site survey determines the location and nature of an AP
needed. Now that you have selected a device to buy, you need to
install it. The first step is simply placing the APs at the determined
locations and powering them up.

A factor that plays an important role is the type
of Internet connection. If you
have a cable/DSL connection,
you need to connect the
cable from the provider to
the WAN port of the AP. You
need to know details such as
the IP address, the subnet
mask and the gateway from
the ISP provider.

If you access the Internet
using dial-up, you need to
connect the modem to the
USB/COM port. However, if
the device you selected has
an RJ-11 port, you can just connect the telephone line directly.
There is no need for a separate modem, as the device will have an
inbuilt modem.

Most of the devices have four LAN ports. If you wish, you can
connect up to four machines using wires to the LAN ports.

Minimum Configuration In An AP
To configure the AP, you have to connect at least one PC with a
wireless PCI card or a Wi-Fi-enabled laptop to the network of the
AP. If you do not have a Wi-Fi-enabled machine, you can connect
using a ‘patch cord’.

For the LAN—be it wired or wireless—it should have the
‘Obtain an IP address’ setting enabled. The DHCP server in the AP
will assign an IP to a wireless client. In some APs, DHCP is turned
‘off’, so you will have to look up the manual—to obtain the IP
address of the AP, as well as find the other steps you need to take.

To access browser-based configuration, you will need to know
the relevant username and password combination. This infor-
mation is different for each AP, and you will need to refer to the
manual to figure out a particular combination. 

There are three important tasks that you need to perform as
soon as you log in. The first is specifying the ESSID and channel:

An AP works in any of the
channels that it is supposed to

work in. The RF, say 2.412 GHz for
channel 1, represents the centre
frequency. Similarly, 2.417
represents channel 2. These
channels are separated by 5 MHz
from each other. However, the
bandwidth that each of these
channels needs is around 30 MHz-
15MHz on each side of the centre
frequency. Hence, technically, two
APs overlap each other if they use
consecutive channels.

If you assign channel 1 to
Access Point 1, then you cannot
use channels 2, 3, 4, and 5 for the
second Access Point, as 2 and 3
will overlap with 1 while 4 and 5
will overlap with 2 and 3. This
means you can only use channel
6. Now, if you wish to connect a
third AP, then only channel 11 is
available. Channel 11 is the last
channel available, so if you wish
to connect a fourth AP, you
cannot do so without overlap.

Channel Conflict

SEPTEMBER 2004
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802.11g Category 802.11b Category 

Score Board

Brand
Model
Performance (40%)
Data Throughput - WLAN Port
Centrino 11G (Acer)

Location 1 (Avg MPS) 
Location 2 (Avg MPS) 
Location 3 (Avg MPS) 

TI (DWL-650G+)
Location 1 (Avg MPS) 
Location 2 (Avg MPS) 
Location 3 (Avg MPS)

Realtek (WPC11)
Location 1 (Avg MPS) 
Location 2 (Avg MPS) 
Location 3 (Avg MPS) 

Ping
Centrino 11G (Acer)

Location 1 (Avg ms) 
Location 2 (Avg ms) 
Location 3 (Avg ms)

TI (DWL-650G+)
Location 1 (Avg ms) 
Location 2 (Avg ms) 
Location 3 (Avg ms) 

Realtek (WPC11)
Location 1 (Avg ms) 
Location 2 (Avg ms) 
Location 3 (Avg ms) 

SNR
Centrino 11G (Acer)

Location 1 (Avg db)
Location 2 (Avg db)
Location 3 (Avg db)

TI (DWL-650G+)
Location 1 (Avg db)
Location 2 (Avg db)
Location 3 (Avg db)

Realtek (WPC11)
Location 1 (Avg db)
Location 2 (Avg db)
Location 3 (Avg db)

Data Throughput - LAN to WAN
Location 1 (Avg MPS) 

Others
Network Issues (Out of 28) 
Compatibility (Scale of 3) 

Features (20%)
No of Antennas
No of LAN ports
Additional ports
Kit bundled
Hardware Reset Button
Auto firmware upgrade via internet
Power Over Ethernet
Encryption
LED

Port Mapping
Access Control
WDS
Firewall
Gateway/Router
Wireless Bridging
Ease of Use (20%)
Browser-based configuration
Ease of determining Access Point’s IP (Scale of 5)
Configuration (Scale of 5)
Channel Change allowed
Save Settings to HDD
Menu Layout (Scale of 5)
Price Index (20%)
Price (Rs)
Overall Score (Out of 100)

Buffalo 
WBR2-G54 
15.24 

1.18 
1.20 
0.26 

0.09 
0.09 
NN 

0.36 
0.31 
NN 

20.00 
13.00 
20.00 

233.00 
97.00 
NN 

13.00 
35.00 
NN 

73.00 
58.00 
26.00 

70.00 
51.00 
NN 

55.00 
37.00 
NN 

1.70 

22.00 
3.00 
10.00 
0
4
Ext Ant 
CAT5 UTP 
Y 
N 
N 
WEP, WPA 
Power, LAN,
WLAN, Diag 
N 
N 
Y 
Y 
N 
Y 
18.80 
Y 
5.00 
4.00 
Y 
Y 
4.00 
13.68
7,600
57.72  

D-Link 
DWL724P+
14.15 

0.47 
0.36 
0.11 

0.08 
0.08 
0.00 

0.42 
0.41 
NN 

2.00 
1.00 
131.00 

50.00 
44.00 
NN 

1,314.00 
133.00 
NN 

75.00 
70.00 
29.00 

71.00 
54.00 
19.00 

50.00 
42.00 
NN 

3.79 

23.50 
3.00 
9.40 
1
4
LPT, Ext Ant 
CAT5 UTP 
Y 
N 
N 
WEP 
Power, LAN,
WLAN, Diag 
Y 
Y 
N 
Y 
Y 
N 
20.00 
Y 
5.00 
5.00 
Y 
Y 
5.00 
13.87
7,500
57.42 

Dax 
DX-910AB0 
13.56 

0.18 
0.17 
0.16 

0.09 
0.09 
0.02 

0.25 
0.24 
NN 

115.00 
14.00 
11.00 

44.00 
65.00 
139.00 

2.00 
653.00 
NN 

66.00 
65.00 
26.00 

68.00 
48.00 
19.00 

55.00 
43.00 
15.00 

- 

24.50 
3.00 
8.00 
2
0
COM, Ext Ant 
CAT5 UTP 
Y 
Y 
N 
WEP 
Power, LAN,
WLAN 
N 
Y 
N 
N 
N 
N 
20.00 
Y 
5.00 
5.00 
Y 
Y 
5.00 
4.63 
13,815
46.19 

Compex 
NetPassage 16A+
11.80

0.15 
0.12 
0.14 

0.07 
0.06 
0.05 

0.25 
0.06 
NN 

25.00 
233.00 
19.00 

92.00 
175.00 
231.00 

21.00 
RTO 
NN 

71.00 
62.00 
30.00 

70.00 
54.00 
NN 

54.00 
44.00 
NN 

- 

22.00 
3.00 
7.40 
1
4
COM, Ext Ant 
CAT5 UTP 
Y
N 
N 
- 

Power, LAN,
WLAN, Diag 
N 
N 
N 
Y 
Y 
N 
15.40 
Y 
5.00 
3.00 
N 
Y 
5.00 
10.16
6,300
44.76 

Compex 
WP11B+ 
13.36 

0.23 
0.24 
0.02 

0.10 
0.11 
NN 

0.23 
0.24 
NN 

3.00 
3.00 
14.00 

58.00 
84.00 
NN 

102.00 
3.00 
NN 

78.00 
71.00 
24.00 

69.00 
52.00 
NN 

55.00 
55.00 
NN 

- 

21.00 
3.00 
7.80 
0
0
- 
RJ45, CAT5 UTP 
Y 
N 
N 
WEP, WPA 
Power, LAN,
WLAN, Diag 
N 
N 
N 
N 
N 
Y 
18.00 
Y 
5.00 
3.50 
Y 
Y 
3.00 
10.67
6,000
49.82 

Linksys 
BEFW11S4 
11.58

0.17 
0.23 
0.19 

NC 
NC 
NC 

0.26 
0.25 
0.11 

3.00 
15.00 
26.00 

NC 
NC 
NC 

19.00 
20.00 
3.00 

87.00 
71.00 
39.00 

NC 
NC 
NC 

55.00 
44.00 
18.00 

0.60 

19.00 
2.00 
7.80 
2
4
- 
- 

Y 
N 
N 
WEP 
Power, LAN,
WLAN 
Y 
Y 
N 
Y 
Y 
N 
15.40 
Y 
5.00 
4.00 
Y 
N 
3.00 
16.00
4,000
50.78

D-Link 
DWL-2000AP+ 
14.73 

0.96 
1.04 
0.06 

0.08 
0.09 
0.05 

0.41 
0.37 
NN 

2.00 
18.00 
21.00 

109.00 
198.00 
140.00 

7.00 
2.00 
NN 

76.00 
67.00 
29.00 

70.00 
60.00 
21.00 

55.00 
40.00 
NN 

- 

25.00 
3.00 
8.60 
1
0
Ext Ant 
CAT5 UTP 
Y 
N 
N 
WEP, WPA 
Power, LAN,
WLAN 
N 
N 
N 
Y 
N 
Y 
18.30 
Y 
5.00 
4.00 
Y 
Y 
4.00 
16.00
6,500
57.63 

Compex 
WPE54G
13.17 

0.97 
0.76 
0.00 

0.09 
0.11 
NN 

0.12 
0.13 
NN 

10.00 
1.00 
72.00 

78.00 
34.00 
NN 

4.00 
2.00 
NN 

73.00 
67.00 
30.00 

69.00 
48.00 
17.00 

55.00 
55.00 
NN 

- 

22.00 
3.00 
10.80 
1
0
Ext Ant 
CAT5 UTP 
Y 
N 
N 
WEP, WPA 
Power, LAN,
WLAN, Diag 
N 
Y 
Y 
N 
N 
Y 
19.20 
Y 
5.00 
5.00 
Y 
Y 
3.00 
13.51 
7,700
56.67 
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across locations, thus being the
performer of interest. The best two
turned out to be NetGear’s WG311
and Buffalo’s WLI-PCI-G54.
Features
PCI cards with antennas that are
flexible wires about two metres
long help you get better connec-
tivity than those that provide a
fixed antenna that protrudes from
behind the cabinet. These tend to
get blocked in corners, and thus
cause performance  to degrade.
Buffalo and MSI provide antennas
with flexible wires.

Unlike PC cards, all PCI cards
provide an antenna. Buffalo’s
antenna connector, though, is
not standard: you cannot

here, ESSID is optional—it just the
name by which the AP will be
recognised. The channel should be
specified so that there is no over-
lapping. Next, you will need to
specify WAN details, which will be
provided by your ISP. Finally, you
need to set up security. Here, give
preference to WPA—it is more
secure.

Making your PCs 
Wi-Fi-enabled
APs, by themselves, do not make a
wire-free zone; you need to
purchase PCI cards for your
computers. Just like the APs, PCI
cards also come in 802.11g and
802.11b flavours. In this test, we
saw five cards supporting 802.11g,
while only one represented the
802.11b category. This clearly indi-
cates that the market is moving
towards 802.11g.

PCI CARDS@802.11G
Performance
In this test, Buffalo’s PCI card
achieved a maximum data rate of
1.17 MBps when connected to a
Compex 26G AP, but the pair was
not able to give sustained perform-
ance. NetGear’s WG511, though a
little slower, showed a sustained
data throughput across APs and

Installing
PCMCIA
cards is not
much of a
hassle

The Standards Battle

Data Rate (Mbps)
Avg. Actual Data Throughput
(Mbps)
RF Band (GHz)
Channels
Non-overlapping channels

802.11a
54 
25 - 30

5
12
8

802.11g
54 
20 - 25

2.4
11
3

802.11b
11 
4 -5

2.4
11
3

SEPTEMBER 2004

AirPlus G+ DWL-520G+

Notebooks are WiFi-enabled
using PC cards while

desktop PCs use PCI WiFi cards
to do so. Another solution is to
use an external USB wireless
adapter. These support both
802.11g as well as 802.11b, and
can be used with notebooks and
desktop PCs as well.

Those supporting 802.11b
come with USB 1.1, while the
ones supporting 802.11g are
equipped with USB 2.0. The USB
interface itself does not impose
any restriction on data transfer
rates. All the three tested

devices put up performances as
good as any other PCI or PC
wireless card.

If your system does not
have a free PCI slot, or if the
laptop’s PCMCIA slot is already
in use, you have no option 
but to buy a USB-based 
wireless client.

These devices are costlier
than the PCI/PCMCIA option,
but do remember that an
external USB device can provide
you with the option of enabling
WiFi functionality on your home
as well as office PC. 

USB Wireless Clients

DDaattaa  TThhrroouugghhppuutt  ((MMPPSS))
Compex 26G
Linksys WPC11
D-Link DWL-2000AP+
LLaatteennccyy  ((mmss))
Compex 26G
Linksys WPC11
D-Link DWL-2000AP+
SSNNRR  ((ddbb))
Compex 26G
Linksys WPC11
D-Link DWL-2000AP+ (db)
Price (Rs)

Dax DX-900USB
(802.11b)
.39
.13
.36

2
25
3

100
100
100
3815

Compex WLU54G
(802.11g)
.52
.13
.62

2
5
3

-51
-55
-60
4400

Compex WLU11A
(802.11b)
.37
.17
.33

82
4
3

NC
NC
NC
2600

Digital Tools l Test Centre

connect a replacement antenna
if the original gets damaged.
Also missing in the Buffalo
device was WPA.
Ease Of Use
There is not much to configure in
a wireless client—just install the
drivers and connect it to the AP.
These steps are essentially the
same, irrespective of  the card you
are using. Still, a quick-start guide
and a configuration utility can
come in handy.

Price
Here again, the performers were
not the winners: pricing causes
both Buffalo’s WLI-PCI-G54 and
NetGear’s WG311 to lose out to
SMC’s 2802W and D-Link’s AirPlus
G+ DWL-G520+.

Adding Hardware
For PCI cards, there is not much of
a hardware installation hassle.
Find a free PCI slot on the moth-
erboard and insert the wireless
card. Connect the external
antenna, if one comes bundled.
Remember to switch off the power
supply before doing a  surgery on
your PC’s internals.

Driver Installation
On restarting the PC after you
insert the PCI card, Windows will
ask for the driver disk. Insert the
driver CD-ROM that comes with
the card. You can switch on the
APs now. As the driver installation
completes itself, you should see a
network icon in the system tray.
Right-click on this icon and select
‘View Available Wireless
Networks’. Now, you should be
able to see the AP. Select it, then

SMC 2802W

SEPTEMBER 2004
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802.11g PCMCIA Cards 802.11g PCI Cards802.11b PCMCIA Cards 802.11b PCI Card

Score Board

Brand
Model
Features (15%) 
External Antenna
External Antenna Port
Popout Antenna
Flexi Wire Antenna
Encryption
LED
Supports Ad hoc Mode
Ease of Use (10%) 
Quick Start Guide
Configuration Utility bunbled
Performance (50%) 
Data Throughput - WLAN Port
LinkSys

Location 1 (Avg MPS) 
Location 2 (Avg MPS) 
Location 3 (Avg MPS) 

Compex 26G
Location 1 (Avg MPS) 
Location 2 (Avg MPS) 
Location 3 (Avg MPS)

D-Link 2000AP+
Location 1 (Avg MPS) 
Location 2 (Avg MPS) 
Location 3 (Avg MPS)

Latency
LinkSys

Location 1 (Avg ms) 
Location 2 (Avg ms) 
Location 3 (Avg ms) 

Compex 26G
Location 1 (Avg ms) 
Location 2 (Avg ms) 
Location 3 (Avg ms)

D-Link 2000AP+
Location 1 (Avg ms)
Location 2 (Avg ms) 
Location 3 (Avg ms) 

SNR
LinkSys

Location 1 (Avg db)
Location 2 (Avg db)
Location 3 (Avg db)

Compex 26G
Location 1 (Avg db)
Location 2 (Avg db)
Location 3 (Avg db)

D-Link 2000AP+
Location 1 (Avg db)
Location 2 (Avg db)
Location 3 (Avg db)

Others 
Network Issues (Out of 27) 
Compatibility (Scale of 3) 

Price Index (25%) 
Price (Rs) 
Overall Score (Out of 100)

D-Link
DWL-G650+
7.13 
N
N
N
N
WEP, WPA
Link, Act
Y
10.00
Y
Y
8.48 

NC
NC
NC

0.09
0.08
0.00016

0.06
0.1
NN

NC
NC
NC

49
46
70

59
45
NN

NC
NC
NC

69
50
24

70
49
NN

15
2
20.00
3000
45.60

Compex
WL11B+
4.88 
N
Y
N
N
WEP
Link, Act
Y
10.00 
Y
Y
17.61

0.09
0.1
0.04

0.06
0.18
NN

0.19
0.17
NN

37
12
37

3
2
NN

3
2
NN

77
58
22

65
54
17

71
52
15

23
3
17.39 
2300
49.88

D-Link
DWL-G520+
11.63
Y
Y
Y
N
WEP, WPA
Power, Link, Act
Y
10.00
Y
Y
26.42 

0.15
0.14
0.15

0.74
0.77
0.5

0.85
0.94
NN

2
7
3

1
1
1

2
23
NN

71
65
39

72
60
32

73
54
31

25
3
17.14
3500
65.19 

SMC
2802W
11.81 
Y
Y
Y
N
WEP, WPA
Power, Link, Act
Y
10.00
Y
Y
23.14 

0.13
0.12
NN

0.46
0.33
NN

0.86
1.11
NN

4
3
3

1
1
5

2
2
4

75
61
34

72
53
27

64
58
34

24
3
18.75 
3200
63.70

Asus
WL-130B
11.44
Y
Y
Y
N
WEP, WPA
Act
Y
10.00 
Y
Y
23.74 

0.16
0.15
0.15

0.04
0.1
NN

0.24
0.23
0.19

2
5
8

1
1
2

2
2
4

80
70
39

77
67
43

74
67
37

26
3
20.00 
2000
65.18

Buffalo
WLI-CB-G54A
4.88 
N
Y
N
N
WEP
Power, Link
Y
10.00
Y
Y
36.12

0.14
0.13
NN

0.95
0.96
NN

1.09
0.77
NN

2
12
NN

1
1
NN

1
5
12

74
75
33

75
57
NN

74
52
59

21
3
16.00 
2500
66.99

NetGear
WG511
3.38 
N
N
n
N
WEP
Power, Link
Y
10.00
Y
Y
20.67

0.1
0.07
0.08

0.61
0.55
0.01

0.59
69
NN

3
4
34

2
1
20

2
2
NN

73
54
24

55
46
19

71
46
14

25
3
13.64 
4400
47.68

Telephone Web siteCompany E-mailFaxBrand

Contact Sheet

Apple
Asus
Buffalo
Compex
D-Link
Dax
Linksys
MSI
Net4India
Netgear
SMC

Apple Computer International 
Rashi Peripherals 
Buffalo Inc.
Rashi Peripherals 
D-Link India Limited
Dax Networks 
Kaybee Infotech 
Tirupati Enterprises 
Net4India Limited 
Cyberstar Infocom Ltd 
Cyberstar Infocom Ltd

080-25550575 
022-28260258
011-51527935 
022-28260258
022-26526696 
044-24323558 
022-28216763 
033-22251192 
022-24988511 
080-22223762
080-22223762

080-25550660 
022-56916609
011-51527989 
022-56916609
022-56902210 
044-24357267
NA
NA
022-24988543 
080-22236781
080-22236781

indiainfo@asia.apple.com 
ho@rptechindia.com
anjuthapa@buffalo-india.com 
ho@rptechindia.com
sales@dlink.co.in 
sujit@daxnetworks.com
sales@kaybeeinfotech.com
abhishek@tirupati.net 
infohps@net4india.net 
deepak@cyberstarindia.com 
deepak@cyberstarindia.com

www.apple.com
www.asus.com
www.buffalo-india.com
www.compex.com.sg
www.dlink.co.in
www.daxnetworks.com
www.linksys.com
www.msi.com.tw
www.net4india.net
www.netgear.com
www.smc-asia.com

Note 
NC - Not Compatible
NN - No Network detected

For details of all the tables,
visit
www.thinkdigit.com/fromthe
mag/200409 or refer to the
Digit CD.



72 DIGIT SEPTEMBER 2004

strip th pg Ad

select ‘Allow me to connect to the
selected network’ and press
‘connect.’ The PC is now on the
wireless network.

Creating a Mobile 
Workforce
Wireless PCMCIA cards  (PC cards)
let laptop-wielding executives
connect to the network as they
walk into office.

But then, they may not need a
PC card, as most of the new laptop
models are already Wi-Fi-enabled.
If your company uses such laptops,
configure the cards to connect to

the AP and you are done.
In the tests, we had six

PCMCIA cards—three each for
802.11g and 802.11b.

PC CARDS
Performance
Performance-wise,
the PCMCIA cards
did not put up a
great show as
compared to PCI
cards. A factor that
definitely affected
performance was
the  presence of an

SEPTEMBER 2004

NetGear WG511

external antenna in PCI cards,
which is absent in the PCMCIAs,
especially at Location 3. In the
802.11g category, the NetGear
WG511 outperformed the others.
Similarly, the Buffalo WLI-CB-G54A
easily came out tops in the 802.11b
category. In the compatibility test,
Compex’s WL54G failed badly at
Location 3. 

Features
By default, PC cards do not have an
external antenna, but Compex’s
WL54G and Buffalo’s WLI-CB-G54A
did provide ports to connect them.
Only the D-Link in the 802.11g
category and Linksys’ WPC11 in
the 802.11b category had WPA.

Price
Here, the NetGear and Buffalo
took a big lead in the performance
tests, and so, despite the low price
of the D-Link and the Compex, the
NetGear and Buffalo devices took
the crown in this category.

Enabling Wireless
Just like PCI cards, PC cards too are
simple and straightforward to
install. Just plug in the PC card
into the slot in the notebook,
insert the driver CD in the CD-ROM
and let the installation complete.
The difference here is that you can

SEPTEMBER 2004

AirStation WLI-CB-G54A

DHHCCPP:: Domain Host Control
Protocol lets each computer that

connects to the network get a
temporary IP address. It is used in
scenarios where there are more
computers than available IP
addresses.

MIC: Message integrity check. A
one-way cryptographic hash function
used in WPA instead of CRC32.

Repeater mode: In this method,
an AP is an extension of remote
access point. Repeater Mode is used
to extend the signal range of a
remote AP or wireless router. The
MAC address of the remote AP is
required to set an AP into repeater
mode.

RF: Radio Frequency. Specifies
the frequency at which the signal is
being broadcast.

SNR: Signal-to-Noise Ratio is the
ratio of the amplitude of desired
signal to that of noise at a specific
time. It is expressed in decibels.

SSID: Secure Set Identification is
a name given to the Access Point.
When the client PC scans for an

available network, the SSID will be
displayed in the ‘available network’
box, and the user can click on it to
connect.

TKIP: Temporary Key Integrity
Protocol ensures the key changes at
every specified interval, and also
performs a hash to generate a new
key in WPA.

WEP: Wired Equivalent Privacy is
a data encryption method to provide
security to the client systems
connecting to it. It is not very safe
because of the insufficient length of
the network key; besides, there’s no
method to distribute it amongst the
clients.

Wireless bridge: In this mode,
two APs can be bridged with each
other for communication. It is used
when the networks of two buildings
or offices need to be connected
wirelessly.

WPA: Wi-Fi Protected Access is an
improvement over WEP, as it utilises
the Temporary Key Integrity protocol
(TKIP). It will be in use until the
802.11i standard is properly ratified.

Glossary

Digital Tools l Test Centre
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insert a PCMCIA card while the
laptop is on. Next, right-click the
network icon and select an AP, just
as for PCI cards.
Securing Your Airborne
Data
You cannot limit radio frequencies
to the borders of the office wall. It
will definitely be visible in the
neighbouring areas, making the
network open to attack. If, you
simply sit and relax after the
network is up, you are putting the

data of your organi-
sation at risk. Most
devices still depend
on the WEP secu-
rity standard,
which is not very
secure at all. Even a
novice hacker,
armed with a good

search engine, can find a WEP snif-
fer to get into your wireless
network in no time.

Managing the WEP key is
pretty difficult too. Since each
mobile client stores a WEP key, it
is a nightmare for a system admin-
istrator to modify the key for every
mobile client to keep enforcing
security, or in a situation when
one of the clients permanently
leaves the network.

The TKIP (Temporary Key
Integrity Protocol) in WPA forms
part of the final key, which is used
to encrypt data. 

It also requires a re-keying
mechanism between the mobile
clients and the AP every 10,000
packets. This process reduces 
the chances of key detection
using sniffers.

The extended IV (Initialisation
Vector) reduces the chances of
replay attacks. Similarly, MIC
(Message Integrity Check) prevents
attackers from capturing, modify-
ing and re-sending data packets. 

All said and done, WPA is a
solution to all known issues of
WEP authentication and data
security. 

Setting up WPA in a home

environment is as simple as
setting up WEP. Just think of a key,
which could be alphanumeric
text. Specify this in the AP as well
as the clients. That’s it!

Summing It Up
802.11g is killing 802.11b, which
is only good for the end user. 
The speed provided by 802.11g 
is not similar to that of the 
speed provided by a 100 Mbps
wired network—let alone Giga-
bit Ethernet. The price you 
pay for being wire-free is high,
but the cost of the setup is
coming down. 

Devices which retailed for
more than Rs 20,000 some time
ago are available for less than Rs
7,000 now. 

SEPTEMBER 2004

Switch
Access Point
100 metre wire
10 RJ45 connectors
5 PCI Ethernet cards
5 PCI Wi-Fi cards
1 PCMCIA Wi-Fi card
Total

Wired
1600
-
2200
80
2500
-
4400
10780

802.11b
-
4000
-
-
-
10000
2500
20500

802.11g
-
7600
-
-
-
17500
4400
29500

Price Comparison

SEPTEMBER 2004

D-Link DWL-650G+

Compex WL11B+
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Pulse

Sony Ericsson K700i

Nikon D70

HP PhotoSmart R707
A Smart Cam For Amateurs—Say Cheese!
The HP Photosmart R707 will leave amateur
photographers drooling. This easy-to-use
camera sports a 5.1 megapixel CCD. Expect

impressive
picture and
colour
quality. One
hitch: images
can be saved
only in the
JPEG format.
The camera

comes with bundled software and a memory
capacity of 32 MB, with an additional
memory slot. The red-eye reduction and
image advice features are cool. It would be
ideal to buy the HP 8867 docking station
along with the camera. 

Company Hewlett Packard India ltd
Price Rs 29,990; Docking Station Rs 6,000
Phone 1600-114141
E-mail seema.dawar@hp.com 
Web site www.hp.com

Camera Ergonomics At Its Best

The D70 is Nikon’s answer to the EOS D300
from Canon. This digital SLR sports a 6

megapixel CCD, and stores images in RAW, TIFF
and JPEG formats. The camera’s ergonomics will
leave you gasping. Playing around with
functions such as white balance, ISO or Image

quality is no stiff ask. The cool 1/8” LCD screen is quite a beauty, too.
Image quality is breathtaking, even without in-depth settings. It’s
ideal with a Nikkor F mount lens.  

Company Inter Foto India Pvt Ltd
Price Rs 68,500 (for body), Rs 88,500 (with lens)
Phone 022-24925151
E-mail info@interfotoindia.com 
Web site www.nikon.com

A Worthy Successor

This top-of-the-line phone from
Sony Ericsson is set to take

over the mantle from the older
T610. A brushed aluminium
finish lends a sleekness very few
phones have. It is elegant and
compact, and has a rich, vibrant
65K colour screen—the best we
have come across. Marketed as a
‘Dual front’—a reference to its
look—it has all the trappings of a
phone on one side, and looks like
a digital camera on the other.
The K700i is tri-band-enabled and
offers Bluetooth, IR, FM radio,
MMS support, and 40 polyphonic
ringtones along with a 4X digital
zoom VGA camera. The phone is
powered by a fast processor,
which is why it is fun working
with—something we found
lacking in the T610.

Company Sony Ericsson India
Price Rs 20,995
Phone 0124-2560808
E-mail dhiraj.soni@sonyericsson.com 
Web site www.sonyericsson.com

HP Scanjet 5590

Photo Finesse

The 5590 is all about superb performance and
splendid features for business houses. You

can scan photos at up to 2,400x2,400 dpi! This
beauty handles 50 sheets at a go. The scanner
gives you a Transparent Material Adapter to scan

large documents and transparencies. You can also convert 35mm
negatives into digital images. 

Company Hewlett Packard India ltd
Price Rs 34, 892
Phone 1600-114141
E-mail seema.dawar@hp.com 
Web site www.hp.com

Transcend JetFlash DSC 128 MB

Slightly larger than a standard thumb drive,
this USB flash drive integrates a digicam.

The body incorporates a small viewfinder, a
tiny lens and two status LEDs. A cap opens up
to reveal the USB connector. The device powers
on as you open the slider to reveal the lens.
The memory LED glows green if there is

available memory for additional images.
Image quality is quite ordinary, and the

lack of a flash can sometimes handicap.
Company Mediaman Infotech

Price Rs 5,000
Phone 022-23823100

Fax 022-23877418
E-mail sales@mediamangroup.com
Web site www.transcendusa.com

Atek Super Optical Mini Mouse

Calling all laptop users: the feather-light
Atek works on any surface. You can use it

on the palmrest of the laptop, too! The 50 gm
device works plug-and-play  with most
Windows versions, and comes with a three-
foot cord. It’s the size of the optical mouse
that will bowl you over—it fits perfectly well

between the index and middle
fingers.

Company J S Equipments
Price Rs 2,500
Phone 022-23810713
E-mail jse@vsnl.com 
Web site www.atek.com
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The Mini Revolution

The smaller sibling of the
popular iPod sports the same
set of features. Available in 5

colours, the iPod Mini measures
just 3.6 x 2.0 x 0.5 inches and
weighs just over 100 gms. A menu
button and playback options sit on
the scroll wheel itself and thus
enable a smooth, one-handed
operation. The Select button is placed
in the centre of the scroll wheel. The
contrast on the backlit 1.67-inch
greyscale screen is adjustable. There
are 22 preset equaliser settings to
choose from. With 25 minutes of skip-
protection, this iPod Jr plays audio in
the AAC (16 to 320 Kbps), MP3 (32 to
320 Kbps), MP3 VBR, Audible, AIFF,
Apple Lossless and WAV formats. And
of course, there are always songs to
purchase from the iTunes Music Store.
You can also view contacts, read text
files, play inbuilt games and use it as an alarm clock.

Use the bundled FireWire or USB 2.0 cables and iTunes software to
transfer music and other data. Also included are earphones, a power
adaptor and a belt clip. Audio quality is typical IPodesque; the output
classy even at maximum volume.

Transferring a GB of songs over USB 2.0 took us just 3 minutes and
27 seconds. The iPod Mini logged a battery life of 7 hours and 25
minutes, just 35 minutes short of its claimed battery life. This little
wonder is bound to be an audiophile’s favourite. It is also available in a
choice of colours, something that the bigger-size iPods are not.

Company Apple Computer International
Price Rs 19,500
Phone 080-25550575
E-mail indiainfo@asia.apple.com 
Web site www.apple.com

Apple iPod Mini

Freecom USBCard 16MB USB2.0

Hitachi Deskstar 7K400

Hitachi’s 7K400 hard drive offers a
staggering 400 GB of storage, which

promises to hold 45 hours of HDTV
broadcast, or 1,00,000 songs of 4 minutes
each, or thousands of e-books in the PDF
format, and lots more. 

It comprises five platters, 10 heads and a
solid 8 MB of buffer memory. But increased
mechanical movements though could result
in long term reliability issues. 

We got a SATA version of the drive and it
turned in good scores. The SiSoft Sandra test
showed its access time as six milliseconds—
quite impressive for a 400 GB drive. A GB of
file transfers across partitions logged an
average time of around a minute
for sequential and random
files. 

Company Cyberstar
Price Rs 25,000
Phone 011-26438216
E-mail anil@cyberstarin.net 
Web site www.hitachigst.com

PixelView PlayTV
Box3

This external TV-
tuner box

operates without a
PC. You can,
however, connect a

PC to the monitor via this box and switch
between TV programs and PC output. The
box also allows the picture in picture mode. 
Use its remote to power it on or off, as well
as play around with its volume, channels,
etc., the controls for which are also present
on the box itself.  

PlayTV’s output may not be as good as
the Pinnacle Pro card, but is decent enough
and allows full screen viewing (SXGA - 1280
x 1024 @ 75 Hz).

The kit comes with all the necessary
cables, a power adapter, and batteries for the
remote.   

Company Rashi Peripherals
Price Rs 5,400
Phone 022-28260258
E-mail ho@rptechindia.com
Web site www.prolink.com.tw

Data in the Wallet!
Wanna carry your data in the wallet? USBCard, the credit card-sized
USB storage device, does just that. It measures 85.5 x 54 x 3.9 mm and
weighs just 28 gm. The connector
works with Windows and Mac
machines. And for plug-and-play, it
doesn’t even ask for clumsy
drivers (with Win ME & above).
Data transfer is fast too—a 10
MB data transfer took just
17 seconds. Bundled soft-
ware includes Password
Lock, Auto Mail, Auto Run,
and Secure and Zip.

Company J.S Equipments
Price Rs 2,250
Phone 022-23810713
Fax 022-23860976
E-mail jse@vsnl.com 
Web site www.usbcard.com

Please write to products@thinkdigit.com. The DIgit Test Centre will be delighted to
respond to your queries.

Looking for more information on any of the products featured in New & Notable?

Compex UE202-B USB
Network Adapter

This tiny USB 1.1
adapter is for those

stuck with old laptops
equipped with defunct
LAN hardware, or without Ethernet ports. It
is also ideal for use with desktops that do
not have a network card installed. Although
it promises a speed of 100 Mbps, the USB 1.1
interface limits the throughput to just 
12 Mbps.
Company Rashi Peripherals
Price Rs 1,000
Phone 022-28260258
E-mail ho@rptechindia.com 
Web site www.compex.com.sg



Microsoft’s celebrated
and trusted
Windows XP OS is

vulnerable to security
threats. The operating
system has a huge number of
loopholes—and these chinks
invite a host of virus attacks. 

This is where Windows
XP Service Pack 2 (SP2) steps
in. SP2 is Microsoft’s attempt
at plugging this set of
loopholes—it is Microsoft’s
damage control effort at
fortifying XP’s defences. 

Here’s a walkthrough of
the installation and
configuration of SP2.

Installation
Installing SP2 can be tedious.
Depending on how often you
have been updating the OS,
you may have to install
anywhere between 80 and
270 MB of updates. 

If you are installing SP2
on a laptop, which is quite a
lengthy process, you had
better run your machine on
AC power.

Security Center
Once you have installed SP2,
you are asked to reboot,
following which a message
asks you if you want to turn
the Automatic Update on or
off. The Security Center
offers three options—

Firewall, Automatic Update
and Virus Protection. The
Virus Protection option is
displayed alongside the anti-
virus software already
installed on the system.
Similarly, if you have
installed a third-party
firewall, the Firewall option
shows alongside the
customary Windows
Firewall. 

Windows Firewall
The Internet Connection
Firewall (ICF) that came with
the earlier version of
Windows XP was inadequate,
and was disabled by default.
Consequently, a whopping
number of computers with
XP were paralysed by high
impact worms such as Sasser
and Nimda. With SP2, the
firewall is enabled by
default. The firewall’s
Stateful Packet Inspection
(SPI) feature monitors the
computer during booting. It
meticulously checks
incoming data packets
against requested outgoing
data packets. If the SPI
comes across a suspicious
data packet that does not
match the request criteria, it
simply rejects it. This tackles
malicious programs when
the system starts. Once the
OS initialises, the Windows

Firewall’s run-time policy
takes over.

However, the Windows
Firewall still isn’t as sturdy
as third-party solutions. Most
firewall solutions, available
for free on the Internet, are
much better equipped to
handle serious attacks. 

Internet Explorer
SP2 comes with a pop-up
blocker for IE. It’s in the
form of an info bar on top of
the page, and offers options
such as temporarily allowing
pop-ups. You can also
manage IE add-ons in SP2. It
comes as a special feature
that can be found in the
Tools menu. You can view
the add-ons currently
installed on the system,
enable or disable them, and
even update ActiveX control
for the plugins. 

Another option lets you
view disabled add-ons with
digital signatures from
unknown publishers.
However, one big hitch that
actually throws open the
system to possible virus
threats is that you can only
enable and disable add-ons
for IE, but no other browser.

Outlook Express
Outlook Express has always
been vulnerable to e-mails
with malicious attachments.
SP2 now makes Outlook
Express much safer. Now
Outlook Express will not
directly display images.
Instead, it asks you whether

you want to download the
images to view them.

A Final Word
With the current security
issues we all face, installing
SP2 is not really an option—it
is a necessity. Dial-up users
need not fret—Microsoft will
shortly start shipping a free
CD to all authorised
Windows users. You can also
get SP2 from the DVD and
the CD with this issue of
Digit.

Apart from security
patching, SP2 also includes
useful features such as
DirectX9.0b and Bluetooth
support, and an update for
Windows Media Player 9. 

It even has features that
ease out WiFi settings on
your machine. We can’t say
for sure whether SP2 will
stand the test of time, but it
is a step in the right
direction. 
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A Safer XPerience

Problem Areas

The following programs are
known to experience a loss
of functionality when they
run on a Windows XP
Service Pack 2-based com-
puter: Norton AntiVirus,
OmniPage Pro, Outpost
Firewall, ZoneAlarm, Yahoo!
Messenger, and Virtual PC.
For the complete list, visit
http://support.microsoft.c
om/default.aspx?kbid=884
1 3 0 & p r o d u c t = w i n -
dowsxpsp2

The virus protection tab displays information such as the name of
anti-virus software installed and its status

Digital Tools l New & Notable

Security Center comes up after installation, and you can manage various
settings from here



77SEPTEMBER 2004 DIGIT

It was time for
the yearly
ritual—where we
tell the
government that
we have paid our
taxes honestly.
While Robert
stayed put in his
rather over-sized
chair and
checked his
options to do so
on their Web site,
Garfield
travelled,
sneered, and
scurried like rat
from one office to
another. Here is
an account of
what happened:

Filing Tax Returns

I got the IT returns form (ITS 2E) from my HR
department. Time now to fill it. Looked around for
help. Found it in the form of a close relative—my
dad. It took a day to get the form filled. 

Time taken: 1 day and 10 minutes

I am not very comfortable with things that involve
the words ‘tax’, ‘bank’, ‘work’, etc. I found
FileReturn.com, and was immediately lost in all the
jargon—the bad design of the Web site didn’t help
either. Thankfully they had a phone number!

Time taken 30 minutes (mostly spent trying to make
sense of the site; we suggest you just call)

I realised I had to pay taxes this time. I needed a
challan. This too came via the same route as the
ITS 2E form.

Time taken: 1 day

I called them, told them I wanted everything done
for me. Two days later a representative showed up at
work. This thing works, then.

Time taken 3 days

The FileReturn.com representative asked me for my
Form 16. Gave me a ‘Saral’ form with two ‘X’s
marking the spots I had to sign. I also signed a
cheque for Rs 250, and was done. 

Time taken 15 minutes

I was told I would get the stamped form back in
two days time. Four days later I recieved it!

Time taken 4 days

The next day saw me at HDFC’s Nerul branch. The
staff prepared the challan in a little over 45
minutes.

Time taken : 30 minutes to travel, 45 minutes for the
challan, Travel cost: Rs 20

10:30 am Bandra-Kurla Complex: T-day! I walk into
building C-13 of the Income Tax Department,
Mumbai, and get my documents stamped. No long
lines, no delays—kudos to the Government of India
(or maybe I just got lucky today!)

Time taken : 45 minutes to travel, 2 minutes to
submit, Travel cost: Rs 50

The returns form and challan, that’s all you need Use the phone instead of the browser...

1

2

3

4

The old way is faster to get the stamped form in
your hands. However, the actual time spent on fil-

ing taxes is practically nil with the tech way. If it’s all
about laziness, tech way wins hands down. The prob-

lem is Robert learnt absolutely nothing about income
tax, while Garfield might actually be able to file his
returns without his father’s help next time. The old
way most definitely teaches you a lot more.

OLD
WAY

TECH
WAY

Total Time Spent: 2 days, 2 hours and
12 minutes
Total cost: Rs 70

Total Time Spent: 7 days and 45 minutes
Total cost: Rs 250

And 
The

Winner
Is...

Garfield D'Souza (garfield_dsouza@thinkdigit.com) Robert Sovereign-Smith (robert_smith@thinkdigit.com)
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AceMoney can also help you
achieve your budget goals, by set-
ting up budgets and transaction
categories. At the end of the
month, you get a break-up of your
expenditure, along with compar-
isons with those of the previous
months.  The software checks all
transactions for discrepancies
and reconciles them.

Notable alternatives
RentTracker Lite 3.22
Pegasus Capital 2.0

Spam Control
POPFile 0.21.1
POPFile integrates with your
existing mail setup and provides
Bayesian filtering. The filter
learns, in time,  what is spam and
what is not. Apart from marking

messages as ‘Spam’ and ‘Not
Spam,’ it can also be used to clas-
sify regular e-mail into folders
based on logic filters. POPFile has
an intuitive Web-based interface.
Additionally, there are other
third-party interfaces available to 
make POPFile even more user-
friendly. One such is OutClass,
available from http://www.vargon-
soft.com/OutClass/.

Notable alternatives
All-in-One Secretmaker 3.8.5
Ella for Spam Free 1.5.6.1

Personal Information 
Managers
Contact Plus Personal 2.7
Contact Plus Personal is a fea-
tured-packed organiser for all
your existing contacts. You can

Saurabh Kumar and Avinash Rai

sing trial versions of your
favourite software may
help get your job done,

but it is not always fun to see the
license for your e-mail client
expiring just when you need to
submit a monthly report. 

Hence, we decided to find out
the best available freeware for
most, if not all, of your day-to-day
computer tasks—from managing
finances to checking e-mail. 

To save you from having to
wade through hundreds of them,
we provide you the top con-
tenders in various categories.

OFFICE
Finance Management
AceMoney Lite 3.4.4
AceMoney helps you keep track of
where exactly you stand finan-
cially, and where your financial
details are headed. 

You can track your bill pay-
ments, even set reminders. There
is the option of filing all your
transactions under various trans-
action categories. This helps you
organise finances better, with
transactions neatly categorised. 

AceMoney also supports the
QIF and OFX file formats. So you
can directly download account
statements from your bank’s Web
site. It comes bundled with a loan
calculator and a mortgage
analyser. The reports are generat-
ed in bar and pie charts.

U

AceMoney can show you a calendar of your Bill payments for your reference

BEST
TOOLS

MUST-HAVE
Productivity software for a SoHo is a great idea.
Getting them at zero cost is even better

Digital Tools l Smart SoHo
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This free utility adds a program
item, ‘Control Panel,’ in the Start
menu, which is the list of all
blocked and allowed sites. Add or
remove any Web site in the
allowed or blocked sites lists. 

You need not open the Con-
trol Panel while surfing the net
as the application always runs in
the background. Whenever a
popup is about to come up, it
brings up a window asking
whether the popup be blocked or
permitted. By clicking on various
options in the window, a partic-
ular pop-up, or the site itself, can
be blocked to be opened. Howev-
er, this gets annoying—it pops up
its own windows very frequently,
but the functionality is impres-
sive. At installation time, it needs
an Internet connection, since it
needs to download a library file.

This utility will do the trick
for users who just need to get rid
of basic pop-ups, but those seek-
ing extra features and support
for Flash and banner ads will
have to look elsewhere—and
there are plenty of other choices.

Notable alternatives
Smart Popup Blocker 1.05
Video Ads Blocker 1.0b

HTTP to POP Utilities
YahooPOPs 0.6
If you are fed up of browsing to
your e-mail site and waiting for
the page to load, use YahooPOP
to make Yahoo! mail POP-based.
YahooPOP starts a local
POP/SMTP server wrapper for
Web mail so that your regular
POP client—MS Outlook, Eudora,
etc—can read and send Yahoo!
mail directly. This saves time and
allows you to use your client’s
advanced features such as receiv-
ing headers of large mails, delet-
ing mails from the server only if
deleted from Outlook, send
mails in groups, etc.

Notable alternatives
Pop Goes the Gmail (PGtGM) 0.9 
Hotmail Popper 3.0.2

Browsers
Opera 7.52 [ad-based]
Opera is low on resource require-
ments, and bundles loads of relat-
ed applications such as an e-mail
client, a newsgroup reader, an
address book, auto-form filler, pass-
word manager, presentation sys-
tem, etc. 

It boasts of one of the best pop-
up blocker engines, and an effi-
cient cache system that makes for
zippy page loading. Opera is
equipped for crashes and can
restore your browsing session if it

crashes, or if your machine
reboots. You also get the option to
save your session, allowing you to,
say, click on the mail session to
reopen all your Web mail Web sites
and log in to them with single
clicks. 

Also featured are mouse ges-
tures that help minimise time at
your keyboard, improving produc-
tivity. The zoom feature can actu-
ally zoom into images and fonts
without breaking the page for-
matting as some other browsers
tend to do.

Notable alternatives
Mozilla 1.6
Mozilla Firefox 0.9.11

E-mail Clients
IncrediMail Xe
IncrediMail allows you to com-
pose mails using new kinds of sta-
tionery and backgrounds.
IncrediMail supports skins and
most e-mailing features. It also
allows managing of an address
book and rules for particular
kinds of mail. In addition to all
this, the latest version has a spam
filter. This version also has
IMAP/POP3 emulator support.

Notable alternatives
Eudora 6.1
Pegasus Mail 4.12

keep track of communication
with your contacts, send e-mails,
schedule and track events, etc.

You can backtrack to commu-
nications of a year ago if you want
to. This software features ‘Quick
Pick’—a table of frequently-used
data for fields to help you fill
forms quickly.

Each contact can have four dif-
ferent event alarms, with a cus-
tomised ‘snooze’ time for
reminders such as meetings, etc.
Also provided is an ‘events’ screen
that displays all your events,
which can be filtered to display
only specific event types. 

The software also has a collec-
tion of templates for letters, faxes,
etc. There’s also an option to cre-
ate envelopes, complete with a
mail-merge provision! Groupwise

reports can be also be generated
and viewed onscreen or printed.

Notable alternative
The Literary Machine 2000

INTERNET
Instant Messengers
GAIM 0.77
GAIM is a multi-network Internet
messenger solution that allows
simultaneous logins on Yahoo!,
MSN, ICQ, AOL, Jabber, and even
IRC networks with a  single user-
name and password. Other fea-
tures include, light resource
requirements, plugins, typing
notification, Buddy Pounces, text
replacement, etc. 

Notable alternatives
Trillian 0.74 
Bassline WinPopUp Free Edition 5.27
Popup Blockers
Bayden PopupPopper 1.1

Opera is
well-
equipped to
combat
crashes. It
lets you
start surfing
from where
you left off
when the
crash
occured

Opera doubles up as a mail client and
a newsgroup reader as well

Configure YahooPOP to allow your
POP3 mail client to transparently
access your Yahoo! mail account

Use GAIM to seamlessly interact with
your friends on all IM networks
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mail server, but can also be
expanded with add-ons.  It also
supports SSL as well as ODBC
database connections, mail
rules, etc. 

It can alert the administrator
and restart critical services in
the event of a critical mail serv-
ice failure, to ensure reliability
and better uptime. The Finger
and Whois servers are also
included.

Notable alternatives
Mailtraq 2.0
Office Mail 1.1

Proxy Servers
602LAN Suite 2004
This mail server has anti-spam
and anti-virus support. 602LAN
Suite 2004 is available free for five
users, to use commercially and
non-commercially. 

This Windows-based soft-
ware has a fax server, firewall,
ICS and Bayesian spam filtering
as well. It can delete suspect e-
mails, or mark their headers so
you can look at them. During

setup, it installs Network
Address Translation (NAT) and
proxy services along with servic-
es such as Web services and user
account handling. A few things
need improvement though like
GUI  administration and sepa-
rate anti-virus support, but 
the spam filtering and connec-
tion-sharing facilities make it 
a decent try.

Notable alternatives
FreeProxy 3.6
SOHOConnection 2.1

SYSTEM
Anti-virus
Avast 4.1
The Professional edition provides
enhanced protection from
threats coming over IMAP, ICQ
and mIRC. The Home edition has
an on-demand scanner with Stan-
dard Shield, and an embedded e-
mail scanner. This makes for
protection from threats when
opening or using any applica-
tion, e-mail or documents. It also

Download Managers
FlashGet 1.6a [ad-based]
FlashGet downloads large files
from the Internet. Apart from
resuming broken downloads, it
also boosts download speeds:
FlashGet splits files into chunks,
and downloads them from mul-
tiple servers in parallel.

FlashGet has an organised
interface, can be scheduled to
download at specific times of the
day or week, can turn off your PC
after downloading, and can limit
downloads to a specified speed,
especially if your office admin

does not like downloads to move
too fast.

Notable alternatives
Getleft 1.1.2
Download Wonder 1.55

Mail Servers
IMail Express 8.0
IMail Express comes with Web
mail access, and anti-spam and
anti-virus scanning capabilities.
It has the basic requirements of a

Apart from
resuming
broken
downloads
FlashGet
also boosts
download
speeds
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malware was wrongly identi-
fied. You can configure theIE-
resident utility to stop malware
in its tracks  automatically, to
inform you before blocking it,
or to ask permission to block it. 
It can also clean up the lists of
last-visited Web sites, opened
files, cookies, etc. SpyBot sup-
ports IE, Netscape Communica-
tor and Opera.

Notable alternatives
Free Spyware Scanner
Bazooka Adware and Spyware
Scanner 1.12

Compression
ZipGenius 5.5.1.400
ZipGenius supports scanner and
digicam file formats as well—it
imports pictures to compress
from a scanner. It also supports
local (proxy) networks as well as
Star Office and Openoffice.org.
A broad range of expression for-
mats are supported. While it
works, it does anti-virus checks,
and does everything that most
compression software do. But it
also supports XX, UU and
MIME/Base 64 encoding as a
unique feature. It has a backup
command that automatically
creates a compressed archive of
a selected folder. ZipGenius is
good for administrators too, as
it supports unattended setup.

Notable alternatives
UHA
7-Zip 3.1 pop

MULTIMEDIA
Audio Players
Winamp 5.03
Winamp is one of the best and
most capable audio players
around, with a stable core and a
very usable interface that can be
changed using any of the
hundreds of skins available. 

Winamp supports a wide
variety of plugins that help fill
in any missing functionality
easily. This includes things such

as new audio formats as well. 
Winamp allows you to

stream music over a network
and set up an audio radio. The
latest version comes with file
management (Media Library),
ID3 tag editing, AAC encoding,
CD-burning and more. Winamp
now supports skins of both
version 2 and 3.

Notable alternatives
Quintessential Player 4.5
Musicmatch Jukebox Basic 8.2

Video Players
Fresh View 2.6
Fresh View is a multimedia file
organiser. It can be used to create
albums of image files, etc. Images
can only be saved in the BMP, GIF
and JPEG formats, but it supports
more than 80 multimedia formats
such as PNG, TIFF, MIDI, MP3, AVI,
etc. It allows you to create HTML
albums, to view pictures as slide
shows. You can print images using
toolbar buttons. Fresh View is easy
to use, and pop-up tool tips are
helpful.  This file organiser does
not have a batch-renaming facili-
ty, however you can rename files
from the albums, which is not a
difficult thing to do. Overall, Fresh
View does justice to its job and can
be termed as a good multimedia
organiser.

Notable alternative
Fox Media Center 1.0

Music File Converter
Easylame
Easylame is considered as the
best encoder to convert files
from the .wav to the .mp3 for-
mat. This tool provides you with
lots of options that can be cus-
tomised. It comes with drag-and-
drop functionality and has a
friendly interface.

Notable alternative
MP3 Organizer

Media Cataloguing
Whereisit
Whereisit is a media catalogue
generator that keeps track of
files and media on your disk.
Managing media files using
Whereisit is a happy experi-
ence—it works flawlessly. The
best part is it does not bundle
along any malware.

saurabh_kumar@thinkdigit.com
avinash_rai@thinkdigit.com

includes a screen-saver mode
scanner that scans your PC in the
background. Virus definitions
can either be scheduled, or down-
loaded manually. 

Notable alternatives
AVG 6 Free Edition
Vcatch Basic 5.0.20.2 [Bargain
Buddy installed]

Firewalls
ZoneAlarm 4.5.594.000
ZoneAlarm is a good out-of-the-
box firewall for people who

understand the need for network
security, yet are hesitant to con-
figure a full-fledged firewall.
ZoneAlarm is easy to deploy, and
can be tweaked for better con-
trol. It offers an easy-to-use inter-
face, a visual tutorial and good
help features. It detects a new
network connection  automati-
cally and assigns user-defined
security levels. 

Notable alternatives
Sygate Personal Firewall
AlertWall Personal Firewall

Anti Spyware
SpyBot 1.3
This new version of SpyBot 1.3 is
even more user-friendly and use-
ful. Notable among its features
is its huge comprehensive data-
base of adware. SpyBot 1.3 dis-
plays spyware and adware
search results in an tree format
that can  even be understood by
a novice user. Before starting a
search on your hard drive for
malware, SpyBot performs a
backup of the registry. A revert
option lets you rollback if any

You can
schedule
ZoneAlarm
to access the
Internet (in
a controlled
manner)
after office
hours

Winamp 5 supports both Winamp 3
and 5 skins, apart from other great
features

ZoneAlarm ensures that only known
and wanted applications access the
Internet services
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Display My TV

Our educational institution wants to use 29-
inch TVs as an output device instead of

monitors. What computer configuration do we
need for that purpose? We use a Pentium 4 2.4
GHz , an Intel GVSR original motherboard, 128 MB
DDR RAM with a 40 GB hard disk, and need
output to both TV and monitor.

AGS

The hardware configuration that your
institution currently uses is just perfect.

However, you will need to install a display card
with TV-out capability. Doing so will help you
connect the computer to the TV. Since your
motherboard does not have an AGP slot, you
need to find a PCI display card with a TV-out
connector. You can either use an S-Video cable,
or a composite cable (if the video card
supports it) to connect the TV.  

Drained Batteries

I have a Pentium III 733 MHz, a 20 GB hard
drive and 128 MB of RAM. For the past one

year, my motherboard’s battery has been drain-
ing swiftly. I have to correct the system clock
every time I reboot. A couple of months back, the
computer refused to boot as well. If I change the
battery, everything starts working normally
again, including the clock. Does a computer
refuse to boot if the battery is completely dead?
If yes, why does this happen, and is there some-
thing wrong with my motherboard?

Tejendra Nanabhai Pathare

It is unusual for a battery to drain so
quickly. Also, your computer should boot,

regardless of whether the battery is dead or
not. Your motherboard seems to have a prob-
lem, and you will need to contact your hard-
ware vendor to solve this.

Missing Floppy Drive

I run Windows 2000 Professional. Recently,
my floppy drive stopped showing up in My

Computer. All the other drives display correctly.
Under Floppy disk controllers, in the Computer
Management console, it says that the drive is
working properly. What is the problem? 

Amit

The BIOS doesn’t seem to detect your
floppy drive. Check the CMOS settings

and see if the floppy drive is visible. Ensure
that the CMOS is set to ‘Halt on all errors’ and
also check that the BIOS ‘Report the floppy
drive to the OS’ setting is enabled.

Another reason could be drive letter
conflicts caused by software such as RAMdisk.
TweakUI from PowerToys, which is available
from the Microsoft Web site, can also cause
drive letters to be hidden in Windows Explorer
and My Computer. If you have it installed, go
to Start > Settings > Control Panel and double-
click on TweakUI. In the My Computer tab,
select the checkboxes of the drives that are
shown as hidden. Click Close, and restart your
computer.

Sharing The Link 

I am an IIT Bombay student. We access the
Internet via a LAN from our rooms. The

problem is, my room has only one LAN socket,
but we have two computers in the same room,
and want to connect both. How can we allow both
to connect to the network using the single LAN
socket? What hardware and software do we
need? Also, this needs to be a solution for both
Linux and Windows.

Vamsi Krishna

The simplest solution is to buy a four-port
hub, and connect that to your LAN socket.

You can then connect up to four computers to
that one LAN socket. A four-port hub costs
around Rs 800.

Adobe Incompatibility

I
The Digit CD with archived content asks for

Adobe Reader 6. I tried installing it from
your CD, but I get an error saying the OS is not
compatible. I run Windows 98 First Edition. Why
is this so?

Dr Girish
Adobe Reader 6, and above, are not
compatible with Windows 98 First Edition.

All you can do is either upgrade to Windows 98
SE or install Adobe Acrobat Reader 5. This

E-mail us your 
computing problems,
and we may answer
them here! Since we get
more mails per day than
we can handle, it may
take some time for your
query to be answered.
Rest assured, we are 
listening!

sos@jasubhai.com

Adobe Reader 6 requires Windows 98SE  and later OSes
to work

The TV-Radio button is
highlighted once you
connect the TV to the
graphics card

Your Questions, Our Answers



previous version lets you view PDF files, but
you will not be able to use advanced features,
such as the search capability. 

Undelete My Data

How can I retrieve files that have been
deleted from the Recycle Bin, and how can I

find the current date using DOS commands?
Kripal Singh

Irrespective of the Windows flavour you
use, files deleted from the Recycle Bin are

irrecoverable. This is because Windows does
not bundle a utility to do so. MS-DOS had 
an ‘undelete’ command up to version 6.22,
and the command line tools in Windows
98SE, but this was discontinued in Windows
XP. You will need to use a third-party tool,
such as R-Studio, Ontrack EasyRecovery or Get
Data Back, which will let you recover data 

from your hard drive even if you format it
accidentally. 

To view the date in DOS, just type ‘date’
and press [Enter].

Need For Speed!

I have a Pentium III 600 MHz, 128 MB RAM and
an Intel 82815 graphics controller, running
Windows 98SE. I wanted to play Halo, but the
game gave me an error that says, “Hardware
acceleration may be disabled, run dxdiag.” Also,
when I try to run Need for Speed: Underground,
I get an error that says, “This program has
caused an illegal operation and will be shut
down.” What do I do?

Arshad

You will face such problems when you 
try to run newer games. This is because

your onboard graphics controller cannot
support the game that you intend playing.
The minimum system requirements for Halo
are at least a Pentium III 733 MHz processor,
128 MB RAM and a 32 MB video card that
supports Hardware Transformation and
Lighting. So you need at least an nVidia
GeForce2 or an ATi Radeon 9200SE. You will
need to upgrade to be able to play most new
generation games.

Mole In Internet Explorer

I run Windows XP Home Edition, and my e-
mail client and Internet Explorer display an

unknown Web page as default. Though I set IE’s
start page as ‘blank’, the unknown page still
shows up. I even reinstalled IE, but to no avail. It
is annoying me no end.

Swarup Mondal

Looks like you have spyware on your
computer. The best solution is to install

anti-spyware tools such as SpyBot or Ad-
Aware, and scan your entire system with
them. These software check and prompt you
to remove all spyware applications present on
your hard drive. This should solve your prob-
lem, and also prevent future applications
from installing.
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20 Questions?

I have an Intel Celeron 1.7 GHz CPU, 128 MB RAM and an Intel
845G motherboard, running Windows XP Home.

I have a few questions:
Are refilled cartridges hazardous for printers? What do I use to clean
the rollers? What paper should I use to avoid paper jams? Can you
give me some buying tips on how to choose the right CD-R? I have a
GTA 4 anti-CD check crack, how do I use it? How can I run PlayStation
CDs on my computer? What software do I use to get DVDs to run on
my machine?

Ishan Raut Desai

Now that’s a lot of questions! Let’s take them one at a time:
Yes, refilled cartridges sometimes leak, which may damage

your printer, and also give poorer quality printouts.
You can use alcohol to clean the rollers of the printer. This is a

generic solution. You may want to consult your printer’s user
manual to check the exact type of liquid that you can use to clean
the rollers.

Regarding the type of paper, choose any good quality printing
paper as long as it is not translucent or too thick. Bond paper is
the best type of printing paper but may be expensive in the long
run. The paper thickness is not an issue as bond paper is the
normal recommended paper type for all printers.

Original game CDs are copy-protected, and thus cannot be
replicated using software such as Nero Burning ROM. Copying
game CDs is illegal! If this problems occurs even when burning a
new compilation, or copying CDs that aren’t copy-protected, your
CD-Writer might be faulty. Send it to the manufacturer’s service
centre for repairs.

Using no-CD check cracks is illegal. We suggest you buy your
own CD.

You can run PS1 and PS2 game CDs on your computer using
emulators such as Bleem!. Make sure you own the 
original PlayStation CDs, or you will be heading into illegal terri-
tory here again.

DVDs only play on a DVD ROM drive. Since, you have not
mentioned what drive you have, we will suppose it’s a DVD ROM
drive, and that you are asking about DVD movies. Install software
such as Power DVD or Win DVD to watch DVD movies on your
computer. Data DVDs can be accessed using Windows Explorer.

Question 

of the

Month
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How to...

Share one computer among multiple users

Solutions that share a PC between
multiple users help SOHOs utilise
their PCs to maximise productivity

as well as cut IT-infrastructure costs.
Call centres, hospitals, educational
centres, etc also find it useful. You may
employ it to share your home PC with
your children.

We used one such solution-+ONE PC-
that uses the time-slicing technique to
share a PC. Its pack contains a PCI
display card, a connector box, a soft-
ware CD, a 15 feet long SVGA cable and a
USB extension cable.

+ONE PC provides a computer with
three extra I/O connections-keyboard,
mouse and monitor-that use the
resources of the host PC. Users can do
light tasks such as surfing, playing small
games and such. The host can instantly
see changes made to its disk by the
workstation.

Up to five users can share one PC
using this solution. Their speed depends
upon the configuration of the host PC.

System requirements
The host PC should have approximately
128 MB of RAM per user. This means that
you need to have at least 256MB of RAM
installed if you want to share the PC
among two users. The OS should be either
Windows 2000 or XP. The host PC

requires at least a Pentium III 500 MHZ
processor. Enhancing the system configu-
ration of the host PC improves the
performance of the workstations. 

Installation
Shut down and switch off the host PC.
Open the cabinet and install the bundled
PCI display card. Connect one end of the
SVGA extension cable to this card, and the
second monitor to the other. Connect the
second set of PS/2 keyboard and mouse
to the bundled junction box. The box, in
turn connects to the USB port of the host
PC. 

Next, power on the PC and press [Del]
to enter the BIOS. Select the ‘Integrated
Peripherals’ or ‘BIOS features Setup’

menu, locate the ‘Init Display First’ or
‘VGA- Boot-From’ option., set it to ‘AGP’ or
‘AGP/onboard’, press [F10] to save your
changes, and then restart the computer.
The PC detects the new display card as ATI
128 Rage series and installs it automati-
cally. Disable Power Management since
+ONE PC doesn’t support it. To do so,
right-click on the desktop, select
Properties, switch to the Screen Saver tab
and click the ‘Power… ‘ button. Set all the
fields in the selected power scheme
settings to ‘Never’.

Next, run the Setup file from the
bundled software CD according to the
type of processor that you have installed -
with or without Hyper-threading - and
install the necessary software. Select
password protection and network admin-
istrative control options as and when they
appear during the setup. Click OK to
restart the PC when setup is finished.
That’s it, you’re through!

Configuration
If the first boot brings up the logon screen
on the workstation monitor too, then the
workstation is configured properly.
Initially, you may face some keyboard
problems-both keyboards may work for
the workstation only. However, the solu-
tion to this is simple: double-click the
+ONE PC icon in the system tray and set
the first keyboard for the Host PC. You
will also see the Network Multiuser
Settings window there. In its left panel,
navigate to MMuullttiiuusseerr  SSeettttiinnggss  >>  LLooccaall
SSeettttiinnggss  >>  DDeevviiccee  AAssssiiggnnmmeennttss  >>  KKeeyybbooaarrdd
aanndd  MMiiccee. You will see two mice and
keyboards configured in the right panel of
the window; double-click ‘Keyboard #01’.

In the properties window, go to the
‘Keyboard Recognition via LED-Blinking’
tab, and click on the ‘Start LED-Blinking’
button. This sets the lock LEDs blinking
to help you identify the keyboard
connected to Keyboard #01. You can also
press a few keys to see the progress bar
going up on the data received from the
keyboard connected to the host PC. If
the keyboard indeed is the right one, flip
back to the General tab, select ‘Station
to Main Console,’ and click OK. Now, you
can use both the host and workstation
PCs at the same time. 

You can also use the Network
Multiuser Settings window to monitor
processes or applications. Go to
MMuullttiiuusseerr  SSeettttiinnggss  >>  LLooccaall  SSeettttiinnggss  >>
SSttaattiioonnss  >>  SSttaattiioonn  22. Four tabs-
Application loaded, Information, Station
Infos and Video Settings-appear in the
right panel. The first tab shows you 

real-time information of all the running
processes on the workstation. The
Information tab displays general infor-
mation about the workstation. The
Station Infos tab lets you know the
station name, which is changeable. It
also shows up some configurations for
the workstation, which you can define.
The Video Settings tab helps you change
the resolution and refresh rate of the
workstation.

However, the system disappoints in
the security department. The worksta-
tion user can delete or uninstall any
software without as much as a warning
being issued to the host. He can also
shut down the host PC. 

In Sum
+ONE PC, along with the other solutions
mentioned alongside, help you harness
the spare power of a single PC to run
multiple workstations. These are very
cost-effective, especially in the scenarios
we have mentioned. We’ve reviewed only
+ONE PC here, but the others too do their
job quite well. They are bound to bring
about a tremendous reduction in your
infrastructure bills.

Price Rs 6000 plus taxes (For 2 user 
set up)
Contact Adline Systems
Phone 011-25720911
E-mail adline@del6.vsnl.net.in
Website www.adlinesystems.com

Jetway N2view TwinMagic
Motherboard
Contact: Anirox Technologies
(Phone: 022-28655282)

IOGear ShareView
Contact: J.S. Equipments (Phone:
022-23810713)

Similar Solutions

+ONE PC set up for two users

The Network Multiuser Settings lets you
monitor processes and applications
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SD Versus DDR

I have a Celeron 1.7 GHz processor, a VIA
motherboard and 128 MB SD RAM. I want to

upgrade my RAM and have four slots on my
motherboard—two DDR and two SD slots. Will I
be able to use DDR and SD memory simultane-
ously, and just add 128 MB DDR RAM to my
computer?

Gagan Cheema

Unfortunately, you cannot. You can
choose to run your system either on DDR

or SD RAM, but the two will not run simulta-
neously. We suggest you sell the SD RAM to
your vendor, and buy 256 MB of DDR memory.
As of now, SD RAM costs more than DDR RAM,
because the former has been discontinued.

The Death Of A CD-ROM

I have a Celeron 266 MHz processor with a
20 GB hard drive and 64 MB RAM. I bought

a Samsung 52X CD-ROM about two years ago.
Last month it suddenly started acting up and
refused to detect re-writable CDs. After many
tries, it detected the CD-RW as an audio CD, and
now treats all CD-RWs as audio CDs. What’s
wrong?

Rakshit Desai

Your CD-ROM drive is on its last legs. You
can try a lens cleaner to make sure this

isn’t caused by a dirty lens. If the lens cleaner
doesn’t solve the problem, you will have to
buy a new drive.  

Beat The Heat

I have a Pentium III 1.0 GHz, a Mercury 815e
motherboard, an 80 GB hard drive and 150

MB of SD RAM. The problem is that my heat sink
gets really hot, and as a result, the PC hangs or
restarts. The CPU fan is working fine, but the
BIOS setting doesn’t show its RPM. I have another
case fan, and the BIOS reports its speed. Is there
a problem with my motherboard?

Abhay

In order to find the culprit, you need to
make sure that the CPU fan is working

correctly. Open your cabinet and make sure
the fan rotates easily. Make sure the heat sink
and fan blades are free from dust. 

You can use a paint brush to clean both. If
necessary, remove the fan and heat sink, clean
them thoroughly, and apply thermal paste
again and fix them back on to the CPU. 

To make sure that it’s a heating problem,
you can try running the CPU with the same
heat sink and fan on another motherboard.

Another factor, due to which the BIOS may
not be reporting the RPM speed of the CPU fan
correctly, could be that the CPU fan cable is
not connected to the proper connector on the
motherboard. You may want to check that. 

If all is in order and you still have an issue,

you will have to opt for an external CPU fan
kit which will lighten your wallet by Rs 600. 

We Have A Spy In Our Midst

Whenever I log onto the Internet, my
computer gets infected with viruses. I use

AVG as my anti-virus, but it seems to be of no use.
I run Windows XP with Service Pack 1. My virus
definitions are always up-to-date. While scanning
my computer with spybot , it says, “There is a
security hole in your computer which allows
unauthorised material to pass on to your
computer without your knowledge.” What do I do? 

Akash

Your problem stems from a
Trojan or spyware that has

been installed. What you can do
is run SpyBot and make it
remove the spyware. Download
and install the latest Windows
and anti-virus updates. This will
ensure that your computer stays
safe all the time. Also turn on the
inbuilt Windows Firewall. Turn to
Page 56 for more instructions on
securing your Windows XP PC in 30
minutes.

Carbon Copies

I brought my friend’s hard drive over to copy
some data to my system. After I was done,

that hard disk developed problems. My friend
says some system files are missing. I formatted
the hard drive, and now want to copy all the soft-
ware that is on my drive to his. I do not have any
software CDs though. Is there a way to copy
everything, as it is on my drive, to his drive-
including the OS?

Shaik Basha

It’s possible, but it won’t work because
your friend will have a different hard-

ware configuration. If by some miracle, you
both have exactly, and we mean EXACTLY the
same configuration, you can use utilities
such as Norton Ghost or DriveImage to make
an image file (exact copy) of your hard drive
on to your friends. 

Illustrations M
ahesh

B
enkar

Norton Ghost creates an exact copy of your hard drive
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hundred rupees apiece as the business grows.
There are other perks such as sending SMS
messages from the mail account and also a
large address book that holds 2,500 entries. All
this comes for a little under Rs 1,500.

Yahoo!, on the other hand, provides only
25 MB storage per account, and all the facilities
that Rediff provides. Other than that, they offer
200 blocked addresses, 50 filters and Yahoo!’s
trademarked Bayesian spam filters. Additionally,
they have waived the $25 setup fee that they
usually charge for new accounts. That brings the
cost down to around $9.95, or around Rs 460.

Indiatimes Meramail features Personalised e-
mail IDs, 6 e-mail addresses, 1,200 MB e-mail and
6 GB briefcase space, for a little under Rs 1,500.

All this comes at a price that most busi-
nesses can well afford!

However, all this has a sizable downside. As
Abbas says, the problem with services such as
Rediff, Yahoo! or Indiatimes is that their setup is
rather rigid. For starters, Web sites hosted on
their servers have problems with language and
platform support. They mostly run on Microsoft
products, so they generally lack support for PHP
or MySQL. This makes Web site maintenance
cumbersome, and the number of choices drops
significantly. On the other hand, if only the e-

mail service is subscribed to, the cost is slightly
on the high side. Sharma says that bandwidth
for outsourced e-mail management is a definite
issue, so is spam. Neither Yahoo! nor Rediff were
available for comment.

Yahoo!’s Web hosting and Business Mail solu-
tions are controlled from the US, according to
Yahoo! India. That necessarily means the
payment has to be made in US dollars and the
customer support is also undertaken by US
offices. These are issues that would concern an
entrepreneur looking to outsource e-mail needs. 

On The Other Hand
It is in fact possible to get the same functional-
ity at even lower prices if you have your own
business and can spare some time to learn a
little bit about Domain Name Servers (DNS). It
is possible to actually use your free e-mail
account to receive mails sent at your official e-
mail id (See box above, “How to Set Up Professional
Looking e-mail IDs”). All you need is a little tweak-
ing, and you can bind your e-mail with your
domain name and make it look like it is
coming from the company mail server.

Setting up a system of this sort means that
a lot of the traffic is dependent on free serv-
ices such as NoIP or ZoneEdit. Which means
you are at the mercy of the vagaries of the
Internet economy. 

Solutions to Swim In!
Most SMEs however, go in for an in-house server
for internal e-mail and an outsourced service
for external ones. Setting up mail servers,
setting up mailboxes, calling up people to ask
them to set up your mailboxes for you, it is
hard not to be bewildered by so much choice.
This is easily managed by keeping in mind the
end-point of investing the time and the money.
It is ultimately based on the kind of require-
ment that confronts the company. Choices are
choices, but they can only become solutions if
chosen judiciously. 

suprotip_ghosh@thinkdigit.com

With basic knowledge of DNS and how it
works, it is actually possible to set up

a free e-mail account and get your mails
delivered as if it was from a professionally
managed server. Here’s how:

First, set up an e-mail account with any
free e-mail server, say, yourname@rediff-
mail.com. Or if you have bought an inter-
net connection from you ISP, you can use
the e-mail account of your ISP (yourname
@vsnl.net, etc.)

Set up your own Web site, in one of
many free hosting services 

Buy your own domain name (www.
mycompany.com). Indicative prices are
given below.

If the provider you bought your domain
from supports DNS (refer to box: DNSing
in the dark), configure it to point to your
Web site already hosted in the hosting
service. Else, use a free DNS service such
as ZoneEdit (www.zoneedit.com) or no-IP
(www.no-ip.com)

Using ZoneEdit as the example, in the
control panel, enter the name of the e-mail
account you need to have as an official e-

mail account, viz., mail@mycompany.com,
and use ZoneEdit’s redirection service to
redirect all mail sent to this address to
your free account
(yourname@rediffmail.com or your-
name@vsnl.net, etc.)

You can use Outlook, Outlook Express
or Netscape mail to send mail. Just use
the outgoing mail server name such as
smtp.vsnl.net as your outgoing mail
server. If you have a leased line or ISDN
at office, it is easier to send and receive
the 10 MB attachments that can be 

sent from most e-mail accounts
these days

Any e-mail your business associ-
ates will receive from your free
account will appear to come from
mail @mycompany.com, thus
imparting a professional look to your
business

How To Set Up A ‘Professional Looking’ E-mail Service

We are not aware
of outsourcing
options, especially
to bigger service
providers such as
Yahoo! or Rediff.
However, free
mailboxes are out
of question in our
line of business;
security is impor-
tant to us.
Kuldeep Sharma
Cravitex Ltd
Mumbai

US$
74.90 for
10 years

8.95
11

Company name
NameSecure

WebLinkIndia
GoDaddy
Net4Domains

Location

US
India
US
India

Website name
http://www.namesecure.com/en_US/index.jhtml?cat=
null&subCat=null
http://www.weblinkindia.net/web-hosting/index.htm
http://www.godaddy.com/gdshop/default.asp
http://www.net4domains.com/

INR
3,445

445
412
500

Prices/Year

Names such as “ThinkDigit.com” are easy for
people to remember, but computers do not

understand them. They use names called IP
addresses to refer to one another instead. For
instance, you may type in ‘www.thinkdigit.com’
into your browser, but your computer connects
to ‘130.94.75.250’. Every time a domain name is
used, your computer accesses the domain name
servers (DNS) on the Internet to translate the
‘domain name’ into the machine-readable IP
address. During a single day of browsing and e-
mailing, your computer might access the
domain name servers hundreds of times.

DNSing in the dark
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he communication revolution has
changed the way we use phones. Gone
are the days when we hesitated to make

national or international calls. For an organi-
sation, it is even more imperative to be in
touch with employees as well as clients. 

And so, when calls are made even to check
whether someone is present within the compa-
ny, or one makes STD and ISD calls in the day-
time, the meter ticks away furiously. 

Hence many organisations use an STD/ISD
lock or disallow personal calls. But what do you
do when constant calling is inevitable? 

The initial euphoria over dial-up connec-
tions and the overdependence on MTNL is
slowly dying. Companies and individuals are

discovering alternative, cost-effective ways of
staying connected. Voice over Internet Protocol
telephony (VoIP) and Closed User Groups
(CUGs) are two such. And in this case, a co-oper-
ative bank shows that, when it comes to using
technology or its services, it need not be an
order issued from a higher authority.

About Shamrao Vithal Co-op Bank
Shamrao Vithal Co-operative (SVC) Bank, orig-
inally registered as a Co-operative Credit Soci-
ety in 1906, is a leader in its segment with
deposits of Rs 1,449.30 crore. With nearly
92,000 account holders, it operates from 42
locations in Maharashtra, Karnataka, Mumbai
and Goa. 

Their activities include fixed deposits, sav-
ings bank deposits, cumulative deposits, cash
credit loan systems, and cash certificates. Two
years ago, they deployed a distributed core-
banking application on their intranet and
linked all 38 branches and the four extension
counters. 

The application—a departure from the
standard centralised deployment form-came
in for a lot of flak from industry analysts. 

As a major player in the increasingly com-
petitive Indian banking sector, SVC Bank, like
all other banks, was facing increasing compe-
tition from private and multinational banks.

Technology-led Growth
Faced with a slowdown in profits due to
declining lending rates and a lack of growth
in deposits, SVC’s target was to accelerate
growth while minimising costs. There was
also a need to expand customer base. 

As a core thrust area, the bank identified
extensive service automation as a possible
route. Says Ravi Kiran Mankikar, Chief, Infor-
mation Technology, SVC Bank, “The speed of
delivery of financial transactions is critical to
any bank’s operations. 

That needs authorisation and constant
communication between the head office and
branches. Speedy decisions need instantaneous
communicationthat has to be reliable, secure
and authenticated. Earlier, decision makers
communicated via e-mail, telephone, fax, and
through instant messaging. However, this
entailed significant costs that needed to be
reduced.”

This aside, SVC intended to integrate seam-
lessly with its core-banking application, which
follows a distributive deployment instead of
the standard centralised form of implementa-
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Co-op Bank saved
Rs 25 lakh by
switching over to
VoIP. This is the
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happened

T

Squash Your
Phone Bills

Case Study

Im
ag

in
g 

Pa
ra

g 
Jo

sh
i, 

Ph
ot

o 
M

ex
y 

Xa
vi

er

108Business 
E-mail Options102



geted at ironing out kinks in the decision-mak-
ing and authorisation process without having
to rely on conventional correspondence modes
such as e-mail and fax. However, non-written
modes of official transaction tend to be prob-
lematic, as questions of confidentiality come
into the picture. 

For example, you need to authenticate a
transaction request to the head office and
authorisations for branch offices. An e-mail-
based system accomplishes this via digital sig-
natures. This can not be achieved through an
STD call. VoIP phones however, says Mankikar,
can also be used as a locator for employees in
responsible positions.

It Takes Time To Deploy And Train 
It took three months to deploy the system and
another three months to train employees. The
training did not coincide with the deployment
process and took place independently. Wipro
set up all the hardware, the sleek call manager
and the Cisco IP7940 phones included. The call
managers and the servers reside in a glass
room cooled by intelligent air-conditioning
systems. VoIP is just a component for internal
corporate communications for SVC bank. IP
telephony is supplemented by the Microsoft
Exchange server. 

Apart from handling e-mail and other cor-
respondence, it is also integrated with the call
manager, which monitors the various links
among the branches and remote offices. If a
link is down, it sends e-mails to the concerned
authorities in the office and SMSes others. 

These e-mails and SMSes are then used to
monitor intranet activity for the entire back-
bone. The records, in the form of e-mails, can
also be used to cross-check event logs prepared
by HCL Comnet, the company that maintains
the data network. The same call manager also
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tion. All this was planned keeping the
crossover to the paperless office in mind.”

And How They Found A Solution
SVC Bank has a total of 38 branch offices and
four extension counters. Of these, 26 are in
Mumbai, five in the rest of Maharashtra, 10 in
Karnataka and one in Panjim, Goa. A Unicen-
ter Service Desk Network was set up to replace
the help desk to assist users with IT-related
issues. This solution from Computer Associates
morphed the conventional ‘help desk’ into an
all-encompassing operational support group.
Accordingly, a broadband backbone, compris-
ing leased lines and ISDN, interconnected all
42 locations. 

Existing and upgraded connections were
used from DoT and MTNL. As the next step, all
the ATMs were connected together using this
dedicated link. Last, a major step was taken in
the implementation of VoIP telephony.

The interconnecting VoIP network took
three months to build. Now, for the past 18
months, most official communication is done
using IP phones. These were deployed keeping
in mind the infrastructural cost overhead as
well as utilisation of available resources.

The deployment of VoIP, says Mankikar,
was primarily targeted at significantly decreas-
ing communication costs. Official communi-
cation via the standard phone, fax and e-mail
proved costly, while on the other hand, there
was a considerable amount of idle bandwidth
on the 64 Kbps intranet data network.  

Moving to VoIP meant efficient resource
utilisation, while ensuring that telecommuni-
cations costs cut down significantly. This could
have entailed complications with MTNL; how-

ever, the unified net-
work approval took
care of that.

Setting up a VoIP
network does incur
costs. But the benefits
more than compen-
sate for the expense.
SVC Bank, for
instance, shaved Rs 25
lakh off its communi-
cations bill.

You can trim such
expenditure by using
the existing data net-
work for voice data
transfers via VoIP,
simultaneously ensur-
ing reliability and
security. Having voice
and data on the same
network also means it
is fit to be used for
branch transactions.
Firewalls and IDS pro-
tect the intranet. This
aside, the data net-
work is separate from
the existing network.

The implementa-
tion of VoIP was tar-

Investments
VoIP telecommunications hardware and
software
IP phone sets or soft phones
Network upgrades for possible quality of service
and performance upgrades
Implementation labour and professional services
On-going support and administration labour
Support and maintenance contracts
Increased support calls and potential user
downtime losses on initial deployment
IT Training
User Training
Write-off, write-down and disposal costs for
existing telecommunication assets

Risk Potential
Quality of service/performance
User training and adoption
Administration and support skill levels and
resources 
Proprietary vs. open systems interoperability

Source
http://searchcio.techtarget.com/ateQuestionNR
esponse/0,289625,sid19_cid558148_tax292624,0
0.html

Where Will You Incur Costs

Implementation
of VoIP is not as
important as the
fact that it works
well”
Ravi Kiran Mankikar
Chief, Information
Technology, SVC Bank

VoIP converts voice signals from a telephone into a digital
signal that travels over the Internet. If it's a regular phone
number that is dialled, the signal is converted back at the
other end. 

VoIP also lets you dial directly from a computer. At times,
service providers may provide a dial tone for VoIP-enabled
phones. If the service assigns a regular phone number, then
an individual can call from his or her regular phone into the
VoIP set without using special equipment to access the Intern

How VoIP Works 

Internet

Regular phone
with VoIP adapter

VoIP 
software

Infographic Solom
on Lew
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deals with support requests from
other branches.

The MS Exchange server is also
used to create a common bulletin-
board service for meetings and
other programmes. On the inter-
nal network, digital signatures
used to authenticate e-mail-cer-
tificates are issued inhouse. All
this is part of an effort to create a
seamless business communica-
tion network. 

Says Mankikar, “Its implemen-
tation is not important, but that
it is working well is.” However,
some holes need to be plugged—
communication on the move, for
instance. 

For that, he says, SVC bank
uses a Closed User Group (CUG) of
mobile users with Orange as the
service provider. The CUG and the
internal data network 
are maintained as separate enti-
ties, which are as distinct as
external PSTN and GSM networks, 
to ensure that internal security is
not compromised.

Other than that, the bank also
uses an FTP server that holds sup-
port documentation for the imple-
mentation of VoIP. 

It has been designed to ensure
that the support system runs
smoothly in the unlikely event
that the links to the head office
go down, and at the same time,
reduce traffic to and from the
Head Office servers.

The Results Are Showing
The past two years saw SVC Bank
migrating to the paperless office
in a phased manner. The migra-
tion for most of the intra-location
organisations is complete. 

In the pipeline are projects to
set up a service using which

employees can log in, apply for
leave and check the status of their
applications. 

They also plan to implement
Microsoft’s Unified Messaging
System (UMS), which aims to pro-
vide unified messaging based on
Windows NT and Windows 2000 as
the operating systems, along with
Microsoft Exchange Server as well
as Windows CE. 

This allows users access to a
single inbox containing e-mail,
voicemail, fax and paged messages
via a phone or another device. 

For SVC bank, this means that
employees can manage their e-
mail, voicemail, fax and page mes-
sages via the same interface they
use to search the Web or an
intranet, and access corporate
data and applications. 

All this is to ensure that net-
work costs remain the same as
they increase their leverage on
existing systems, says Mankikar as
his colleague, Jayavanti K Hat-
tangdi, Deputy General Manager,
Operations, SVC Bank calls up a
branch office on her IP phone. 

He points out that this call is
being routed to Pune. Back in his
office, he shows us the system
that generates warnings and e-
mails that contain information
such as status reports, coming
from the call manager, thus giv-
ing a bird’s-eye view of the links
to all branches and ATMs.  

SVC bank seems to be plugging
its corporate communication gaps
swiftly. “My aim is to change the
way people perceive co-operative
banks,” he says. Innovation, it
seems, need not come from far
above. 

aparna_krishnakumar@thinkdigit.com
suprotip_ghosh@thinkdigit.com

CUG Saved Rs 20,000 For Bangalore-based IT Firm

Closed User Group (CUG) is a facility most telecom operators offer
companies that run up fairly huge telephone bills. For a nominal fee,

this service lets a fixed number of people make calls at a reduced rate
from the same company.

SVC Bank along with the VoIP facility got an internal CUG, which
resulted in a substantial reduction of communication costs. They also 
got an external CUG for their executives spread across Maharashtra from
Orange, a Mumbai-based cellular service provider.

CUGs met with success at Select Technologies, Bangalore. Six months
ago, the company faced burgeoning telephone bills. Despite 
support partners across the world, its 17 Indian branch offices were 
found making the maximum number of calls. 

This prompted A Santosh, Manager, Finance and Operations, to switch
to Airtel’s CUG service. With a basic tariff of Rs 599 per person and a call
charge of 30 paise per minute, 55 phones became a part of the CUG. 

The result: Savings of at least Rs 20,000 per month.

Column Ad
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Do IMs Kill Productivity?
Business decisions facilator or an idle chat tool? The two sides of instant messaging

“No, they are powerful office tools”“Yes, they encourage idle chat”
Asha Ayare
Head, Business Solutions, Kotak Mahindra Primus

Nishant Kolgaonkar 
Head, HR & GIAS, Computer Associates India Pvt Ltd
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Kotak Mahindra Primus has a partnership with
Ford Motors, Australia, of which Kotak owns 40
per cent. The head office uses 150 PCs; 400 more

are used in the branches. We want to optimise the
time we give our employees with those PCs. We
observed that employees chatted on instant messengers
during working hours. 

We could not monitor everyone’s PCs. Adding to
that was the bother of viruses and spyware through
instant messengers, since every messenger today has a
file transfer feature.

So, we formulated a business policy a year ago
that permits only the use of business-oriented
applications such as Microsoft Office. Messengers
were uninstalled in all areas of the office, except the
Treasury and Wholesale departments, who continue
to use it for business purposes. Early morning
reminders are sent via the instant messenger, and
that’s that. 

This policy has eliminated idle chat, resulting in
substantial productivity enhancement. News and other
useful features offered by certain messenger
applications help keep an individual updated, but then
you have news Web sites for those updates, right?

At CA, we see instant messaging as a powerful,
real-time, shared communication tool. Instant
messaging fosters rapid communication and

decision-making, and provides people in an
organisation a valuable way to introduce each other.

CA employees make active use of MSN Instant
Messenger for internal communication. Our Human
Resources department finds it a great way to keep in
touch with, and improve relations with, employees.
Teams scattered at multiple locations use it to
coordinate their work, thus bringing about a
noticeable surge in productivity. 

At present, IMs are only used for internal
communication. This effectively secures us from
hacker attacks. We also use e-Trust, and that
precludes hacker intrusions.

Chat messages here are short and concise, and
hence, they do not really clog the bandwidth.
CA employs a mature set of people who have free and
on-demand access to different forms of
communication such as telephone, fax, e-mail, etc. As
such, IM is not a medium that somebody would
exploit for idle talk. That has never been our concern. 

— As told to Garfield D’Souza
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used for commercial purposes. It needs to be
secure, well-maintained, and capable of
handling and storing large amounts of data. “If
e-mail is critical to a business, it makes sense to
have separate providers for Web hosting and e-
mail.” says Abbas S Dean, IT manager, Mumbai
Liaison office, Anglo Eastern Ship Management.
This Mumbai-based organisation has around 60
users in its office. Though they do not have a
resident mail administrator in their Mumbai
office, they would prefer to have their mail-
server in-house. “It would give us more flexibil-
ity,” he says. They use MS Exchange on an
XP/2000 platform.

This solution makes eminent sense if you are
a large corporation. But if you are a start-up, or
an enterprise not directly involved in IT, these
technical details can be daunting. It is possible to
learn all this, or else, look for options elsewhere.

Attention! Mailman Wanted
There are various solutions available for the
Small and Medium Enterprise (SME) sector.
Hardware is cheap, and software prices vary
according to the kind of license needed since
the needs of a typical SME are not too high.

There are problems though. A mail server
needs to continuously connected to the
Internet, otherwise mails will bounce, and
typically, cannot be retrieved unless there is a
perimeter server in place.

There are also risks of virus infections,
malicious attacks and the Denial of Service
(DoS) attacks. Some viruses on the prowl can
send hundreds of thousands of e-mails from e-
mail accounts, eating up bandwidth and forc-
ing clients to block mails from the server. This
means enterprise grade firewalls and antivirus
software, which in turn means constant moni-
toring of the mail server, and high costs. 

Technology needs pampering to run, and
much to the chagrin of us all, pampering costs
money.

Still, businesses tend to host mail servers in-
house. The security, as well as the freedom of
managing a server in-house has a higher comfort
level for most businesses. 

Trust and security are most important, says
Kuldeep Sharma of Cravitex Ltd Mumbai, a firm
that markets and exports apparel, footwear and
fitness systems. Cravitex hosts their mail server
in-house, running MDaemon (a product by C&C
software) on the local LAN on NT. 

It has outsourced the external mail server
to a hosting service. However, bandwidth and

Small businesses
face a perennial
dilemma—to
outsource e-mail
services, or
create an in-
house system.
Here are a few
reasons why
outsourcing
could help 

Suprotip Ghosh

-mail is an indispensable part of busi-
ness today, be it a start-up or a Small or
Medium Enterprise (SME). With GBs of

e-mail space available for free, it is tempting to
just use any such free services for the business
needs of the SME. However, just any e-mail ID
cannot be used for official correspondence. It is
far savvier to have an e-mail ID that contains
your company name, and also yours! The state-
ment it makes at once impresses clients as
being authentic. 

But owning a domain name and running a
mail server is expensive, especially if it has to be

E
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spamming are chronic problems. Sharma
confesses that he can only place trust in the
service provider as far as confidentiality of
sensitive external information is concerned.

They Also Gain, Who Stand and Wait
Fortunately, the average entrepreneur today
has many more choices than five years ago. It is
possible to ‘outsource’ most needs. Early this
year, Spymac began to give out its 1 GB mailbox
accounts. In April, Google launched the beta
GMail service, with a 1000 MB mailbox and mail
search for its free e-mail accounts. 

That move heated up the e-mail war, and a
few months later, people who had bought 20
MB or 10 MB mailboxes with rudimentary facil-
ities were left looking a bit foolish when Yahoo!
and Hotmail said they would increase the free
account sizes to 100 MB. Rediffmail increased
their accounts to 1 GB too. 

They compensated commercial clients by
giving them double the size of free accounts,
other than a number of enhanced facilities
such as spam-protection and enhanced security.
Commercial e-mail accounts today provide
cutting-edge service and performance. 

And all this comes at rates dirt-cheap. The
interesting trend is the enormous amounts of
space on free e-mail accounts that have opened
up vistas.

An Embarrassment of Choices
There are literally as many ways to ‘outsource’
e-mail needs as the number of service providers

themselves. Most major e-mail service providers
such as Yahoo! and Rediff have premium busi-
ness e-mail services. Rediff, for example, have
Rediffmail Plus, which comes with a package of
5 mail IDs, 1 GB mail storage, your own domain
name, POP3 and virus protection added. Other
than that, e-mail IDs can be bought for a

SEPTEMBER 2004 DIGIT

At a time when the Small and
Medium Enterprise is the target

of aggressive marketing, Yahoo!
Business Messenger, a hosted service
accessed through instant messaging
(IM) software from Yahoo!, has been
discontinued. This fee-based IM
service offered features that many
companies require for instant
messaging. These features include
message encryption, IT management
and administration tools, message
logging and archiving, voice and
video communications and online
meetings.

Yahoo! has decided to focus
instead on its popular free IM service
while relying on partners such as
Akonix, FaceTime Communications
and IMlogic, which specialise in
gateway software. These enable
companies to manage IM platforms.

Quite a few such messengers
are available in the market. These

can be used as a complement to e-
mail for intra-office
communications. They save a lot of
work, and are easier on the
computer.

Jabber is an open-source instant
messaging platform that uses an
open, XML-based protocol to create
the standard functionality people
expect of an IM system.

Exodus is a Windows client for
Jabber (http://www.jabberstudio.
org/projects/exodus/releases/).
Read the Jabber manual
(http://www. jabber.org/user/user-
guide/) for details.

DataTel Lite provides secure IM
along with an assortment of
customizable features. 

DataTel Lite runs as a true peer-
to-peer program so no central
server program is required. Get it
from http://www. data-
mate.com/products.html

IM!portant

1/2 Pg  H AD
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hundred rupees apiece as the business grows.
There are other perks such as sending SMS
messages from the mail account and also a
large address book that holds 2,500 entries. All
this comes for a little under Rs 1,500.

Yahoo!, on the other hand, provides only
25 MB storage per account, and all the facilities
that Rediff provides. Other than that, they offer
200 blocked addresses, 50 filters and Yahoo!’s
trademarked Bayesian spam filters. Additionally,
they have waived the $25 setup fee that they
usually charge for new accounts. That brings the
cost down to around $9.95, or around Rs 460.

Indiatimes Meramail features Personalised e-
mail IDs, 6 e-mail addresses, 1,200 MB e-mail and
6 GB briefcase space, for a little under Rs 1,500.

All this comes at a price that most busi-
nesses can well afford!

However, all this has a sizable downside. As
Abbas says, the problem with services such as
Rediff, Yahoo! or Indiatimes is that their setup is
rather rigid. For starters, Web sites hosted on
their servers have problems with language and
platform support. They mostly run on Microsoft
products, so they generally lack support for PHP
or MySQL. This makes Web site maintenance
cumbersome, and the number of choices drops
significantly. On the other hand, if only the e-

mail service is subscribed to, the cost is slightly
on the high side. Sharma says that bandwidth
for outsourced e-mail management is a definite
issue, so is spam. Neither Yahoo! nor Rediff were
available for comment.

Yahoo!’s Web hosting and Business Mail solu-
tions are controlled from the US, according to
Yahoo! India. That necessarily means the
payment has to be made in US dollars and the
customer support is also undertaken by US
offices. These are issues that would concern an
entrepreneur looking to outsource e-mail needs. 

On The Other Hand
It is in fact possible to get the same functional-
ity at even lower prices if you have your own
business and can spare some time to learn a
little bit about Domain Name Servers (DNS). It
is possible to actually use your free e-mail
account to receive mails sent at your official e-
mail id (See box above, “How to Set Up Professional
Looking e-mail IDs”). All you need is a little tweak-
ing, and you can bind your e-mail with your
domain name and make it look like it is
coming from the company mail server.

Setting up a system of this sort means that
a lot of the traffic is dependent on free serv-
ices such as NoIP or ZoneEdit. Which means
you are at the mercy of the vagaries of the
Internet economy. 

Solutions to Swim In!
Most SMEs however, go in for an in-house server
for internal e-mail and an outsourced service
for external ones. Setting up mail servers,
setting up mailboxes, calling up people to ask
them to set up your mailboxes for you, it is
hard not to be bewildered by so much choice.
This is easily managed by keeping in mind the
end-point of investing the time and the money.
It is ultimately based on the kind of require-
ment that confronts the company. Choices are
choices, but they can only become solutions if
chosen judiciously. 

suprotip_ghosh@thinkdigit.com

With basic knowledge of DNS and how it
works, it is actually possible to set up

a free e-mail account and get your mails
delivered as if it was from a professionally
managed server. Here’s how:

First, set up an e-mail account with any
free e-mail server, say, yourname@rediff-
mail.com. Or if you have bought an inter-
net connection from you ISP, you can use
the e-mail account of your ISP (yourname
@vsnl.net, etc.)

Set up your own Web site, in one of
many free hosting services 

Buy your own domain name (www.
mycompany.com). Indicative prices are
given below.

If the provider you bought your domain
from supports DNS (refer to box: DNSing
in the dark), configure it to point to your
Web site already hosted in the hosting
service. Else, use a free DNS service such
as ZoneEdit (www.zoneedit.com) or no-IP
(www.no-ip.com)

Using ZoneEdit as the example, in the
control panel, enter the name of the e-mail
account you need to have as an official e-

mail account, viz., mail@mycompany.com,
and use ZoneEdit’s redirection service to
redirect all mail sent to this address to
your free account
(yourname@rediffmail.com or your-
name@vsnl.net, etc.)

You can use Outlook, Outlook Express
or Netscape mail to send mail. Just use
the outgoing mail server name such as
smtp.vsnl.net as your outgoing mail
server. If you have a leased line or ISDN
at office, it is easier to send and receive
the 10 MB attachments that can be 

sent from most e-mail accounts
these days

Any e-mail your business associ-
ates will receive from your free
account will appear to come from
mail @mycompany.com, thus
imparting a professional look to your
business

How To Set Up A ‘Professional Looking’ E-mail Service

We are not aware
of outsourcing
options, especially
to bigger service
providers such as
Yahoo! or Rediff.
However, free
mailboxes are out
of question in our
line of business;
security is impor-
tant to us.
Kuldeep Sharma
Cravitex Ltd
Mumbai

US$
74.90 for
10 years

8.95
11

Company name
NameSecure

WebLinkIndia
GoDaddy
Net4Domains

Location

US
India
US
India

Website name
http://www.namesecure.com/en_US/index.jhtml?cat=
null&subCat=null
http://www.weblinkindia.net/web-hosting/index.htm
http://www.godaddy.com/gdshop/default.asp
http://www.net4domains.com/

INR
3,445

445
412
500

Prices/Year

Names such as “ThinkDigit.com” are easy for
people to remember, but computers do not

understand them. They use names called IP
addresses to refer to one another instead. For
instance, you may type in ‘www.thinkdigit.com’
into your browser, but your computer connects
to ‘130.94.75.250’. Every time a domain name is
used, your computer accesses the domain name
servers (DNS) on the Internet to translate the
‘domain name’ into the machine-readable IP
address. During a single day of browsing and e-
mailing, your computer might access the
domain name servers hundreds of times.

DNSing in the dark
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Optimise Your    

Windows XP - 7 GB
Reinstalling an operating system becomes easier
once you have segregated it from your data files.
No more backing up to another hard disk. Just
delete the OS partition and reinstall

Temp - 500 MB
This is a dedicated partition for your
Windows’ swap. To be more effective,
change the default cluster size of this
one to 64 KB. Note that this is not an
essential element by far

Games - 9.5 GB
With games breaking the 3-CD barrier, more space is
always welcome. You can also store patches and mods
for your favourite games in here

My Documents - 3 GB
The My Documents folder carries much more
than your documents. It is where movies and
music are meant to be stored by default
(which we won't do). Moreover, files that you
receive over an Instant Messenger such as
MSN Messenger or Yahoo! Messenger also
reside here. So do e-books created by Adobe
Acrobat, etc

Program Files - 3 GB
You can move the Program Files
directory to another partition. All it
takes is a registry edit as soon as you
finish installing Windows XP. Go to
Start > Run. type ‘regedit’ and head
to: HKEY_LOCAL_MACHINE\
Software\Microsoft\Windows\Curre
nt Version and change the KEY =
ProgramFilesDir to reflect the new
partition; for example D:\Program
Files. Do not delete C:\Program Files!
This is a sentimental place for
Windows XP, the OS needs it…

Downloads - 6 GB
Make this the default partition to which
a download manager (such as FlashGet,
supplied on the Digit DVD) saves files to.
Similarly, this can be the default path
that browsers such as Opera or Firefox
use to save files

80 GB hard disks
are de facto today;
but what do you do
with all that space?
Here are some
suggestions...
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80 GB Hard Disk
Music - 20 GB
The Music partition should also contain a folder
that stores your playlists. Keeping playlists within
one dedicated folder makes music management
much more user-friendly

Backup - 1 GB
The Backup partition is where you maintain
copies of essential data. For example, ask
Microsoft Outlook to back up your e-mails to
this partition. Thus, you have one place from
which you can restore your data

Movies - 30 GB
Note that the sizes are
mere suggestions. If
you feel that movies or
games do not deserve
this much space but
your backups do, feel
free to change the
partition sizes
accordingly

By dividing the 
hard disk into partitions,
not only is data
segregation possible,
data fragmentation is
also reduced.
Additionally, consider
upgrading your drives to
the NTFS file system.
NTFS causes less data
fragmentation, is more
secure and compatible
with practically every
program out there. 
The only reason not to
upgrade is the fact that
an older operating
system (Windows 98,
mainly) may not read or
write to an 
NTFS partition.

Why Partition?
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Aliasgar Pardawala and Sanket Naik

obile computing is redefining the way
we do business, and corporates are only
too happy to equip mobile workers with

notebooks—it is a great business productivity
tool. The importance for mobile computing
stems from the need for access to critical data
wherever and whenever an employee needs it.
With access to data round the clock, the 9-to-5
time barrier is no longer valid, and ensures
work happens outside office and past office
hours.

Notebooks are favourites among marketing
and sales people. Coupled with a CDMA connec-
tion that offers data services, one can access e-
mail round the clock and keep in touch with
clients. Wi-FI capabilities keep you connected
when you travel across the globe; a Bluetooth

adapter lets you synchronise your contact data
across all your devices; a Firewire port lets you
unload pictures from your digital camera at
will. Besides, who likes to be away from a
computer for long!

The recent fall in the prices has thrown up
obvious advantages of using laptops, includ-
ing time saved, efficiency, etc.

Whether you are a CEO or a sales manager
looking to empower your sales force with 
the right mobility tools, or an individual 
looking for a notebook for business enhance-
ment, you will find something here that 
you can use.

We tested 43 popular notebooks, classify-
ing them into five categories—Budget, Work-
horse, Lifestyle, Desktop replacements and
Ultra-portables. Apple notebooks formed a
separate category by themselves. You may see
the detailed features and performance

Laptops are no
longer expensive
executive toys;
they are
essential
business tools.
Find out which
one suits your
needs the best

M

MOBILE
Powerhouse



comparison tables included in the Digit CD
with this issue.

BUDGET BUDDIES
Notebook prices have fallen steadily over the
past 12 months, resulting in a new target audi-
ence. The ‘Budget’ category comprises note-
books that sell for around Rs 50,000, which may
be the price point that will encourage their
mass adoption. 

Eight models fit into this category—one
each from IBM, Mercury and Zenith, two from
Wipro and three from ACi. The prices ranged
from as low as Rs 31,000 to close to Rs 57,000.

Features 
As expected, most laptops here ran on desk-
top hardware. There were some exceptions
though—ACi managed to include a Centrino-
based notebook, which promises decent
features and a good battery life without
compromising much on performance. 
The ACi’s Ethos V ran on VIA’s C3 processor
while Zenith’s Performer model integrated an
800 FSB processor. IBM and Wipro opted for
Intel’s Celeron processors to power their
notebooks, while the others ran on Intel
Pentium 4 processors.

All notebooks came with at least 256 MB of
RAM, making it easy for users to opt for
Windows XP. The IBM and ACi Ethos V models
had a 14-inch TFT display, which should suffice
for most. If you are looking for more, the others
deliver. The IBM R40e, the Wipro Notebooks

and the Zenith Performer have the best
displays in this category. 

All the laptops had a minimum of two USB
ports, with the Zenith One-up model boasting of
six. Apart from the IBM, Zenith and ACi Ethos,
all others had a Firewire port. All the note-
books, without exception, had an Ethernet port.

Hard disk capacities vary the most, and
this segment saw a variation of 20 GB to 60
GB. With increasing application sizes of
today, 20 GB is too little for a notebook; a
decent music collection or movies can rake
out GBs of space leaving little space for the
OS and applications, not to mention your
mail folder. The ideal proposition seems to be
a 40 GB hard drive, and Zenith and ACi get full
marks for their generosity. CD-ROM drives
seem to be a popular choice with most
laptops. IBM, Zenith and Mercury opted for 
a combination drive, and scored over 
the competition.

Usability
Nothing comes close to IBM’s R40e. It sports
the best finish of them all, and is ruggedness
personified. All other models had similar
build qualities, but were nowhere close to
being as rugged as the IBM. 

The ACi Ethos model’s build quality feels
weak, but at this low a price you can’t really
complain. 

Don’t be fooled by its looks though—this
notebook tackled most of our tests better than
the competition.
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Ergonomically, all the laptops are no-frills
products. The IBM misses out on a touchpad,
but offers its patented track point. But it makes
up for it by offering a good, solid keyboard.

Except for Zenith, all notebooks ran
Windows XP Home Edition. IBM was the only
one to supply a recovery CD, along with other
useful IBM utilities that help you recover the
factory conditions in case your system crashes.
Most came with average quality carry cases. 

Only the ACi Emerald Pro and Emerald C
come with a three-year warranty, the rest offer
a one-year warranty. Wipro offers an on-site
warranty—the rest offer a carry-in warranty.
The turn-around-time (the time it takes for you
to get a new laptop, or get your laptop back
after repairs) typically ranges from 12 to 48
hours across various vendors. 

Performance
ACi’s Emerald Pro performed well; hot on its
heels was Zenith’s Performer. While both were
on par in most tests, the Emerald Pro sported a
better battery time—still not enough to watch
an entire movie on a single charge. IBM and
Wipro couldn’t keep up with their feeble
Celeron processors.

ACi’s Emerald C, the lone Centrino note-
book, fared well, but was edged out in the end.
Astonishingly, the Mercury notebook offered
better battery life than the Centrino-based
Emerald C. ACi’s Ethos V returned poor scores.

Despite the weakest processor of the lot, it man-
aged to pass most of our stress tests, proving
that it’s worth its amazingly low price tag.

Conclusion 
The budget category needs the maximum value
from a minimal investment. The feature sets and
usability of all the laptops were almost identical,
so it was up to the performance scores to decide
the winner. ACi’s Emerald Pro emerged winner;
however, we should mention that the margin over
the competition was nothing special.The Wipro
Little Genius 1000D turned in good performance

scores; this, coupled with good pricing and the
great offer of an on-site warranty pushed it
ahead of the Zenith performer to win the
Best Buy Silver award. Zenith’s Performer

and Wipro’s Little Genius 4000D are
also commendable buys, and perform

better than the Wipro
Little Genius 1000D. 

If it wasn’t for the
below-par perform-
ance, ACi’s Ethos V
would be the perfect
example of a budget
laptop.

If you have a low
budget and need to
deploy laptops for your
team, nothing matches
the cheap Ethos V.

Test Centre

SEPTEMBER 2004

SEPTEMBER 2004

ACi Emerald
Pro

We assessed laptops on five main
parameters—features, performance,

usability, price and warranty, and
support. Weightages varied, depending
on the importance of a parameter to a
particular category. Windows XP
Professional SP1 was the standard
operating system. We also loaded all the
latest drivers for optimum performance. 

Features
We noted features such as the type of
RAM, hard disk capacity, the optical drive
provided, types of ports, etc. As per their
importance, weightages were attached
and thereby scores derived. 

Usability
Usability was evaluated on the basis of
how simple or difficult it was to handle
the device in our everyday lives—of
primary importance here were weight,
dimensions, and ergonomically inclined
factors such as keyboard feel, touchpad
sensitivity, etc. As a measure of heat
dissipation, we logged temperatures,
shown by a thermistor-based device, at
various points on the notebook.
Package contents
We checked whether the vendors
provided OSes, recovery CD with the
laptop. We also noted extra software and

accessories—power adapter, carry case,
etc., bundled along.

Performance
We ran a number of tests to evaluate
each individual sub-system. The
following benchmarking suites were
used:
SiSoft Sandra 2004 Professional: This
synthetic benchmarking suite evaluated
CPU, memory and hard disk
performances. The scores for each
individual sub-system were noted down.
PCMark 2004: PCMark 2004 is a system-
wide benchmark that tests the complete
system as well as individual components
such as processor, and graphics sub-
system and returns aggregated scores.  
Ziff Davis Business Winstone 2004: This
benchmark tests using applications that
are used on a daily basis, evaluates
complete system performance, and
returns a unified score. Higher the score,
the better is the system performance.
Video encoding: Here, we encoded a 50
MB .vob file using Dr DiVx to convert it
into the AVI format. The time taken do so
was noted.
Call of Duty: The game was run at
resolutions of 800 x 600 and 1,024 x
768, and the average fps was noted
down. 

DisplayMate Video Edition: The LCD
display was evaluated using tools such as
Point Shape and Visibility, and Streaking
and Ghosting slides. Protractor was used
to measure the maximum viewing angle
from which you can read text on a white
background.
WiFi test: NetCPS—a utility that pumps
data to test TCP/IP connections was used
to evaluate WiFi data throughput. We
also copied 20 MB of assorted data and
streamed a movie file too-all via WiFi.
Digit Battery Meter: We ran a .vob file till
the battery drained. A software timer
developed inhouse kept time.  
Warranty and Support: Apart from the
support, warranty period, we also took
into account the number of service
centres and the average turnaround
time.

How The Awards Are Given
The scores from features, performance,
usability, warranty and support, and
price, are given weightages relevant to
the specific category. An overall score
out of 100 is calculated. 

The product that scores the highest
here is adjudged the winner of the Digit
Best Buy Gold award for its category.
The second highest scorer gets the Digit
Best Buy Silver award.

How We Tested And How We Decided The Award Winners

Wipro Little
Genius 1000D
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WORKHORSES
The majority of notebooks owned by upper-
management in most companies form this cat-
egory. Executive looks, essential features, a
good balance between processing power and
battery life, good pricing, etc., are some of the
things to look for in such laptops. 

In all, 12 laptops from eight different
brands made it to this category. Three Compaq
notebooks; two from Toshiba; and one each
from IBM and Acer made up the international
brands. Zenith contributed with their Strategist
and Director models, while Wipro sent in two
notebooks. A new entrant—MSI, known for
great motherboards—also sent in one laptop. 

The laptops were all designed to cater to two
sets of people—the more mature and elegant
looking notebooks for senior management, and
the peppy-looking ones to cater to the young
blood rising in the corporate ranks.

Features
Almost all the laptops here were based on the
Pentium M Centrino platform. Only the
Compaq P2514AT, Compaq P2563AI and the
Toshiba Satellite A60 models used either a
Pentium 4 or Celeron processor. 

Most of the Centrino-based notebooks inte-
grated a 1.5 GHz processor; Acer went one step
further and used a 1.8 Ghz processor and
Zenith’s Strategist model used a 1.7 GHz
Processor. The IBM’s R50 processor was the low-
est rated at 1.4 GHz processor—still a decent
clock speed. 

256 MB seems to be the norm for RAM. A few
exceptions—the Compaq P2514AT, and both the
Zenith models—ship with only 128 MB of RAM.
We asked for the Zenith laptops to be upgraded
to 256 MB, since that is a pre-requisite to run
Windows XP, at least in our opinion. The prices
quoted in this category for the Zenith models
include the cost of upgrading to 256 MB RAM.
Acer was the best of the lot, and offered 512 MB
of RAM. 

Zenith’s Strategist model stood apart from
the rest with its 15.4-inch wide-screen TFT dis-
play—wide screens are really helpful when
working with applications such as Excel. Four
of the notebooks had 14-inch displays—the IBM
R50, the Compaq 2514AT, the Toshiba Tecra
M2V and the Zenith Director. The rest had 15-
inch displays. 

The quality of the display screens on the
Toshiba Tecra, Compaq’s V1040AP and IBM’s
R50 were the best—noticeable when watching
fast action videos. 

All the laptops offered three or four USB
ports. A port that seems to be gaining in popular-
ity is the Firewire port, making it easy for imag-
ing professionals to connect their digital cameras
and other high-end digital imaging stuff. 

Infrared (IR), though outdated, is still the pre-
ferred wireless communication protocol, and is
found on a lot of laptops. Though great to sync
your mobile phones, handhelds etc, it is a defi-
nite no-no when transferring large files. Only the
MSI and Zenith notebooks lacked an IR port. 

With the wide acceptance of Bluetooth in

1/2 Pg H AD

Centrino
platform-based
notebooks offer
long battery life,
great
performance,
and wireless
connectivity
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handhelds and mobile phones, notebooks with
inbuilt Bluetooth adapters are cropping up. The
Acer and Compaq’s V1040AP were the only note-
books with inbuilt support for Bluetooth. 

With the Centrino platform comes Wi-FI.
Acer and MSI offer the faster 802.11g capable of
54 Mbps, while the rest offered 802.11b adapters
capable of reaching 11 Mbps. When put to the
test, only MSI’s Megabook M510c returned good
results, while the Acer was a bit of a letdown. 

Hard disk capacities hovered around 40 GB.
However, Acer Travelmate 8005LMi outdid the
rest by providing an 80 GB hard disk.

Combo drives are standard on workhorse
notebooks, and almost every notebook had one,
except for the Toshiba Satellite A60 and the
Compaq 2514AT—they came with separate DVD
and CD-ROM drives. The Acer 8005LMi again
excelled by providing a DVD-writer. 

A notable feature of the IBM R50 is that it
senses movement—if you move the laptop, it
locks the hard disk’s head to prevent damage to
it, just like in the ad you would have seen on TV.
The Acer 8005LMi offers a Media bay—a bay that
can accept either an optical drive or an addi-
tional battery for prolonged life. 

Nothing beats the Acer 8005LMi in terms or
features; the Compaq V1040AP came second. 

Usability
The IBM R50, Toshiba Tecra M2V, Compaq
V1040AP and Acer 8005LMi sport sophisticated

design and elegant looks. The MSI M510C,
Toshiba Satellite A60, and Zenith’s Director and
Strategist look good and should attract the
younger executives.

The Toshiba Tecra was the lightest and most
portable notebook in this category. The MSI,
Compaq 2563AI and 2514AT, and the Toshiba
Satellite A60 are slightly bulky, but manageable. 

The painstaking attention to the ruggedly
designed IBM R50 is clear when you notice the
grip that helps you lift the upper lid, or the
small lamp that helps you find keys in the dark. 

Compaq’s V1040AP and the Toshiba Tecra
take second place in terms of functional design,
followed closely by Zenith’s Director and
Strategist models. The Tecra was slightly better
than the Compaq in day-to-day use. The smaller
touchpad surface on the Compaq can get really
irritating. 

Zenith’s Director and Strategist were very
similar to each other in terms of design and
practical usability, except for the 5X’s larger
proportions. 

MSI’s M510C closely resembles Apple’s
iBook design with very few flaws, except for the
way too tiny touchpad buttons.

The speakers on almost all these laptops
sound dull. Only the Compaq V1040AP’s speak-
ers are acceptable, and can add that little extra
to your presentation. The MSI’s speakers were
loud, but lacked depth. The IBM R50s speakers
were the worst, but this is the only chink in its
armour.

Overall, the IBM R50, Compaq V1040AP and
Toshiba Tecra offer the best user experience.
The MSI 510C, Zenith’s Director and Strategist
models, and the BenQ 5000U form the second
tier of products in terms of usability. 

You get three years’ warranty on Acer, BenQ,
IBM, and Toshiba Tecra products, whereas
Compaq, Zenith and Wipro offer the standard
one-year warranty.

Performance
The king on the performance arena was the
MSI Megabook M510C. It simply blew the com-
petition away—including the well endowed
Acer 8005LMi and Zenith 5X. 

In the system test, the Acer won, obviously

From The Horse’s Mouth

Neeraj Roy, CEO of
Hungama.com, has been a
notebook user for the past
twelve years, and now uses a
Compaq Presario 80XL550. He
travels ten days a month on an
average, and his laptop is the
lifeline that helps him stay
connected with work. He feels

battery life on the move is the biggest challenge for
a notebook user, and is a primary factor in making
purchase decisions. He also rates performance and
wireless connectivity as important criteria.

Harsh Vardhan Roongta, CEO of
Apnaloan.com, is a chartered accountant and has
over 18 years of experience in financial services

and consultancy. Roongta has been a notebook
user for the past three years. His business trips—
twice or thrice a month—see him using his IBM
ThinkPad R40e, and a Reliance mobile phone for
Internet access. He feels that computing on the
move is the best thing in favour of a laptop. Of
course, there are a few uncomfortable things to
adjust to-the smaller keyboard,
for example. 

In his opinion, good battery
life, a large screen, and
ruggedness are the most
important criteria when buying
a notebook. Performance and
weight, he feels, are secondary
factors to consider.

“Laptops help people who are on the move”Nowadays, most
workhorse
notebooks are
equipped with
combo drives
that allow you to
back up data and
watch DVD
movies while
travelling

Neeraj Roy

H V Roongta
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Save Power

Battery life is an important aspect of any mobile device-be it a cell phone,
PDA or a laptop. Given below are ways in which you can save and prolong
battery power:

Decrease the brightness of the screen if there’s ample light around you.
Do not disable processor-specific technologies such as Intel’s
SpeedStep and AMD’s PowerNow technology. These help run proces-
sors at lower speeds. Smarter management of CPU cycles enables
longer battery life, lower heat dissipation and near-noiseless operation. 
If your laptop is WiFi and/or Bluetooth-capable, switch these off when
not in use. Both are power-hungry and consume a lot of power. 
Use the Standby mode instead of turning the screensaver on. This
mode cuts off power supply to the hard drive and the monitor. 
Pressing a key or moving the mouse restores the power supply. 

MSI
MegaBook
M510C
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due to the faster processor and the 512 MB of
RAM. Similar results were seen in the video
encoding test. The MSI M510C wasn’t far behind
the Acer in all these tests, and even beat it in the
display, battery life and wireless tests. 

The screen quality on the MSI was better
than that on the Acer in all the parameters
that we laid down. The Toshiba Tecra, the IBM
R50 and the Zenith Director have better dis-
plays than most. 

The MSI M510C also had the longest battery-
life, and hence took a good lead over the Acer,
which sacrifices battery life for performance.
The Compaq V1040AP came had the second-
longest battery life, and was followed by the
Zenith Director. 

Despite its 802.11g Wireless adapter, the
Acer notebook failed to return the expected
scores—even after repeated attempts. The MSI,
on the other hand, did extremely well, and we
could stream a movie on the wireless link—it
played without a jerk. Wipro’s Little Genius CP
also came out with flying colours in the wire-
less tests. 

Conclusion
Considering scores on performance, features,
usability and price, the MSI M510C emerges as
the winner—it gets the Best Buy Gold award.
Wipro’s Little genius won the Best Buy Silver
award, because of its all-round abilities. 

However, you shouldn’t ignore products such
as the IBM R50, Toshiba Tecra, Compaq V1040AP
or Acer 8005LMi. The only reason they lose out is
the price; but then again, the designs they sport,
the features they offer, the name of a trusted
brand, etc., come at a premium. 

LIFESTYLE COMPANIONS
Notebooks that blend looks, appeal, style and
functionality fall into the Lifestyle category.
These products reflect the personality of the
user, and may have the latest technology or just
look elegant and sophisticated. These products
are meant for a buyer who wants to stand out in
a crowd.

The category consisted of nine notebooks
from Samsung, LG, Compaq and Toshiba; all
cost above Rs 1 lakh.

Features
Fancy features were the norm here. Samsung
offers an inbuilt biometric security solution
with their laptops. Samsung P30 and  X10 mod-
els have in-built biometric security solution.

LG’s LS40 is rated to provide 10 hours of bat-
tery life. However, it provided just four hours in
our test.

Compaq’s X1237AP was the most feature-
rich laptop, offering a Bluetooth adapter, DVD-
Writer, and 15.4-inch wide format screen—truly
useful features as compared to other fancy stuff
provided by others.

Every notebook in this category was based
on the new Centrino platform. The processors
were mostly Pentium M running at either 1.5
GHz or 1.4 GHz. Samsung’s X05 was the only
exception—it had a Celeron M processor.

The Toshiba Satellite M30 comes with a
breathtaking 15.4-inch wide display that is crys-
tal clear. The sheer brilliance of this screen,
combined with the Harmon Kardon speakers,
takes multimedia to an unmatched  level.

Barring Samsung’s X10 and X05, the others
supported either of the two legacy ports—serial

When it comes to
good looks, in
the Lifestyle
category, Apple
notebooks lead
the pack

Wipro Little
Genius CP
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Lapples Anyone?
Notebooks that give you a feeling of

being different, notebooks that will
have people look at you with wonder;
yes, we’re talking Apple here. Notebooks
or desktops, Apple computers are always
desirable. The iBooks and PowerBooks
have a charm of their own.

Apple leads the pack when it comes
to meticulous details on the appearance.
Minute details such as rubber padding
on the top lid for better grip, a LED in
the power socket that changes colour to
indicate battery charging, retracting
latches that hold the upper lid, etc., are
enthralling. 

For the comparison, we got one 12-
inch iBook and three PowerBooks in the
increasing size of their display—12, 15
and 17 inches. The essential difference
between the two classes of Apple note-
books is self-explanatory, the PowerBook
as the name suggest are powerful and
are priced higher, whereas the iBooks
are slightly low on power, features and
price. 

The milky white 12-inch iBook has a

polycarbonate outer case,
which can take daily
thrashing without any
problems. The
PowerBooks, on
the other hand,
offer a brush
finished
Aluminium
casing that is
scratch-resistant and
looks beautiful.

The PowerBooks offer a Superdrive
that is capable of burning DVD’s, Gigabit
Ethernet ports, a Firewire 800 port that
is capable of nearly double the data
transfer rate of a standard Firewire port,
inbuilt Bluetooth, a 54 Mbps WiFi
adapter, and the latest in graphics—ATi’s
Mobility Radeon 9700. 

Apple’s Mac OSX Panther is the OS
used in all the notebooks, and is simple
to use and understand. Mac OSX comes
with all the necessary applications, such
as an e-mail client, a PIM software and
Web browsers. Microsoft’s new Office

2004 for the Mac
platform takes care

of the Word process-
ing and spreadsheet

needs.  
G4-based note-

books are slightly
slower than Centrino-

powered notebooks
from other brands, as

proved from the comparison
between the Dell D800 and 17-

inch PowerBook—we ran the
PSbench action script on Adobe
Photoshop CS. Dell’s D800 took 195 sec-
onds to complete the script, whereas the
17-inch Apple took around 305 seconds
for the same task.

However, it’s not the performance
that matters here; it’s the user experi-
ence that is the driving force. Our stints
with these notebooks convinced us that
they are simply the best. Migrating from
the Windows platform does pose some
problems initially, but the simple Mac
OSX interface can be grasped easily. 
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or parallel. All models had at least two USB
ports and one Firewire port.

All notebooks offer Wi-FI access via 802.11b
adapters. Only the Compaq X1237AP provided
Bluetooth. All the notebooks provide an
Ethernet port and inbuilt modem. The Compaq
X1237AP, the Toshiba Satellite M30, the LG LM40,
and the LG LM50, provided an SD card reader,
while Samsung’s X10 and P30 offer Memory
Stick, and SD/MMC support.

An ATi Mobility Radeon 9200 graphics pow-
ers Compaq’s X1237AP and the LG LM40, while
the LG LM 50 offered the better performing
Mobility Radeon 9600. Samsung had GeForce
440 Go and Geforce FX-5200 Go for their X10
and P30 models respectively. The rest used
Intel’s Extreme Graphics 2 for their display
requirements. The Radeon-powered notebooks
offer better graphics performance as compared
to the Intel chipset-powered notebook.

Except for Compaq’s X1237AP, which had a
DVD-Writer, the rest came with Combo drives to
write CDs and read DVDs. Windows XP
Professional was the chosen OS for most of
these laptops, but Compaq, Toshiba and
Samsung X05 offer the Home edition. Compaq
was the only vendor to bundle a carry case.

Usability
Samsung X10 and X05 were the only notebooks
in this category to weigh below 2 kg.
Unmatched in their portability, these two note-
books should be on your list if you are looking
for a slim notebook.

LG’s LM 40 weighs over 2 kgs, and is as slim
as the two Samsungs. Toshiba’s satellite M30 and
Compaq’s X1237Ap are the heaviest at 3 kgs, due
to their 15.4-inch wide screens. All the other
notebooks weigh in at between 2.3 and 2.7 kgs.

Ergonomically, Samsung and Toshiba win
hands down with the perfect placement of keys,
and superb touchpad implementation—especial-
ly the Samsung models. The Compaq X1237AP
model is a delight to use, but its touchpad spoils
the experience somewhat. All the LG models are
decent, nothing extraordinary.

Compaq and Toshiba notebooks are covered
by a 1 year carry-in warranty, and claim turn-
around times of 24 hours. LG and Samsung pro-
vide 3 years of carry-in warranty. Samsung
products are covered by a replacement warran-
ty, and the claimed turn-around-time is 48
hours; LG claims 24 hours for its notebooks.

Performance
LG’s LM 50 topped the PC Mark 2004 results,
displacing Samsung’s P30 and the Compaq
X1237AP to second and third position respec-
tively. The PC Mark results tell us that the LG
LM50 provides the best overall performance.

In the system benchmarking test,
Samsung’s X10 posted the highest score, thanks
to advantage of an extra 256 MB of RAM. The
next best scores were posted by the Toshiba
M30 and the LG LM 40.

The video encoding test saw the LG LM 50
churn out the maximum frames per minute,
followed by Compaq’s X1237AP and the
Toshibas M30.

On the gaming front, the Compaq X1237AP
ruled the roost, followed closely by the
Samsung P30. The others are mediocre per-
formers, but this doesn’t say much as most lap-
top users don’t buy laptops to play games. The
point is, the Samsung P30 and Compaq
X1237AP have great graphics sub-systems that
might come in handy.

On the wireless front, Samsung led the
pack—all their models cruised through most of
the tests that we put them through. The
Compaqs and LGs also returned impressive per-
formances. 

Overall, LG’s LM50 is the best-performing
notebook, but only beating the Samsung’s X10
by a small margin of just one point.

Conclusion
Based on overall performance, features, war-
ranty coverage and usability, LG’s LM50 comes
out top to clinch our Best Buy Gold award for
this category. It was too hard to choose between
the Toshiba Satellite M30 and Compaq X1237AP
for the Best Buy Silver award, so we decided
that both deserved it. 

However, the cool looking Toshiba Satellite
M30 garners more flaunt value than the sedate,

How To Buy A Good Laptop Bag
A leather bag that carries the laptop and
protects it from jerks and scratches is a useful
accessory. Here is what you need to look out for
while buying one:

Choose a top-loading bag whose zip can be
drawn halfway through. This might make it a bit
tedious to pull the laptop out, but it reduces the
chances of it falling accidentally—which is what
happens often with standard cases. 

The bag should have cushioned pads at the
bottom as well on its sides. Without them, the
chances of damage are higher as leather cannot
bear that much weight for long.

Make sure the bag has pockets for PCMCIA
cards, CDs, business cards and pens.
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The Toshiba M30
matches the
Apple notebooks
when it comes to
aesthetic appeal.
It promises great
performance too
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mature look of the Compaq X1237AP. The Samsung X10
nearly won the top honours in this category, and deserves a
worthy mention. This notebook is a great product, espe-
cially if you are looking for a light-weight solution that fits
your image. Other products that deserve a mention are the
Samsung P30, X05 and LG LM 40, which offers the best bat-
tery life of them all.

DESKTOP REPLACEMENTS
Notebooks that perform as well as a desktop, and are also
mobile, fall in the Desktop replacement category. Their
mobility is limited due to their bulk and weight.

However, workhorse notebooks are getting better, and
the line that separates these two categories is getting thin-
ner. Hence, many vendors have stopped offering them as a
performance alternative. This was evident from the fact
that the category has only three products.

Two notebooks from ACi—the Emerald M10 and the
Ultima—and a Dell Latitude D800 formed this category.

Features
Both the ACi notebooks were powered by desktop proces-
sors from Intel. The Dell Latitude D800 had the latest 2 GHz
Pentium M processor with 2 MB of L2 cache as against the
512 KB found on the other two.

The D800 offers 1 GB of main memory, while both the
ACi models have a relatively modest 512 MB of main mem-
ory—enough for most system-intensive applications. 

With a 17-inch display, the ACi Ultima is way ahead of
both the notebooks in terms of viewable real-estate offered.
The Dell D800 makes up for the smaller 15.4-inch display by
providing a higher resolution screen that is both crisp and
brilliant. The ACi Emerald M10 just has a standard 15-inch
screen—no match for the other two.

USB ports were in abundance, legacy ports such as
Serial and parallel were also present, and all had Firewire
ports. The usual Ethernet, modem and Infrared ports are
also standard. The Dell D800 has a Bluetooth adapter. The
Emerald M10 has a memory card reader that can read all
six available types of cards.  

Both the ACi models come with 40 GB of hard disk
space—too little for a desktop replacement. The Dell offers
80 GB of space. nVidia’s GeForceGo FX-5650 powers Dell
Latitude D800, whereas the ACi offers an ATI Mobility
Radeon 9600 on the M10 and a 9000 on the Ultima. The Dell
offers a DVD-writer, while ACi offers just a combo drive and
a vanilla CD-ROM drive on the M10 and Ultima respectively.

Securing Your Laptop

It’s quite easy to buy the costliest and top-of-the-line laptop;
protecting it from thefts is well, not that easy. Universal

security slots are available on almost all available laptop
models. These slots use a variety of locking devices, which
keep your laptop attached to a solid base. Moreover, there
are a number of other devices ranging from motion-sensing
PCMCIA cards that set off alarms in the range of 110dB to
biometric fingerprinting devices that secure your laptop and
render it useless if no proper authentication is provided. 

If your laptop contains critical data, use devices such as
smart cards and automatic IR-access locking devices. These
ensure that data stays where it ought to be.

Increasingly, many laptop manufacturers are paying
special attention to security needs. Acer and Samsung, for
instance, provide security options, which thwart any attempt
to steal data.

1/2 V Ad
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Usability
All three notebooks were huge and heavy; how-
ever clever design hides the bulkiness of the
Dell D800. The ACi Ultima is a monster, weigh-
ing 4 kg, thanks mainly to the 17-inch screen. 

Ergonomics is a non-issue with the D800;
the keyboard is well laid-out with good spacing
between the keys. The touchpad buttons are
large and hard to miss, however the tactile feel
isn’t the best. Dell also provides a pointing stick
for lazy fingers. 

ACi’s Emerald M10 and Ultima can’t match
the Dell D800 on ergonomics; nevertheless they
offer the best for the price one pays for them.

Heating issues are
omnipresent in all note-
books, and it is compounded
in notebooks that use desk-
top processors due to the

higher thermal
envelope that they
are designed with.
All the three note-
books in this cate-
gory were no
exceptions -their
u n d e r - s u r f a c e
heats up after a
while. For the
ACi’s, the palm rest
and the keyboard
heated up—very
u n c o m fo r t a b l e .

The D800 has great ventilation and doesn’t face
these problems.

Performance
ACi’s Emerald M10 and Dell D800 were on par
in almost all the tests except for the Call of Duty
game, where the M10 beat the D800 hollow. The
better performance of ACi’s M10 is quite evi-
dent, since the M10 uses a Hyper-Threaded
processor with a difference of almost 1 Ghz in
clock speeds. The  Pentium M processor in the
D800 matches the M10’s desktop variant. 

System intensive tests, such as ZDBench,
video encoding, etc., saw the ACi Emerald M10
slip ahead of the Dell D800 by a small margin,
and similar results were seen across all the tests
that we put these two laptops through. The
ACi’s Ultima proved to be a mediocre performer
when compared to other two notebooks in this
category. 

The Dell D800 offers twice the battery life as
compared to both models from ACi. This is one
of the advantages that the power optimized
Centrino platform offers without cutting out
much on the performance aspect. 

All three notebooks are supported by three
years of warranty. While ACi offers a carry-in
warranty, Dell offers on-site warranty coverage,
additionally due to its global presence, one also
gets an international warranty. 

The claimed turn-around-time is 48 hours
for ACi laptops, and 24 hours for Dell.

Conclusion
Riding high on features, usability, equally
impressive performance and excellent service
and support, Dell’s Latitude D800 takes the
crown. However, its high price will be a stum-
bling block for many potential buyers. 

If you don’t give much importance to brand
value, and want a powerful notebook, then
ACi’s Emerald M10 is the best solution on offer
at a reasonable price. 

ULTRA-PORTABLES
Ultra-portables offer computing power in the
smallest possible form-factor. The bonsai act
leaves them crippled on the performance
front, since most of them use low-power
processors to squeeze out the most from the
tiny batteries. 

Reliance GTRAN Card

The sole purpose of Reliance Infocom’s GTRAN
card is to provide Internet connectivity on the
go. All you need to do is plug it into the PCMCIA
slot. This card works on CDMA 1x technology
and theoretically provides 153 Kbps of peak
data throughput. Your mobile phone gets tied
up when you use it for a dial-up connection.
GTRAN solves this problem by providing
Internet connectivity. Reliance offers the GTRAN
card for Rs 14,700 with 3 tariff plans. You pay
40 paise/minute flat in the first plan. The
second and third plan offers 100 MB and 500
MB of data exchange for a flat fee of Rs 500 and
Rs 1000, respectively. You shell out an extra Rs
10 for each additional MB of data exchange.
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Model ScoreBasic Specifications Price (Rs)

Score Board

BUDGET CATEGORY
Via C3 1 GHz, 256 MB, 40 GB, 14”, CD-ROM
Pentium M 1.4 GHz, 256 MB, 40 GB, 15”, CD-ROM
P4 3.06 GHz 256 MB, 40 GB, 15”, CD-ROM
Celeron 2.2 GHz, 256 MB, 30 GB, 14”, Combo Drive, IBM Utilities
P4 1.8 GHz, 256 MB, 20 GB, 15”, Combo Drive
P4 2.6 GHz, 256 MB, 30 GB, 15” ,CD-ROM
Celeron 2.4 GHz, 256MB, 30 GB 15”, CD-ROM
P4 2.8C GHz, 256 MB, 60 GB, 15”, Combo Drive
WORKHOUSE CATEGORY
Penitum M 1.8 GHz, 512 MB, 15”, 80 GB, DVD-Writer, Bluetooth & 802.11G
Pentium M 1.5 GHz, 256 MB, 15”, 40 GB, Combo Drive, 3-in-1 Memory Card Reader
Celeron 2.8 GHz, 128 MB, 14”, 30 GB, CD-ROM, Touch Pad Off switch 
P4 3.06 GHz, 256MB, 15”, 40 GB, Combo Drive, Touch Pad Off Switch 
Pentium M 1.5 GHz, 256 MB, 15”, 40 GB, Combo Drive, Bluetooth 
Pentium M 1.4 GHz, 256 MB, 14”, 30 GB, Combo Drive, IBM Utilities, Keyboard Light, IBM Active Protection System
Pentium M 1.5 GHz, 256 MB, 15”, 40 GB, Combo Drive
Pentium M 1.5 GHz, 256 MB, 14”, 40 GB, Combo Drive
Celeron 2.8 GHz, 256 MB, 15”, 40 GB, DVD-ROM
Pentium M 1.5 GHz, 256 MB, 15”, 40 GB, Combo Drive
Pentium M 1.5 GHz, 128 MB, 14”, 30 GB, Combo Drive
Pentium M 1.7 GHz, 128 MB, 15”, 30 GB, Combo Drive
LIFESTYLE CATEGORY
Pentium M 1.5 GHz, 512 MB, 15.4” (Wide), 80 GB, DVD-Writer, Bluetooth
Pentium M 1.5 GHz, 256 MB, 14”, 40 GB, Combo Drive
Pentium M 1.5 GHz, 256 MB, 15”, 60 GB, Combo Drive
Pentium M 1.4 GHz, 256 MB, 14”, 40 GB, Combo Drive
Pentium M 1.4 GHz, 256 MB, 15”, 40 GB, Combo Drive
Celeron M 1.4 GHz, 256 MB, 14”, 30 GB, Combo Drive
Pentium M 1.5 GHz, 512 MB, 15”, 40 GB, Combo Drive, Biometric Security
Pentium M 1.5 GHz, 256 MB, 15”, 80 GB, Combo Drive, Biometric Security
Pentium M 1.5 GHz, 256 MB, 15.4” (Wide), 40 GB, Combo Drive, Harmon Kardon Speakers
DESKTOP REPLACEMENT CATEGORY
P4 3 GHz, 512 MB, 17” (Wide), 40 GB, CD-ROM, PC camera
P4 3.06 GHz, 512 MB, 15”, 40 GB, Combo Drive, 6-in-1 Memory Card Reader
Pentium M 2 GHz, 1 GB, 15.4” (Wide), DVD-Writer, Extra Battery 
ULTRA-PORTABLE CATEGORY
Pentium M 1.5 GHz, 512 MB, 12”, 60 GB, External Firewire Combo Drive 
Pentium M 1.5 GHz, 256 MB, 12”, 40 GB, DVD-ROM (Built-in)
Pentium M 1.4 GHz, 256 MB, 12”, 40 GB, External USB Combo Drive
Pentium M 1.2 GHz, 384 MB, 12”, 30 GB, External USB Combo Drive, Docking Station & Extra Battery
Athlon XP-M 2100+, 256 MB, 13.3”, 40 GB, Combo Drive (Built-in),  Port Replicator 
Pentium M 1 GHz, 256 MB, 10.6”, 40 GB, External Combo Drive, Port Replicator   
Celeron M 800 MHz, 256 MB, 12”, 30 GB  
LAPPLES
Power PC G4 1.5 GHz, 512 MB, 17” (Wide), 80 GB, DVD-writer, Firewire 800, Bluetooth
Power PC G4 1.5 GHz, 512 MB, 15.2” (Wide), 80 GB, DVD-writer, Firewire 800, Bluetooth
Power PC G4 1.2 GHz, 256 MB, 12”, 60 GB, DVD-writer, Bluetooth
Power PC G4 800 MHz, 256 MB, 12”, 30 GB, Combo Drive 

45.83
47.04
47.63
40.79
43.67
47.34
47.46
47.32

54.31
53.15
48.64
51.58
49.96
52.64
57.41
51.19
47.17
56.66
51.03
52.56

52.9
49.14
51.63
53.23
49.58
50.25
52.26
51.93
52.92

51
59.27
63.78

58.43
53.05
56.98
64.69
61.12
51.84
53.89

NA
NA
NA
NA

31,200
50,990
50,990
52,990
49,500
56,990
43,990
47,500

1,35,000
79,990
64465
74,470
1,26,179
89,990
74,990
1,19,990
79,990
73,990
58,990
68,200

1,59,990
1,35,000
1,40,000
1,05,000
1,10,000
1,09,000
1,42,490
1,24,990
1,09,000

79,990
84,990
2,37,918

99,999
79,990
1,10,000
1,39,973
79,990
1,24,990
1,44,490

1,71,400
1,52,200
1,02,800
70,990

Ethos V (ECS G320)
Emerald C
Emerald Pro
R40e
G550
Little Genius 4000D
Little Genius 1000D
Performer

TravelMate 8005LMi
Joybook 5000U
2514AT
2563AI
V1040AP
R50
MegaBook M510C
Tecra M2V
Satellite A60
Little Genius CP
Director
Strategist

X1237AP
LM40
LM50
LS40
LS50
X05
X10
P30
Satellite M30

Ultima
Emerald M10
Latitude D800

TM 372TCi
Ethos Lite D12
Joybook 6000u
Latitude X300
LifeBook S2020
LifeBook P5020
Q20

PowerBook G4 17-inch
PowerBook G4 15-inch
PowerBook G4 12-inch
iBook G4 12-inch

Aci
Aci
Aci
IBM
Mercury 
Wipro
Wipro
Zenith

Acer
BenQ
Compaq
Compaq
Compaq
IBM
MSI
Toshiba
Toshiba 
Wipro 
Zenith
Zenith

Compaq
LG
LG
LG
LG
Samsung
Samsung
Samsung
Toshiba

Aci
Aci
Dell

Acer
Aci
BenQ
Dell
Fujitsu
Fujitsu
Samsung

Apple
Apple
Apple
Apple

Brand 

Features
Most current ultra-portables use Centrino plat-
form, with its apparent advantages such as
longer battery-life and good performance.
Except for the Fujitsu S2020, which uses an
AMD Athlon XP-M 2100+ and Samsung’s Q20
with Celeron M processor, all the others had
Pentium M processors of varying speeds. 

The ACi Ethos, BenQ Joybook 6000U and the
Fujitsu P5020 offered a wide-screen format.  The
Fujitsu S2020 was the odd one out, offering a
13.3-inch screen. In terms of display quality,
Dell, Samsung, and Fujitsu offer better displays
than most others.      

The Dell Latitude X300 comes with a dock-
ing station, which also has an additional bat-
tery compartment in which you can charge a
backup battery. The Docking station also pro-
vides additional serial and parallel ports that
are missing on the laptop. All the notebooks,

except the Samsung Q20 had Wireless adapters.
This is very convenient, as wireless hotspots are
sprouting up everywhere. The Dell latitude
X300 was the only one to go one-step ahead and
offer Bluetooth. Except for Fujitsu S2020 and
ACi Ethos Lite D12, all other ultra-portable have

nVidia MXM

nVidia has come up with a specification called
MXM (Maximum graphics Module) that

enables manufacturers to incorporate the
common graphics subsystem design into their
laptops. These modules will sport a PCI-Express
x16 interface. It takes away the hassle of having
custom-design graphic boards for each model
and also enables the end user to update the
graphics subsystem as easily as it is done with
the desktop PC. 

SEPTEMBER 2004
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Telephone Web siteCompany E-mailBrand

Contact Sheet

Acer
ACi
Apple
BenQ
Compaq
Dell
Fujitsu
IBM
LG
Mercury
MSI
Samsung

Toshiba
Wipro
Zenith

Acer India Pvt Ltd
Allied Computer International (Asia) Pvt Ltd
Apple Computer International
BenQ India Pvt Ltd
Hewlett Packard India ltd
Dell Computers Asia Pte Ltd
Aci Infocom Ltd 
IBM India Ltd
LG Electronics India Pvt Ltd
Kobian India Ltd
Maxtone Electronics
Samsung Electronics India Information &
Telecommunication Ltd

HCL Infosystems Ltd
Wipro Limited
Zenith Computers Ltd

080-25219520-23
022-56407000
080-25550575
022-25705230
1600 444 999
1600 338 044
022-28266031
080-22063000
0120-2560900
080-25566626
022-23011919
011-51511234

0120-2544534
1600 333 312
022-28377300

ailenquiries@acer.co.in
support@aci-asia.com
indiainfo@asia.apple.com
SalesEnquiryIn@BenQ.com
seema.dawar@hp.com
anil_srinivas@dell.com
sales@aciinfo.com
sanmenon@in.ibm.com
rajeevsaxena@lgezbuy.com
rohit@kobian.com
-
notepc@samsungindia.com

notebook@hclinsys.com
littlegenius@wipro.com
laptops@zenith-india.com

www.acer.com
www.aci-asia.com
www.apple.com
www.benq.com
www.hp.com/in
www.dell.co.in
www.fujitsu.com
www.ibm.com/in
www.lgezbuy.com
www.kobian.com 
www.msi.com.tw
www.samsungindia.com 

www.toshiba.com 
www.wipro.com
www.zenith-india.com 

external Combo drives that attach to the note-
book via USB ports. 

Usability
In terms of portability, the Dell Latitude X300
and the Samsung Q20 were easy winners.
Weighing around 1.3 kg, the Samsung Q20 is
the lightest notebook we have tested yet. The
Dell followed, weighing in at 1.4 kg. 

The ACi Ethos Lite and Fujitsu S2020 are
categorised as ultra-portables, but are thicker
than the others due to the integrated optical
drives. They’re still easy to carry about, of
course, and are good for people who constant-
ly use optical drives. 

Except for ACi and Acer, all the others were
covered with a three-year warranty. Dell was
the only one to provide an on-site warranty. As
for turn-around-times, Acer claims one of 12
hours, while all the rest are either 24 hours or
48 hours.

Performance
The ACi’s Ethos Lite posted the best score in the
system benchmark; it was closely followed by
Fujitsu’s S2020 and Dell’s X300. Acer, for some
reason, failed to deliver, despite all the hard-
ware it carries; it performed badly compared to
the other notebooks. 

In most other
tests, ACi dominated,
and was followed by
the BenQ Joybook
6000U, the Dell X300,
and sometimes the
Acer 372TCi. The
Samsung Q20 fell far
behind the competi-
tion due to the lower
powered Celeron M
processor. 

The Fujitsu’s had
802.11g wireless
adapters, and offered
the best wireless
experience. The Dell,
BenQ and Acer TM
372 TCi were good,
but limited by their
802.11b adapter. 

Conclusion
The Dell Latitude X300, with its ultra-thin size,
low weight, good features and impressive per-
formance takes the Best Buy Gold award. The
Acer TM372 TCi also presents itself as a com-
mendable buy, but falls behind the X300 in
terms of features and usability.

The Fujitsu S2020 gets the Best Buy Silver
award for its excellent pricing. This ultra-
portable was the best all-rounder due to its
screen-size, performance and pricing.  

The BenQ Joybook 6000U is the best per-
former, but weighing 1.6 kg with a wide screen,
it lost out to the competition. 

aliasgar_pardawala@thinkdigit.com
sanket_naik@thinkdigit.com
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Trend

Business,
VIDEO CONFERENCING AS part of your business is no longer a futuristic
concept—it is here, and it is now. Video conferencing not only helps
bridge distances, it also helps bring down travel costs, cuts down on
unutilised man hours, and brings a company face to face with domain
experts at a nominal cost. Here’s what five senior industry personalities
have to say about video conferencing 

We use video conferencing for two reasons: To increase the
frequency of contact between remote teams and to reduce
the cost of travel. We changed the layout of the conference

room for this purpose and saw to it that lighting was appropriate. We
had to install a power supply to shoulder the additional power needs
and got an IP-based Wide Area Network in place. As part of basic
infrastructure, we got an ISDN line, too. A Polycom camera was the
preferred device for image and audio capture. As a result, it has helped
cut national and international travel costs. Apart from allowing
meetings to be held in a short timespan, it also allows face-to-face
interaction with our colleagues as well as business partners. We did a
cost-to-benefit analysis before implementing it and found that the
savings on travel alone have been enough to offset the equipment
costs, and more.

IIT uses group-based videoconferencing to
extend its classrooms to include
geographically distant students wishing to

pursue high-quality advanced engineering
education. We use a full-fledged satellite
uplink facility to capture audio and video
inputs from live IIT classrooms with full
digital imaging support to faculty. HCL
Comnet manages the VSAT (Very Small
Aperture Terminal) network. The
infrastructure was built with donations from
reputed alumni like Infosys CEO Nandan
Nilekani and venture capitalist Kanwal Rekhi;
grants from the Ministry of Communications
and IT, and international agencies. IP-
multicasting allows two-way audio and video
interaction. This lets a student attending the
lecture at a remote centre ask questions and
get real-time replies. This facility is now the
only one of its kind in educational
videoconferencing in India, thus ensuring
that IIT faculty can now reach a remote
student, and also give him the feel of
classroom participation. We were driven by
the vision of bringing IIT education to
students who are as capable, but have limited
resources.

Mohan U Deshpande
Professor-in-Charge, DEP,
IIT Bombay

Alagu Balaraman
Head, IT,
Godfrey Phillips India Ltd
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Yugal Sharma
Country Manager
Polycom

InCamera!
Video conferencing is a way of life at Reliance. Bundling video

conferencing as part of the Reliance Web World network in 111
cities made business sense. They are connected with three T1

lines. Video conferencing is a business model because the enterprise
client just has to pay for the services, while we take care of
infrastructure and training. All you need to do is just walk into any
Web World, and check in for the services. Our Churchgate Webstore,
for instance, was used to record the statement of a witness for a court
case. This is perfectly legal. Gillette did a product launch through our
Web World network using video conferencing. It has been used by
Bollywood, too. We ran a contest for Kal Ho Na Ho on R-World and had
the winners speak to Preity Zinta and Karan Johar via a video
conference. In the near future, we see enterprises as our biggest
customers. We plan to push our services as a means to overcome
distance, and for people to make their presence felt. Sunil Buch 

Head, Marketing and
Production Management
Reliance Infocomm

We use video conferencing for telemedicine. Our doctors use it to
interact with patients and the referring doctor. This
supplements the patient’s electronic medical record on

Medintegra, our telemedicine application. These records help specialist
doctors formulate opinions. They also specify a treatment regimen,
which is then entered into Medintegra and carried out by the referring
doctor. We seek the opinion of two specialists, each from a different city
using video conferencing. Even our continuing education programmes
are conducted using video conferencing from anywhere between three
to ten cities. Our infrastructure includes a colour TV (20-inch flat, 29-
inch flat and 42-inch plasma models), a good quality sound system,
three ISDN lines (128 Kbps each) or broadband Internet—256 Kbps
dedicated—with a public static IP address, VCR for recording certain
cases, clean power with backup, computers with video-out to view
images, medical equipment, Polycom Image and Audio Equipment, as
well as Aethra. It lowers the total cost of treatment. 

Dr D Lavanian
Business Manager
Apollo Group of Hospitals

Video conferencing is no longer looked at by corporates and
enterprises as a fancy way of communicating. It is now a
necessity. Most enterprises have decentralised decision-making,

and yet it is important for the head office to make certain strategic
decisions. Video conferencing allows companies to make these
decisions instantly. The technology has evolved over the years. It started
out with large screens in conference rooms, but now we have desktop
conferencing which denecessitates the setting up of a conference
room, thereby reducing costs further. Small enterprises such as
lawyers, consultants, exporters, etc, can use it to maximise their
business revenue. Video conferencing has been around in India for
more than 15 years, but it is only in the last five years that it has been
accepted as a way of doing business. The National Informatics Centre
has nearly 80 locations in Maharashtra connected via video
conferencing. Our estimate of the Indian video conferencing market is
about $50 million (around Rs 230 crore).

As told to Garfield D’Souza



Meera Vankipuram

ollowing the death of her
husband in a construction
accident while working in

Jeddah, Saudi Arabia, Kannatha, a
resident of Uranganpatti village in
Madurai district in Tamil Nadu,
ran into financial problems. 

She was advised to seek
compensation from her
husband’s former employers,
but had no clue how to go about
it. She sought help from the
local Internet kiosk operator,
who not only located the e-mail
address of the Indian Consulate
in Jeddah, but also typed out an
e-mail and sent it on her behalf. 

Two weeks later, she received
a parcel containing the relevant
documents, which were duly
filled and sent out. A month

after sending the original e-
mail, Kannatha and her family
received Rs 1.3 lakh in
compensation—and all she spent
was Rs 30 for a few hours of
Internet access. 

Thanks to SARI (Sustainable
Access in Rural India), a
pioneering project
conceptualised by a professor
from IIT-Madras, the Web now
helps struggling farmers become
successful entrepreneurs. The
Web also gives people from
villages across Tamil Nadu access
to better medical facilities,
higher education and solves
agriculture-related problems,
among other things. 

The project, which draws on
the research expertise of Harvard
University Centre for
International Development, IIT
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In a world shrunk by technology, an obscure hamlet
in the Madurai district of Tamil Nadu is showing the
way to harness the power of the Internet 

F

Madras and the Massachusetts
Institute of Technology’s Media
Lab, seeks to harness Information
and Communica-
tion Technologies (ICTs) to
improve health, education and
economic development in rural
areas, by deploying innovative
technologies and effective,
economically sustainable,
business models. 

SARI is managed by the
Telecommunications and
Computer Networks Group
(TeNeT), Department of
Electrical Engineering, IIT
Madras, led by Dr Ashok
Jhunjhunwala.

It works in close association
with the telecom and computer
industry to develop ICTs such as
the corDECT Wireless in Local
Loop system, Fibre Access
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Network, DSL Systems and several
other solutions. TeNet then
collaborates with R&D
organisations to implement
projects that develop versatile
and low-cost projects beneficial
to rural India, using these ICTs. 

Logging On
Chennai-based n-Logue, a
company incubated by TeNet,
aims to install and operate
telephone and Internet
connections in every Indian
village. n-Logue identifies and
trains potential kiosk owners and
also supplies them with the
necessary infrastructure—
hardware, battery backup,
wireless Internet antenna, etc. The
company also helps the kiosk
owners arrange for loans, which
are repaid with revenue from the
kiosks. n-Logue makes its money
from hourly connection fees. 

Abdul Razzak owns two
Internet kiosks in Melur, Madurai,
and has been an entrepreneur for
three years now. Says Razzak, “I
teach computer courses such as
Java, etc, at rates much cheaper
than those in the city.” A typical
‘Office Tools’ course, for example,
would cost only Rs 300 at his
kiosk, while it could cost four
times as much in Chennai.

Shalini, from Pinjavakkam
village, Tiruvallur district, Tamil
Nadu, was introduced to n-Logue
by her mother, a social worker.
Shalini has done a secretarial
course from a school in Chennai,
and is currently pursuing a
Bachelor of Arts degre throught a

correspondence course. She is also
in charge of the sole Internet
kiosk in Pinjavakkam. This
income helps support her family. 

In Tiruvallur, the Internet is
mainly used as a tool for
education; not just for children,
but also for adults. “Now we don’t
have to go to the city to study. We
can stay here and educate
ourselves,” says Shalini. 

Through video conferencing,
people address their problems
directly to the District  Collector. 

Suganya of T Ulagapit-
chanpatti village in Melur taluka,
has been a kiosk owner for two
years now. She was part of a self-
help group when she got onto the
ICT bandwagon. She says the
kiosks have helped farmers seek
advice on crop-related problems
from the Agricultural University,
and on veterinary problems from
the Tamil Nadu Veterinary and
Animal Science University
(TANUVAS), Chennai, using a Web
cam and video conferencing
facilities. Chat is popular at her
kiosk too. “On Fridays we have a
Dubai chat session, and on
Sundays we have a Denmark chat
session,” she says. 

Says Dr Jhunjhunwala, “The
SARI model has grown to over 30
districts and is expanding
quickly.” He believes the Internet
can be used to double the per-
capital GDP of rural India. 

Says Joseph Thomas, Project
Manager, SARI (IIT-Madras),
“Raising the GDP is brought about
collectively by using the Internet
to encourage micro-enterprise in
the village, providing better
marketing channels for village
produce, getting expert advice on
agriculture and veterinary
sciences, and a lot of new
financial services.”

How SARI Benefits
Education is the primary area of
benefit—children from the age of
six to 16 are made computer
literate. Computer courses are
offered at cheap rates; vocational
training is provided to write
resumes, applying to colleges and
jobs, and in improving language
skills. TeNet has also developed an
application that lets students take
sample tests online, prior to board
exams, and receive feedback.

Farmers growing perishable
crops such as flowers, or
groundnuts, obtain market prices
and sell their produce via the
Internet. They also get weather
and soil-related information
online from national agencies.
Web cam and video conferencing
facilities are also used to obtain
health-related advice from leading
medical institutions.

The Road Ahead
The Melur project has achieved
‘self-sustaining’ status, and SARI
has now moved on to other
districts in Tamil Nadu, and other
states as well. 

According to S Madhu,
Manager (Marketing and
Training), n-Logue, “We are
working with the Gujarat
government to connect 16
districts under the ‘Gyan Ganga’
project. We are collaborating
with Gujarat Informatics Limited
to connect all districts—five are
already networked—and develop
local language content.”

IT for development may seem
like a misnomer, but projects like
SARI have attempted to harness
technology to create better
economic opportunities for
India’s rural populace. 

Make way!
meera_vankipuram@thinkdigit.com

SARI was possible due to corDECT, a Wireless Local
Loop technology, jointly developed by Analog

Devices, Midas Communication Technologies, and the
TeNeT group. corDECT provides cost-effective, high-
quality voice and data connectivity, both in urban and
rural areas: voice communication using 32 Kbps
ADPCM, and Internet connectivity at 35 or 70 Kbps.

A fibre optic line is deployed to connect the local
exchange with a central office terminal, which, in
turn, is connected to a few remote terminals.
Conventional copper wire is then used to link sub-
scribers to the remote terminal near them. 

The scheme supports star and ring topological
networks, and promises high-quality voice and data
transfer, with an ability to cater to nearly 8,000 sub-
scribers per sq km. This scheme also supports
advanced Network Management System features,
and is compatible with emerging technologies such
as high bit-rate and asynchronous digital subsrciber
lines and of course, corDECT.

Source: http://www.tenet.res.in/

How SARI Works

Farmers are
able to seek
advice on
crop-related
problems...
and on
veterinary
problems,
using the Web
cam and
video
conferencing
facilities.
Suganya,
Melur

124 DIGIT SEPTEMBER 2004

Digital Leisure l Touched by Tech And This Is How The Villagers Benefit

E-governance made possible
through video conferencing

Access to agriculture solutions and
weather-related information

The World Wide Web is
now easily accessible

E-mail,  browsing, chat and
voice mail facilities 

Access to low-cost med-
ical aid through e-mail
and video conferencing

Computer education
and online tutorials  
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Name the Indian company
whose HamaraCD.com service

lets users create personalised audio
CDs of their favourite songs from a
database of over 25,000 songs in 12
languages.
a. T Series
b. Sony Music India
c. Times Music
d. Sa Re Ga Ma

Which software giant
recently launched a

‘Newsbot’ that will crawl news
headlines from more than 4,800
other sites, in an effort to counter
Google's automated news service?
a. AOL
b. Yahoo!
c. Microsoft
d. Sun Microsystems 

Which non-IT Indian
company recently made a

foray into the IT sector by signing
an agreement with business
software solutions provider, SAP
India, for marketing and
distribution of SAP solutions for
the metals and mining industry in
the country?
a. HLL
b. Maruti Udyog
c. Tata Steel
d. JK Group

Michael Herf and Lars
Perkins founded Picasa 

Inc in 2001, which develops
software that enables users to
manage and share digital photos.
Recently, Picasa was acquired by
a California-based IT major to
enhance its blogging service by
adding picture sharing. Which
biggie are we talking about here?
a. Hotmail
b. Google
c. Yahoo!
d. Rediff

On July 12, 2004, a new world
computer chess champion

was crowned in Israel after it
defeated the defending software
program, Shredder. This program
places less emphasis on the value
of individual pieces and more on
factors such as mobility and
positional advantage, which gives
the program the ability to find
unusual and daring moves. What is
the program called?
a. Junior
b. Deep Blue Jr
c. Demolisher
d. Starter

Recently, he was granted the
rank of Knight Commander,

Order of the British Empire in
recognition of his “services to the
global development of the
Internet.” The person in question
is… 
a. Bill Gates
b. Pierre Omidyar
c. Jeff Bezos
d. Tim Berners-Lee
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Crossword 
Across: 6. Parent, 8. Oracle, 9. Hard, 10.
Panic, 11. Radar, 13. Scaling, 16. Celeron,
17. Site, 20. Timer, 21. Tube, 22. Scroll,
23. Analog
Down1. Database, 2. Nerd, 3. Connect,
4. Calculus, 5. Alta, 7. Tapi, 12. Alert box,
14. Notebook, 15. Formula, 18. Area, 19.
Hack, 21. Team

Quiz
1: b, 2: d, 3: c, 4: c, 5: b, 6: c, 7: a, 8: a.

Across
6. Entrap is confused by this main 

programme (6)
8. A Redwood Shores, California

Company (6)
9.  Solid, magnetic disk to store

computer data (4) 
10. Action taken by a programme

when unable to run (5) 
11. Radio Detection and

Ranging (abbr) (5) 
13. Graphical process of changing

object size (7) 
16. Intel Corp’s trade name for it’s 

family of Pentium II’s (7) 
17.  Location on the World Wide

Web rearranges ties (4)
20. Clock or switch deformsmiter (5) 
21.  A CRT terminal in a conduit (4) 
22.  Move up, down, sideways 

through a document (6)
23. Opposite of Digital (6) 

Down
1 Electronic filing system 

rearranges a bad 
seat (8)

2 Computer geek (4)
3 A modem will ------- a 

computer to a phone 
line (7)

4 Method of
computation in a
special notation (8)

5 Search system is at the 
Lord’s table endlessly (4)
7 Telephony Application

Programming
Interface (abbr) (4)

12 Message window (5,3)
14 Portable, 

self-contained
computer (8)

15 Prescription for an equation (7)
18 Storage section in a domain (4)

19 Tool to write programme code? (4)
21 Group of workers upset mate (4)

Compiled by Nitaa Jaggi

Crossword 

Answers

Got an
interesting
question? 
Send it in with
the answer to
editor@thinkdig
it.com

Of Bots That Crawl News Sites, People Who
Get Knighted, And Robots That Replace Wives

Steve Jobs received a
private jet plane as a

bonus in January 2000
for his performance as
interim CEO of Apple
Computer.

Did you
know?

Name the playwright whose    
1972 novel, in which a

group of men swap their wives for
lookalike robots, inspired the
Hollywood flick The Stepford
Wives, starring Nicole Kidman. 

a. Arthur Miller
b. Tennessee Williams
c. Ira Levin
d. Eugene O’Neill

6

EBay
founder

Pierre Omidyar
and his wife,
Pamela,
contributed $1
million to the 
well-heeled
campaign supporting Proposition
71, which would make available $3
billion for a research undertaking
in California. What is it?

a. RFID for endangered species   
b. Stem cell research
c. A new generation chip
d. AIDS

1



THIS ONE IS for everybody who has ever
hit a record button. Stop! Digital media
is so pervasive that the Big Boys are
taking notice, and they do not like
where your finger is headed.

In the era of digital culture, little
bits of ideas and creations leap across
routers and through computers around
the world—bits with money behind
them. Here, control is vital, since it
defines the economy. Lawrence Lessig’s
Free Culture is a frightening ride through
the history of copyright law, which was designed as
a shield to the intellectual property of large
conglomerates.

As absurd as the Digital Millennium Copyright
Act (DMCA) seems to the silent majority that does
not wish to steal money from its favourite artists,
the law has precedence. It paves the way for the
absurd Induce Act. Once passed, the Induce Act will
criminalise the act of inducing another to commit
a copyright violation. It’s like putting you in jail
because somebody used your hammer to break into

a house. 
If you have ever listened to the

radio, you should read this book. If
you have ever recorded a song, you
should read this book. If you have
ever taped a favourite TV show or a
vital cricket match, you should read
this book. If you have thousands of
songs sitting pretty on your computer
while the original CDs gather dust in
a remote cupboard, read this book.
If you have ever felt thankful for
the thousands before you who have
inspired you with their music, moved

you with their words, teased you with their art,
read this book. And if you do not care about a law
nor are in the least bothered where society is
headed, you should most definitely read this book.

Download a free copy from www.free-culture.org.
Ah yes, check the copyrights for that as well!

Ahmed Shaikh
Free Culture: How Big Media Uses Technology And The Law To Lock
Down Culture And Control Creativity
Publisher The Penguin Press Author Lawrence Lessig
E-mail lessig@pobox.com 
Web site www.free-culture.cc
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A Few Glitches Aside, This Lord
Lords You Over

THIS TIME AROUND, you finally get to play
as the Fellowship, with eleven characters
available, out of which four can be
unlocked. 

The Return of the King starts by putting
you in the role of Gandalf. No matter
how casually you play the first level, you

win the battle. It’s the Skill Points that
you are actually playing for. 

There are four grades to attain—Fair,

Good, Excellent and Perfect. After the first
level, you are given the choice of treading
three different paths, just like in the
movie. Ultimately, you have to take the
Paths of the Dead. 

All characters have excellent moves and
combos. But you can’t begin with outright
combo action. Besides, the stylish combo
moves need mastery. The great level design
makes for some fun gameplay. But, the lev-
els are arranged in order, difficulty-wise. 

Overall, ROTK is a first-rate action game
and is a must-buy. Once you beat the game,
you get loads of bonuses, including DVD
footage. There’s a co-op mode for the PC
version, where you can share your monitor
with a friend. A few AI problems and an
overfed camera are two hitches. Otherwise,
ROTK lords you over.

SKOAR! Magazine

The Simpsons’ Show!

THE GAME, LIKE any typical Simpsons
episode, is way beyond wacky. Mysterious
bugs of alien origin have been released
into the unsuspecting town of Springfield.
It’s now left to Homer to save the day.

Gameplay-wise, Hit and Run is very sim-
ilar to the GTA series. You have a large area
to explore and seek out hidden goodies.
You can also seek out and destroy all the
Rigelian bugs present in that level to earn
your coins. As in GTA, you set your own
pace for completing the missions.

H&R has its fair share of violence too.
Then of course, there’s the Simpsons
brand of humour. 

There are seven levels in the game,
that give you 42 cars, 21 outfits, and 49
cards. But only a handful of cars are of
any use. Also, walking across a narrow
beam with a cumbersome camera view
isn’t exactly enjoyable, especially if you
lack analogue sticks on the gamepad. 

H&R isn’t a game you can play at a
stretch. But if you are a Simpsons fan,
this game is worth killing for.

Courtesy SKOAR! Magazine

The Simpsons: Hit & Run
Publisher Vivendi Universal 
Developer Radical Entertainment 
Web site www.hitandrungame.com
Price Rs 999
Distributor Sony Music Entertainment

1. Harry Potter: Prisoner Of 
Azkaban
Rs 1,299
Gayatri Impex Pvt Ltd

2. Need For Speed: Underground 
Rs 1,299
Gayatri Impex Pvt Ltd

3. Driver 3
Rs 2,999
Milestone Interactive Software

4. FIFA 2004 
Rs 1,299
Gayatri Impex Pvt Ltd

5. Jumpstart
Rs 699
Express Interactive Software P Ltd

The Lord Of The Rings: The Return Of The King
Publisher Electronic Arts  Developer EA Pacific
Web site www.eagames.com/official/lordoftherings/
returnoftheking
System requirements 700 MHz CPU, 128 MB RAM, 32 MB
video card, 2 GB free hard disk space
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Wired August 2004

Ross King and His 
Fantastic Robot

A THINKING MACHINE is the stuff
of science fiction. Never, ever, tell
that to Ross King. The enigmatic
professor of computer science at
the University of Wales has
devised his own, and this one, says
Oliver Morton of Wired magazine,
promises to change the world.

Excerpts from a brilliant
article in one of the world’s
premier technology publications:

For a machine that’s changing the world, the device on the
lab bench in front of me doesn’t look very impressive—it just
goes back and forth, back and forth, back and forth. 

A contraption about the size of a human hand moves from
side to side along a track. At the far right end of its trajectory, a
proboscis-like pipette pecks into a foil-covered plastic container
and sucks up some liquid; the hand moves a foot or so to the
left, and the pipette squirts out the liquid a few drops at a time
onto a rectangular plastic platter covered with an array of 96
tiny depressions. Then it repeats the routine. Whirr, plunge,
suck, whirr, plunge, squirt—a mechanical counterpoint to the
cries of the seagulls outside the lab in this Welsh coastal town
of Aberystwyth.

The effect is oddly hypnotic. Ross King, a professor of
computer science at the University of Wales and the Dr.
Frankenstein behind this most humdrum of monsters, watches
me watching it with a wry amusement that might mask a touch
of embarrassment. “It comes across better on radio than on
TV,” he says.

Indeed, King’s robotic lab assistant is something of an ugly
duckling. High-throughput screening—testing vast libraries of
chemical compounds on various types of cells to see whether
they interact in ways that might be useful—has become a
routine function in modern bio labs, and at the high end
machines that do it are positively telegenic. For instance, the
Automation Partnership, based in Royston, England, offers one
that bobs, weaves, shakes, and stirs like a possessed bartender.
Such uncanny dexterity costs roughly $1.8 million—but if you’re
a pharmaceutical company interested in performing as many
experiments as quickly as possible, it’s money well spent.

King’s humble robot is based on a Biomek 2000, a low-rent
fluid-handling device that goes for only $37,900. But it can do
something its more nimble cousins can’t. Its components—the
tireless robot arm, an incubator in which cells cultured on the
platter either wither or thrive, and a plate reader that
examines the little depressions to see whether anything is
growing there—are linked up to a much more exceptional brain.
The artificial intelligence routines in that brain can look at the
results of an experiment, draw a conclusion about what the
results might mean, and then set off to test that conclusion.
The “robot scientist” (King has resisted the temptation of a
jazzy acronym) may look like a mere labor-saving gizmo,
shuttling back and forth ad nauseam, but it’s much more than
that. Biology is full of tools with which to make discoveries.
Here’s a tool that can make discoveries on its own.

Read the entire story at http://snipurl.com/roboticarm
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Newsweek  August 2, 2004

iCame, iSaw, iPod
MANY PEOPLE CALL the Apple
iPod a sub-culture. They are
wrong. It is a culture by itself. 

Stephen Levy, Newsweek’s Chief
Technology Writer and Senior
Editor, chronicled the rise and rise
of the iPod. This is also, in part,
the story of Steve Jobs, the man
behind the iPod and the
revolution Apple is bringing about
in the personal computing and

entertainment front.
Excerpts from the article:
Steve Jobs noticed something earlier this year in New York

City. “I was on Madison,” says Apple’s CEO, “and it was, like, on
every block, there was someone with white headphones, and I
thought, ‘Oh, my God, it’s starting to happen’.” 

Jonathan Ive, the company’s design guru, had a similar
experience in London: “On the streets and coming out of the
tubes, you’d see people fiddling with it.” And Victor Katch, a
59-year-old professor of kinesiology at the University of
Michigan, saw it in Ann Arbor. “When you walk across campus,
the ratio seems as high as 2 out of 3 people,” he says.

They’re talking about the sudden ubiquity of the iPod, the
cigarette-box-size digital music player (and its colorful credit-
card-size little sister, the Mini) that’s smacked right into the
sweet spot where a consumer product becomes something
much, much more: an icon, a pet, a status indicator and an
indispensable part of one’s life. To 3 million-plus owners, iPods
mean membership into an implicit society that’s transforming
the way music will be consumed in the future. “When my
students see me on campus with my iPod, they smile,” says

Professor
Katch, whose
unit stores
everything
from Mozart to
Dean Martin.
“It’s sort of a
bonding.”

Apple
wasn’t the first
company to
come out with a
player, but the
earlier ones
were either

low-capacity toys that played the same few songs, or brick-size
beasts with impenetrable controls. Apple’s device is not only
powerful and easy to use, but has an incandescent style that
makes people go nuts about it. Or, in the case of 16-year-old
Brittany Vendryes of Miami, to dub it “Bob the Music
Machine.”

(Actor) Will Smith has burbled to Jay Leno and Wired
magazine about his infatuation with “the gadget of the
century.” (Actress) Gwyneth Paltrow confided her Pod-love to
Vogue (her new baby is named Apple—coincidence?). 

People who actually create music are among the biggest
fans. Couture maven Karl Lagerfeld’s iPod collection is up to
60, coded in the back by laser etching so he can tell what’s 
on them.

To read the entire story, go to http://snipurl.com/ipodnation

MediaWise
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Googlebombed!
GOOGLE, THE WORLD’S favourite
search engine, is vulnerable. And
ironically, this is because of its
proprietary software that ranks
pages based on their popularity,
rather than any other parameter.
Discover magazine wrote how the
search engine’s software could be
manipulated to get your results
on top. It is euphemistically
called Googlebombing, and it is
now fast becoming big business.

Excerpts from the piece:
Does Google have a favorite in the upcoming presidential

election? Not Google’s CEO or its charismatic young founders,
not the shareholders of the company-Google, the search engine
itself. Does it favor one candidate over the other? 

This is not a preposterous question. Just type the words
miserable failure as a search query, and see the top result. The
document that Google thinks is most relevant is a biography of
the 43rd President of the United States, George W Bush.

Before some of you write angry letters to the editor about
the liberal bias infecting search engines, consider this: The
results for “miserable failure” were not directly shaped by
anyone at Google. Instead, Web users manipulated the
rankings by altering their own Web pages. The practice is
called Googlebombing.

This kind of group intervention is possible because of the
ingenious way that Google calculates its search results, a
much-scrutinized system called PageRank. It involves two
known variables. 

If you search for a relatively common word like
paleontology, you’ll find hundreds of thousands of pages that
contain the word. A search engine is not much use unless it finds
the most valuable pages and returns them as the top results.
Theoretically, Google could have hired thousands of humans to
read all the pages in its index—instead, the company tapped the
free labor of all the people in the world who were already

creating Web pages.
Most Web pages have

hypertext links to other Web
sites. Google’s software
recognizes those links as
votes. The PageRank
system tallies all the votes
for every page it has
found on the Web. Pages

that have attracted more
links become more prominent in Google’s rankings. When you
query “paleontology” the top 10 are the 10 pages that have
received the most links. 

Apart from the votes system: let’s say you create a link
from your page to a site devoted to the life of baseball great
Willie Mays. Google pays attention to the words you use to
describe the site. If you link to the Mays site with the phrase
“Barry Bonds’s godfather,” Google learns to associate the
phrase with that site, even if it doesn’t mention Barry Bonds.  If
enough people on the Web publish the same link with the same
phrase, eventually Google will serve up the Mays site as the top
result for “Barry Bonds’s godfather.” 

Read the entire story at http://snipurl.com/googlebombing

The Emperor With No Clothes On
Is this message the naked truth? SuSE, a Novell company,
does give us the creeps with this novel ad. It certainly makes
Windows sympathisers sit up and take notice. 

Chain Reaction 
What better way to show off the Windows XP Tabloid PC
Edition than this? With this flipover notebook, pamper
yourself, and stretch your imagination like never before.
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Not content with
threatening 12-year-old

girls with litigation and
then squeezing $2,000 off
them, the music industry is
now taking its vigilance to
schools. This isn’t a play for
their lunch money, but is
instead aimed as a citizen-

education programme. The
message being, stealing
songs is wrong, you 
little thieves.

The Music Manifesto is
meant to promote music in
UK schools. “We would like
to see schools teaching

copyright awareness so that
pupils understand its
importance not only to
those contemplating music
as a career, but to society
generally,” said EMI.

The message will be
delivered via teachers who
will be oriented on how to
“explain copyright
properly”. The entire

exercise takes on an even
weirder tone
considering that the
Manifesto was meant

to teach the virtues of
music. How a lesson in

copyright translates into
future musicians is not
explained: perhaps
marrying the benefits of
hit-singles to music lessons
is aimed to create more
well-rounded
musicians—looking to the
bread while playing 
the fiddle?

Or maybe British Music
Rights is taking a leaf out of

the book that the Motion
Pictures Association of
America threw at US
schools a few months ago
students were encouraged
to role-play artists,
producers, singers, etc,
ruined by the evils of P2P
file-sharing. That attempt
prompted Wendy Seltzer, a
lawyer for the Electronic
Frontier Foundation to
quip, “There’s no balance;
it’s entirely corporate
driven. If anything, it’s an
exercise in how efficiently
you can brainwash
students.”

RECYCLING

Silicon-tagged
Garbage

Building upon the view
that it ain’t worth it if it

is free, the UK government

is considering charging
people for the trash they
put out everyday. Today, UK
households pay too little for
trash disposal. So goes the
thinking: increasing the
amount they would have 
to pay would bring 
about greater discipline in
trash-management.

Think you have the most
beautiful, most innovative

desktop around? Send it to
mmyyddeesskkttoopp@@tthhiinnkkddiiggiitt..ccoomm,,  and
Digit shall publish the most 
eye-catching of them every month.

When Tux hooks up with a Mac—with all the eye-candy, how
does he get his work done?!: by Utpal Pande

My Desktop

BestIndianSites.com

Here’s one Web site
that can’t feature on

its own top 100 Indian
Web sites list! Most of the
links don’t work—they ask
you to sign up, but when
you try to do so, you get
a “404 Page Not Found”
error. We tried random
usernames and
passwords and got the
same error. Looks like the
site’s shut down; now
only if someone could
inform the hosting
provider, and save them
some bandwidth!

Man who spams gets slammed
A Canadian advertising an Olympic Web site written
across his chest was sentenced to five-months in prison.
The man disrupted a three-meter synchronised diving
event by jumping from a springboard into the indoor
pool. He was later fined and released.

Big, big SMS goof-up
Marian Aliuta, Romania's top footballer, had to leave
his club because he SMSed the wrong Victor - Victor
Becali, his boss, instead of his friend. The message
said the club's new coach was no good.
Aliuta joined a rival club.

CHILDREN, THERE WILL BE A TEST

You Need Education. In Music
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The winning entry will win a
KUSBDTI/128FE USB stick
worth Rs 1,300. This month’s
winner is Utpal Pande.
Sponsored by
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‘How’ is where the tech-
wizardry comes in—with the
power vested by silicon,
dustbins will be tagged
electronically. The chips
would then talk to the
collector bins. The reader
will differentiate between
bottles, cans and plastic. If
you have been a good
citizen, separating the
recyclable from the non-,
you would be let off easy,
but mixing glass with plastic
would raise silicon-hackles
with costly consequences.
The plan is to charge those
who put all their trash in
one basket more.

Under the Household
Waste Recycling Act 2003,
English authorities need to
be collecting at least two
types of recyclable waste by
the end of 2010. The current
proposal is meant to help
fulfil that goal.

HOAX

Kill Ben 

Following the US attack
on Iraq, hundreds of

hostages from two dozen

countries have been seized.
While most were released,
some have been killed,
beheadings being the most
ghastly method of
execution. 

Within the volatile
emotional atmosphere thus
created, was released,
recently, a video clip
showing a beheading. This
particular video turned out
to be a hoax perpetrated by
a US citizen. 

A San Francisco
computer expert was
responsible for pulling the
wool over millions of eyes
that watch the Internet for
such news. Benjamin

Vanderford, 22, posted the
film on a Web site used by
militants in a format that
was used by Al Qaeda ally
Abu Musab al-Zarqawi. The
video showed an American
(Vanderford) being
beheaded as a warning to
the US to leave Iraq. The
fake video was shot in a
garage with a friend’s help.

The video was shot in a
friend’s garage using dye as
blood, a tape reading of the
Quran, and mutilated
bodies and sound effects
from various Web sources. It
was posted onto various P2P
services such as KaZaA.

Vanderford intended to

The Keyboard That
Hanged Itself!

“Installation Art” sent in by
Abhisek Sarda and Viju,
Dona Paula, Goa.
Congratulations! Though it may not be any

competition to the Mona
Lisa smile, the smiley has
made conversations light
and sour pouts change to
happy million-watt smiles.
Meet Harvey Ball, the man
behind the famous
toothless smile that’s so
famously used in instant
chats and e-mails. Ball
sketched it up to pacify
employees sulking about a
merger. 1962 saw the State
Mutual Life Assurance of
Worcester, MA, buying up
Guarantee Mutual
Company of Ohio. Out of
the merger sprung low
employee morale, which
was reason enough for the
company to hire Ball to

draw up some graphic
support for their
campaign to turn the tide
of the morale. 

Within 10 minutes
flat, Ball bowled them
over with a smiling,
rotund face, which found
itself on buttons, desk
cards and posters, urging
employees to smile. By
1971, 50 million such
smiley buttons were sold.
The smiley had arrived.

Always the gentleman,
Ball never ran after
money. He did not apply
for a trademark or
copyright; neither did he
sue Franklin Loufrani,
who did just that. And
neither did he regret it:
“Hey, I can only eat one
steak at a time, drive one
car at a time.”

Harvey Ball 

People Who
Changed

Computing

WIN!
An APUS Pen Drive worth Rs
2500 just by sharing an
amusing picture which a tech
angle to it.

Send your picture to
ddiiggiippiicckk@@tthhiinnkkddiiggiitt..ccoomm..  
prize-winning picture will be
published every month.

Sponsored by



use the video as an
experiment into how
quickly such items spread
over the Internet; as it took
months for the video to
spread, he was reportedly
disappointed over 
the result.

The FBI questioned him
after the hoax became
public. “We will pursue any
and all legal avenues for
prosecution,” said FBI
special agent LaRae Quy.

THE LAW IS AN...

My Lawyer
Will Bury
Yours

We will give away the
ending to this one:

Don’t mess with lawyers.
Here is a familiar story—you
step onto an online message
board and it is filled with
flames, derogatorily
condemning you and
everything you stand for in
front of the amused masses.
All part of the Internet
experience: you are
expected to take it on the
chin and move on. 

Not if you represent a

law firm, though.Stephen
Galton, a California lawyer
and partner in legal firm
Galton & Helm was
subjected to a “barrage of
harassing, defamatory and
abusive messages” and he
came away with a class
action suit! The messages

were posted on boards
supported by Yahoo!,
criticising one of Galton’s
clients. When the lawyer in
question signed up to the
board and defended the
client he was ridiculed by
other users.

When Yahoo! refused to
divulge the details of the
users who allegedly
harassed Galton, he sued
the company for the
information. A company
when legally asked to do so
is bound to release
erstwhile confidential

information of their users.
Galton also alleges that

Yahoo! does not rectify the
wrong people have suffered
as abuse via its message
boards. He would also like
to see similar victims band
together for the class action
lawsuit. Like probably
showing their support by
handing in bags of money
to his law firm. For a good
cause, of course.

NANO WONDER

Metal
Rubber!

Chalk one up for
nanotechnology.

NanoSonic in Blacksburg,
Virginia, has successfully
created a new substance
that marries the strength of
metal with the flexibility
afforded by polymers. 
The process involved is
deceptively simple. Two
buckets, one filled with
positively charged metallic
ions and the other with
negatively charged elastic
polymers are involved. A
charged substrate is taken
and is first dipped into one
of the buckets, which
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Linux
Here are some bouncers from
the vault of Linux jargon to help
you leave your friends reeling.

Framebuffer
The Linux framebuffer or fbdev is
a graphics layer to show graphics
on a console. It is hardware-
independent and it does not rely
on system-specific binaries. It is
also lightweight, unlike the X
Windows system.

It was originally developed
for Apple Macintosh computers.
These do not have a text-mode
display, so it was developed so
the text-mode could be
emulated. It was later expanded
to the IBM PC platform and
became popular.

LSB
LSB is an acronym for The Linux
Standard Base—a joint project by
several Linux distributions. It was
set under The Free Standards
Groups, with the objectives of
standardising the internal
structure of Linux OSes. It is

based on POSIX and several
other open standards.

It is sometimes
disputed, as it
promotes Red
Hat’s RPM
format, so
Debian does not

accept it. For
more information,

visit linuxbase.org.

Staog
Viruses on Linux OSes are rare;
however, many viruses for Linux
have been found, and Staog was
the first of them. It was found in
late 1996. Some other Linux
viruses are Bliss, Devnull, Ramen,
Slapper, Adore, and Kork.

LAMP
An acronym for a set of free
software to run dynamic web
sites, it includes Linux, Apache,
MySQL and PHP. These programs
were originally not designed to
run together, but they became
popular because of low cost and
easy availability. This term first
appeared in a German computing
magazine (- c’t), in 1998. Lamp is
also the name of an obsolete
movie player software. 

Digit had been down south to meet Chief
Minister of Karnataka N Dharamsingh.

Digit’s operations manager Shailesh Iyer and
operations general manager Shivshankar
Hiremath Manasivanagi presented the all-
new redesigned issue of Digit to the new
chief minister, who was so impressed with
the content in the magazine that he read
almost every single page. 

Dharamsingh also briefed the Digit team
on the steps his Government had initiated to
promote the growth of IT in Karnataka. At
present, his government’s IT ministry is

working on the education module to promote
information technology.

He said it was Digit’s classy design that
caught his attention. He went through the
articles and found them informative. He
then did something remarkable—he said he
will try to read Digit every month to keep
abreast of technology. He also hoped that
technology magazines like Digit reached

every corner of Karnataka. He also invited
Digit to be present the prestigious Bangalore
IT.com and Bio Tech, both of which are be
held in November 2004.

We will be there!

Kudos From The South

Digit’s general manager, operations, Shivshankar
Hiremath presents the re-designed Digit to
Karnataka Chief Minister N Dharamsingh



causes ions to stick to it.
The substrate is then
washed under water to
remove excess ions and
then dipped into the other
bucket wherein the other
set of ions stick to the first
set, forming a polymer-
metal sandwich. The
process is then repeated to
add thickness and strength
as desired. When done to
taste, the substrate is
removed to give “Metal
Rubber.” (They could have
come up with a more
imaginative name…) The
cycle is handled by a team
of robots and takes three
days to create a 12-inch-
square sample.
The properties of Metal
Rubber is where the news
is: Twist it, stretch it to
twice its size, take it to
200°C, douse it with jet fuel
- Metal Rubber lives on to
strike another day,
snapping back to its
original form, never failing
to conduct electricity.
Uses ranging from
aeroplane wings to wire
coatings have been
discussed, and companies
with big money are lining

up at NanoSonic’s doors to
test this miracle for
themselves.

NETIZENS NEED NOT

Finnish Off
Duty

In Finland, you don’t need
a big-shot daddy to shirk

mandatory army service.
Finnish youngsters are
getting off battle duty by
citing addiction to virtual
battles, reports Reuters.

Some young Finns
painfully longed for their
PCs, which led military
doctors to express concern
over their mental condition.
The Finnish Defence Forces,
excused ‘IP addicts’ from
their six-month duty,
according to the report.

Commander-Captain
Jyrki Kivela at the military
conscription unit told the
news service that people
who play ‘Net games all
night, and don’t have any
friends or hobbies, often 
are in shock when they join
the army.
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Jeff Maurone
http://snipurl.com/869u

More on My Dinner with No.1 on the Forbes
Further and further you descend, past what seems to be
an annex library, as it was certainly not the primary
librarian that houses the Leicester Codex (Bill’s original
DaVinci notebook, for which he paid approx $30.8
million).  Elegantly non-intrusive but screaming geekhood
were sparsely placed digital canvases that, ever so often,
changed the artwork on the wall.  We passed the movie
theatre, rumored to be the most advanced movie theatre
in the world.  Finally, we reached the bottom level of the
entertaining portion of the home.  To the left was a room
with a design so powerful that it could only exist in the
home of the richest man in the world.

Adam Sacarny
http://snipurl.com/7o8z

Mozilla Vulnerability Timeline
I’ve had many conversations lately about the security
policies surrounding the Mozilla family of web browsers.
The number of people fed up with the terribly
vulnerable Internet Explorer has reached a critical
mass. Now they want to know why Mozilla is better.

I suggest that those people who think “If IE is so
bad, then Mozilla probably is too” take a look at this
timeline. It tracks the identification, fixing, and
notification of a potentially serious security hole
affecting all of the Mozilla Organization’s consumer
applications: the Mozilla Suite, the Firefox browser, and
the Thunderbird e-mail client.

Jonas M Luster
http://snipurl.com/8739

Indispensable Mac OS X products
In going with my last posting, why not start a list of my
indispensable OS X applications et al for your enjoyment.
I’ll update this list as it becomes necessary—feel free to
comment or yell if I am missing something or if there is
something better out there.

The Major League is where the big things happen.
Code and Applications I simply need to lead a fulfilling
life. Well, not really, but it sounds better. The Little
League is, where those small tools reside. Powerful and
almost indispensable nevertheless. 

Russell Beattie
http://snipurl.com/88vk

Possible, Powerful, Popular and Practical:
Mobile Thoughts at 3 a.m.
This is the real problem: Finding that common
denominator. Once you go from Popular and Practical to
the Powerful and Possible, the numbers start to fade.
Yes, companies like BlueLava has sold millions of Java
games, and yes TextAmerica has 100,000 members, and
yes verizon sold 34 million Brew apps in the first six
months of the year. But as an app developer and business
person, where to put your bets is a real dilema. Java?
Right now it’s write once, pray, and debug everywhere.
MMS interop is pitiful, data services are relatively
expensive and varied across carriers and countries,
camera phones are super popular but still only represent
about 15 % of the total phone base.

Here’s taking a look
at a few riveting
posts from the world
of blogs. This month,
we relive a first-hand
experience of a
dinner with Bill
Gates. There’s an
interesting tell-tale
timeline on Mozilla’s
chinks. Browse
through a list of some
favourite Mac OS X
applications. Muse
over the wonders of
3G phones.

What possesses people to blog? Why do we want the world to
know what we do? Is it the inbred desire of our ‘15 minutes’
in the limelight? We’ll never know for sure, but what we do
know is that ‘being different’ is the new karma that ran over
the dogma. 

As soon as you log onto http://www.wibsite.com/
wiblog/dull/, you will notice the difference from other blogs.
For one, here’s a blog that has more comments than posts.

The posts are
short, sweet
and to the
point, and the
comments
often
hilariously
over-insightful.
So what’s the
author’s secret
elixir of
success? Be
amazingly
boring! 

You can’t help but laugh at a post that says, “There was
an object occupying a space on my table. Using my hand I
picked up the item from its place. Having considered my
options for a moment I placed the object on a different area
of the table.”

Yes, the blog is full of such posts. Though we don’t know
what the author was thinking when he came up with this
idea, we’re certainly a tad irritated at not thinking of it first.
If you have anything to say about “The dullest blog in the
world,” mail us at WWTT@thinkdigit.com.

whatweretheythinking.com

www.wibsite.com/wiblog/dull/



It’s A Revolution!
The new Digit is revolutionary. I had
decided not to renew my subscription
after it ended in October 2004, but now I
am being forced to continue. With this
redesign, you have only cemented your
place as India’s No. 1 technology
magazine, thanks to its user-friendly
nature which makes it easy to read and
share with friends.

Bundling a DVD was also a good
idea; especially you are going to give it
away free every month. The content was
mind blowing. 

Please do not go back to giving just
two CDs, even if a lot of readers request
you to do so. You have given everyone an
offer of buying a DVD-Rom at a
phenomenally low rate. 

Tarunpreet Singh
Punjab

Waiting for SP2
The August issue was awesome. I loved
the Free DVD, especially the XP2 RC2
beta release. 

I hope you will bundle the XP SP2
Final release in the September issue DVD,
along with a review in the magazine. SP2
is a must-install release for all the folks
who have Windows XP. 

I was impressed with the changes in
the magazine, both small and big. Digit
articles have become easier to understand
for the common reader. The info about
GMail working through a 260 KB java
applet, which works on the client side
and communicates with the server only
for the e-mail contents, was very
interesting. What an ingenious and
simple way to make e-mail more user-
friendly and faster. One can bank on
Google to be imaginative and innovative
in their initiatives, just like Digit.

Nirjhar Jain
On e-mail

A Complete Mess
I read Digit after six months, and
coincidentally, it was the relaunch issue.
The new-look Digit is more cramped than
any computer-related magazine I have
seen. There were too many ads. The
choice of colours was garish, and the
articles were an ordeal. I think Digit has
gone overboard on the design aspect of
the magazine and made a complete mess
of it. If this is what the new day looks
like, then please pull back the curtains. I
am better off asleep.

Amit Saraff
On e-mail

Perfect Excuse for a DVD-ROM
I was blown away by the August 2004
issue. It is now more readable than ever
before, and there are no longer articles
just meant for people who graduated
from the Massachusetts Institute of
Technology. It is simple to view, and
easier to read. 

I feel that the new look has enhanced
the magazine’s stature in the technology
media segment, but there are some
things you can still improve—like the
positioning of some articles.

The best thing about the new Digit is
the free DVD. Now I really don’t have any
excuse not to buy a DVD-ROM.

Ashish Kumar Varun
On e-mail

Some Socks To Pull Up
Congratulations on the new design. The
new cover layout of the magazine is
great, and giving a CD along with the
DVD is a great idea so that people
without DVD-ROMs don’t miss out on
the action. 

There are still some issues that Digit
needs to take care of:
1) The Clutter: In various places, the
positioning of the articles and the ads
made it difficult to read.
2) Test Centre Reviews: The Test Centre
reviews seem to have lost their
incisiveness. For instance, where has
the Suitability to Task index
disappeared? A thumbnail picture of
the product in the Score Board would
also help.
3) Tips & Tricks: This is my favourite
section of the magazine. In fact, I liked
the old way of presenting this section

134

Rakee

Posted Wed Aug 04, 2004 11:11 am

Subject August Digit 2004

To tell you the truth, after the July
issue, I decided to rent the issues
hereafter instead of buying them. To my
surprise, when I went on August 2 to
borrow Digit, I was shocked to find that
there would be DVDs for upcoming issues.
I just bought a DVD-ROM last month for
movies. I was not happy that I didn’t get
software on DVDs, and now Digit forces
me to buy the magazine again. 

Moreover, the magazine design was
really amazing with a professional look
and quality. Hats off to the Digit team! 

****************************************

KHUBBU

Posted Mon Aug 16, 2004 8:00 am 

Subject Upgrade-2-DVD offer by Digit

I don’t have a DVD drive, and I won't
purchase one right now. Most Digit
readers don't have one. I will stop
subscribing to Digit as soon as my
subscription ends. Maybe I can get my
college library to subscribe. I will read
only the magazine—no one can force me
to buy anything. This is ridiculous. How
can you take your customers for granted? 

Why should I pay Rs 1,400 for a thing
I am not sure I will get warranty for?
Everyone doesn't live in metros. And the
look of the “new” Digit is not at all great.
And you think that if you give these short
test reviews I am going to buy it? I won't.
Most of us from small cities bought Digit
for the CDs. Now, no CD, no Digit.

****************************************

Quickfire

Posted Sun Aug 08, 2004 4:29 pm 

Surprise! Surprise!

One fine morning, I just visited the
forum and was surprised with the speed
at which the pages were loading. I was
really happy to see that. I thought there
won't be anymore, but Digit proved me
wrong. The biggest surprise arrived with
Digit’s August 2004 issue, when they
announced they'll be giving FREE DVDs
with every issue. Wow! That is great! I
hope Digit will continue to bring more
surprises in my life!

Digit Forum

To post your comments on Digit Forum, 
visit www.thinkdigit.com/forum



much better than this one. Also, where
is the A-list?

Even if the overall impact of the
magazine was good, and would have
surely kept the competetion on its toes,
I still feel Digit has a long way to go
before it can be counted as one of the
world’s best magazines.

Visier Solo
On e-mail

The Wait Has Paid Off
The wait for the August issue paid off,
and the optical media drives offer came
at the right time for me. Imagine the
surprise I got when I saw the Digit’s
special offer to upgrade to DVD. I
immediately took the upgrade offer and
also renewed my Digit subscription.
Thanks to Digit, I got both deals at the
price of one!

G Kumar,
Bangalore

Others Will Surely Follow
Do you ever fall short of ideas to surprise
and pamper your readers? 

I guess it is the constant urge to
change and innovate that increases the
number of Digit readers. With the
redesign in August, you have just

reasserted your position as India’s top
technology magazine. I won’t be
surprised if you make others follow
your footsteps. I loved the new sections,
especially Digital Passion, Smart SoHo, 30
days with..., First Hand, the two Visual
Explanations, and Take a Crack. 

The full version games, the mega
software, and the e-books on the DVD
were great, but it could have been better. 
Do keep up the good work of change
and innovation.

Shravet Kumar
On e-mail

Better, Fresher, Colourful
The all-new Digit look and feel is better
than ever before, and much fresher, too.
The colours used in the layout were also
nice. And if that is not enough, you are
giving a DVD and a CD every month.
Just how do you do it in one month’s
time-thinking of story ideas, collecting
information, putting it all into words,
the graphics, sorting, formatting
everything, and then the CD and now
the DVD as well.

Tigger Honeyz
On e-mail

Disappointing New Design!
Kudos for a content-rich August issue.
All the new sections are much worth a
mention. But the “much talked-about”
new design, I felt, was disappointing.
The imaging was much better than
earlier, but was affecting the
magazine’s readability. Many other
readers too felt the same. It was not a
“disappointing” issue, but I think I
loved the old feel. 

Nithin Ismail
On e-mail

Inbox

In the August issue, the
Workgroup MFD scoresheet

(Page 122) had the wrong scores
for the ‘Miscellaneous’ field
under Features. We apologise for
the error.

The Digit Team

Notice any goof-ups? 
Write to goof@jasubhai.com

Goof ups

Write to the Editor
E-mail editor@thinkdigit.com

Snail Mail The Editor, Digit, D-222/2, Om Sagar
Building, MIDC, TTC Industrial Estate,  Nerul, 
Navi Mumbai 400 706. 

Digit will publish the best letters on these pages.
Letters may be edited for clarity

For subscription queries, call the Help Desk at 
022-27629191/9200 Fax 022-27629224, or send an e-
mail to help@jasubhai.com
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Down Memory Lane
When the August 2004 issue reached
me, it reminded me of all the good
times I have had with Digit.

May 2001
A friend brought his issue to school,
where I got my first glimpse of this
magazine. I was in class IX then. It had
a great impact on me.

June 2001
I pestered my parents in to
giving me Rs 100 to buy the
magazine. I bicycled 6 km to the
buy a copy. I popped in the CDs,
enjoyed the software and games, and
revamped my desktop.

December 2002
The free ‘Tips and Tricks of MS Office’
edition was unforgettable. I won a
prize for a project I did in school based
on these tips and tricks. 

June 2003
Digit’s anniversary, and another Tips
and Tricks booklet free. I liked the
book better than the CD.

August 2003
A Linux DVD for free. I first thought
Digit has erred. But then I realised that
India’s No 1 technology magazine has
to introduce us to new technologies. 

December 2003
A collector’s edition! Four CDs of
software, a movie VCD (Ice Age), and an
encyclopedia. That month I joined the
Thinkdigit.com forum.

June 2004
A hyped issue on the Digit forum
didn’t reach to me till the eighth of
the month. The PDF CD was amazing.

August 2004
The issue looked and felt great. It
made me remember the first issue of
Digit. The magazine now supports a
DVD and a CD. Sure it will take some
time before we get used to the new
Digit but I hope Digit continues to give
us great surprises, hoping to see it get
better and better every month. 

Best of luck, Digit.

Divyansh Agarwal
On e-mail

Letter 
of the
Month



It’s unfortunate. Just when we
had SETI@Home, and were

hoping to discover aliens and,
perhaps, be discovered by them,
comes the bad news. Scientist
Frank Drake told a SETI
workshop at Harvard that “the
Earth is going to disappear”
very soon, for aliens.

It turns out that the radio
signals broadcast by traditional
TV antennas are, for aliens, the

strongest evidence of our
existence on this planet. 

If we are to have any hope
of being discovered by aliens,
SETI or someone else will have
to start broadcasting radio
waves into space, to advertise
our presence here—at
taxpayers’ expense, of course.

Drake laments that most
broadcasts now are on cable,
and besides, satellites that relay
TV do so with unforgiving
accuracy, allowing little or no
electricity to escape into space.

Crippleware
for sale

Time to disappear

What a novel idea!
The way people go around

sending text messages, it
was not going to be long
before literature was available
on SMS. That day has finally
arrived. A novel by a Chinese
author, Qian Fuchang, is now
available as a series of SMSes.
The novel is called Outside the
Fortress Besieged, and has been
described as “a steamy tale of
adulterous love”. For those
who lv rdng novls lk ths,

Fuchang’s Fortress will have 60
chapters of 70 characters each.
One small step for SMS, a
giant leap for literature.People And Events That Grabbed Headlines—For Better Or For Worse

Waiting for the aliens

Can you SMS that novel to me?

Along, really long time ago, the
Americans made a movie called The Gods

Must Be Crazy dedicated to the Bush People in
Africa’s Kalahari Desert. Were they seers?
Because the Gods were definitely crazy when
George Bush stood in line when they were
doling out smarts.

Democracy Now (democracynow.org) has
captured audio and video feeds of one more for
the Bushism archives in which a reporter is seen
asking Dubya: “Mr President, you have been a
governor and a president. So you have unique
experience looking at tribal sovereignty from
two directions. What do you think it means in
the 21st century?” The answer: “Yeah, tribal
sovereignty means—it’s sovereign. You have been
given sovereignty, and you are viewed as a
sovereign entity.”

God save America! Not from al-Qaeda, but
from their own President.

Sovereignty? 
Never heard of it!

“Sovereignty means...you are  given sovereignty”
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Bill Gates said earlier this
year that hardware would

be almost free.
But this week, Microsoft

launched the ‘Windows XP
Starter Edition’ for $36. More
powerful? Nah. The
announcement reads, “Users
can have up to three
programs and three windows
per program running
concurrently. Further
simplification of the
operating system includes the
display resolution set to 800 x
600 maximum and no
support for PC-to-PC home
networking, sharing printers
across a network or more
advanced features such as the
ability to establish multiple
user accounts on a single PC.”

A lot less than the full-
price version, but a lot more
than a pirated version. And, a
lot more than the free
version—the one you
“borrowed” from a friend.

The Starter Edition was
originally Microsoft’s
response to Thailand’s
government-initiated Linux
PC project. Now, there’s a lot
of politics behind it, and
Microsoft is doing this to win
over Linux users and strike
deals with governments. But
we have our questions: is
there a home user who would
prefer this crippleware over
the “free licensed version”? 
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